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About Navigation Links
Anavigation link is a feature that points to additional information from a specific area in a topic.
The linkmayopen information in the same topic, a different topic, or even a file outside of the
project altogether.With print-based output the link can electronically open the destination if
the user is viewing themanual online, depending on the type of output you create (e.g., XPS,
PDF, XHTML,Word). In addition, cross-reference links can be customized to refer to specific
content and page numbers in the printedmanual (e.g., See "MyTopic" on page 32). In Flare
you can use navigation links in the following ways.



Cross-Reference This is a navigation link that lets you connect text in one topic to another topic (or a bookmark
within a topic). This is somewhat similar to a text hyperlink. However, cross-referencesdiffer from hyperlinks in a
few ways. Cross-references let you create "automated" links that are based on commandsyou provide. You can
keep links consistent and change them in just one place bymodifying the <MadCap|xref> style in a stylesheet. In
addition, for print-based output, you can create context-sensitive cross-references.When you use a context-sens-
itive cross-reference, the text automatically changesbased on the relationship of the link and the target location if
theyare on the same page or only one page away. See "Cross-References" on page 11, "Inserting Cross-Refer-
ences" on page 16, and "Creating Context-Sensitive Cross-References" on page 24.

Text Hyperlink This is a hyperlink applied to text that "jumps" to a location that you specify. See "Text Hyper-
links" on page 37.

Text Popup This is a link that opensa popup box containing text that you provide. See "Text Popups" on
page 53.

Topic Popup This is a link that opensa popup box containing another topic. See "TopicPopups" on page 59.

Bookmark This is amarker you can apply to a specific location in a topic. Then you can add a link that "jumps" to
this specific location. See "Bookmarks" on page 71.

Named Destination This is a link that points to a specific place a PDF file. See "NamedDestinations" on
page 77.

Links to WebHelp Topics This is a link that points to a specific topic inWebHelp, HTML5,WebHelp Plus, or
WebHelpMobile outputs. See "Links toWebHelp Topics" on page 91, "Creating Links toWebHelp andWebHelp
PlusTopics" on page 94, and "Creating Links toWebHelpMobile Topics" on page 96.

External Link This is a link that lets you search for a file (e.g., HTM, HTML, XML, PDF,Microsoft Office files) out-
side your project. This is especially useful if you want to link from one topic to another in separate project outputs,
such asCHM files. See "External Links—HTML, PDF,Microsoft Office" on page 97.

Image Hyperlink This is a hyperlink that is applied to an image rather than text. You can also create an image
map on a picture, thereby creatingmultiple links. See "Image HyperlinksandMaps" on page 101 and "Creating
ImageMaps" on page 110.

Toggler This is a feature that lets you "toggle" between hiding and showing a tagged chunkof content (e.g.,
paragraph, image, table, list, div). When users open the topic in the output, theywill see a link (also called a "tog-
gler hotspot"). This hotspot can be any text in the topic.When users click the hotspot, the hidden content is dis-
played.When users click the hotspot again, the content becomeshidden oncemore. See "Togglers" on
page 119.
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Drop-down Text This is a feature similar to a toggler. It lets you collapse content in your topic.When the user
clicks the drop-down text link, the content is expanded below it. See "Drop-Downs" on page 127 and "Inserting
Drop-Down Text " on page 129.

For example, let's say you have a topic containing step-by-step proceduresand it seems to be getting quite
lengthy. So you decide to condense the portion of the topic that contains the procedures. Select all of the text that
you want to condense into the drop-down effect and then use the Insert ribbon or menu to create a drop-down
effect. You can select and edit the drop-down head and the drop-down hotspot (the link portion of the drop-down
head the usersmust click to activate the drop-down effect). When users open the topic in the output, theywill see
the drop-down hotspot. This hotspot is the first paragraph (or a section of the first paragraph) of the drop-down
effect. When users click the hotspot, the hidden content is displayed below the hotspot.When users click the hot-
spot again, the content becomeshidden oncemore.

Expanding Text This is a feature similar to drop-down text. The difference is that, instead of multiple para-
graphs, you are condensing a single paragraph. You designate a portion of text in a paragraph to serve as the
expanding text hotspot.When users click the hotspot, the rest of the paragraph is displayed.When users click the
hotspot again, the rest of the paragraph is hidden oncemore. See "Expanding Text" on page 139.

Concept Link (also known as a "see also" link or "A-link") This is a navigation link that lets users open top-
ics that you've determined are related to the current topic. It is similar to the related topics link. However, whereas
you associate a related topics linkwith specific individual topics (usually for a one-time use), you associate a
concept linkwith a group of topics (to be reused in different topics). One great benefit of this type of link is that, if
you later want to add or delete topics from the group, you only need to do so in one place and the changesare
applied to every topic containing that concept link. See "Reasons for Using Concepts" on page 149 and "Inserting
Concept Links" on page 169.

E X A M P L E

Let's say you are developing a Help system for an employee time-reporting software application. You
might have a group of related topics (e.g., Creating a Time Sheet, Changing a Time Sheet, Deleting a
Time Sheet), and you want each of those topics to have the sameHelp control button that links to the
same topics. So youmight create a concept called "TimeSheets." You would then insert the keyword into
each of those topics. After that, you insert a concept link into each of those topics, selecting the
"Timesheets" keyword for that link.

CHAPTER 1│Navigation Links Guide 9



Keyword Link (also known as a "K-link") This is a navigation link that lets users open topics related to the cur-
rent topic based on index keywords that they share. See "Keyword Links" on page 205.

E X A M P L E

Let's say you have inserted an index keyword called "Accounting department" to some of the topics in
your project, including the current topic that you are working on. At the bottom of this topic, you insert a
keyword link that includes the "Accounting department" index keyword. In the final output, when users
click thisHelp control, they can select and open any topics that also contain the "Accounting department"
keyword.

Relationship Link This is a navigation link that lets users open topics that you've determined are related to the
current topic. This is similar to related topics links and concept links. A relationship link is especially designed for
DITA users; however, you do not need to use DITA or know anything about it in order to use relationship links. A
relationship table can be created to identifywhich topics should be linked to one another. You then insert a rela-
tionshipsproxy into individual topics. In online output the end result is one or more hyperlinks that let users quickly
open related topics. In print-based output the end result is one or more references to related topicswith the appro-
priate page number(s). See "Relationship Table Components" on page 217 and "Inserting Relationship Links" on
page 245.

Shortcut Control This is a navigation link that lets users launch a program or window in an application that has
a relationship to the current topic. See "Shortcut Controls" on page 257.

Warning: It is recommended that you avoid creating links to snippets.This is primarily due to the nature of
snippets, which are designed to be inserted intomultiple files. Let's say you have a heading style in a snippet
and that snippet is then inserted into 12 different topics. In another topic, youmight decide to create a cross-
reference that points to the heading in that snippet. But which of those 12 topics is it supposed to point to in
the output? There is no way for Flare to know this, so you could end up with some very undesirable results.
For this reason, it's a good idea not to link to any content in a snippet.
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Cross-References

This feature is supported in all outputs.

A cross-reference is a navigation link that lets you connect text in one topic to another topic (or
a bookmarkwithin a topic). This is somewhat similar to a text hyperlink. However, cross-ref-
erencesdiffer from hyperlinks in a few ways. Theyare based on format commands

This chapter discusses the following:

Automating Links Based on Commands 12

Tasks Associated with Cross-References 15

Inserting Cross-References 16

Creating Context-Sensitive Cross-References 24

Editing Cross-References 28

Editing Cross-Reference Destinations 29

Editing Cross-Reference Style Formats 32

Editing Text for Context-Sensitive Cross-References 34

Updating Cross-References 35



Automating Links Based on Commands
Cross-references let you create automated links that are based on commandsyou provide. This allowsyou to keep links
consistent and change them in just one place byusing the <MadCap|xref> style. Commandsare contained in brackets
(e.g., {paratext}).

E X A M P L E

Let's say you have a topicwith the title "About Things," and there are several other topics in your project that you
want to link to that topic. Furthermore, let's say that each one of those linksneeds to have the same text (e.g.,
"For more information see 'About Things.'")

Now, you could use a text hyperlink in each of those topics; thiswould be a good option if the text in each of the
links needed to be different. But instead you create a cross-reference using the <MadCap|xref> style. In this style
you specify the exact text mentioned above, along with the {paratext} command, which displays the text of the first
paragraph it finds (such asa topic heading). You can use that cross-reference style anywhere that you'd like to
create a link using that configuration.When you insert the cross-reference it includes the text you provided (e.g.,
"For more information see"), and it uses the {paratext} command to display the heading text for the destination
topic (e.g., "About Things").When you put it all together, you have "For more information see 'About Things.'"

Later, if you decide to change the heading text of the destination topic to "AboutWhatchamacallits," the cross-ref-
erenceswill be updated automaticallywhen you generate the output. The new heading will automatically be
reflected in all of the links using that cross-reference style (i.e., "For more information see 'AboutWhatchamac-
allits'"). If you had used text hyperlinks in a situation like this, you would need to find and replace the text in all of the
pertinent linksmanually.

E X A M P L E

Here is an example of a cross-reference format, using a combination of text and commands:

See {b}"{paratext}"{/b} on page {page}.

A format such as thismight be translated in the output as something like this:

See "Dogs and Cats" on page 93.

If you are using autonumbers in your content (e.g., for figure or table numbers), you can create cross-reference formats
that include the autonumbers.

12



E X A M P L E

Let's say that you have created autonumbers in order to number all of the figures in your project. Perhaps your
autonumber format is set up to show the word "Figure" followed byan incremented number and a colon (e.g.,
Figure 4:, Figure 5:, Figure 6:). In addition, wherever you apply autonumbering in a topic, youmight manually
type a short description of the image (e.g., PropertiesDialog). So in the output under the graphic, the user might
see something like this:

Figure 4: PropertiesDialog

Now let's say that you want to insert a cross-reference in another topic that points the user to the Figure 4
graphic. To do this, first of all you would probablywant to insert a bookmarkat that autonumber location so that
you can point directly to that paragraph when you insert the cross-reference. Then you can create a special
cross-reference format that includes the autonumber portion of that paragraph. The following two autonumber
commandscan be used:

{paranum}This command displaysall of the content in the autonumber format, including any text before an
autonumber, the autonumber itself, and any text after the autonumber. Using the example provided above, this
commandwould display something like this in the cross-reference:

Figure 4:

{paranumonly}This command displaysany text before an autonumber and the autonumber itself. However, it
doesnot show any text after the autonumber (such asa colon). Using the example provided above, this com-
mandwould display something like this in the cross-reference:

Figure 4

In addition, if you want to include any text that youmanually add in the topic after the autonumber format, you can
add the {paratext} command to the cross-reference format. Using the example provided above, this command
would display something like this in the cross-reference:

PropertiesDialog

Therefore, suppose your entire cross-reference format is this:

See "{paranum} {paratext}"

In that case, the output would display something like this:

See "Figure 4: PropertiesDialog"

CHAPTER 2│Navigation Links Guide 13



On the other hand, suppose your entire cross-reference format is this:

See "{paranumonly} {paratext}"

In that case, the output would display something like this (without the colon):

See Figure 4 PropertiesDialog

Again, when you insert the cross-reference in a topic, make sure you select the format that you created, and also
remember to link to the bookmarked paragraph where the autonumber appears.

Tip: If you insert a cross-reference into a topic and it initially doesnot look the wayyou expected, try updating
the cross-references in the topic. See "Updating Cross-References" on page 35.

14



Tasks Associated with Cross-References
You can do the following with cross-references.

Insert You can create new <MadCap|xref> styles, add commands, and add the cross-references to topics. See
"Inserting Cross-References" on the next page.

Create context-sensitive cross-references For print-based and EPUBoutput you can create context-sens-
itive cross-references, which automatically change the text in the link based on the relationship of the cross-ref-
erence and the target location. See "Creating Context-Sensitive Cross-References" on page 24.

Edit You can change the style and settings for a cross-reference. See "Editing Cross-References" on page 28.

Update You can refresh your cross-reference linksmanually so that theydisplay updated information. See
"Updating Cross-References" on page 35.

Single-source You can use stylesheet mediums to single-source your cross-reference formats. For example,
you can create a cross-reference format that displaysas "See 'MyTopic'" in some outputs (e.g., online doc-
umentation) but as "See 'MyTopic' on page 44" in other outputs (e.g., print-based formats). For more inform-
ation see the online Help or the FlareStylesGuide.

Note: You can use the built-in Analyzer and reports to find broken links.

Note: You can generate a report to see places in your project where youmight want to create a cross-ref-
erence. Essentially, Flare finds fileswhere a hyperlink to a topic exists. Because cross-referencesare generally
preferred over hyperlinks (due to the fact that theyare dynamic), it suggests that you create a cross-reference
instead.

CHAPTER 2│Navigation Links Guide 15



Inserting Cross-References
You can insert cross-referencesas follows:

Standard You can use the "Standard" method, which allowsyou to select more optionswhen you insert the link,
such asmodifying the cross-reference format or choose a target frame. Thismethod lets you quickly select from a
list of files in your project or use a tree view with folders.

Quick You can use the "QuickCross-Reference" method, which is faster but doesnot have asmanyoptions. This
method lets you quickly select a bookmark in the current file, a file in the same folder, or another file currently open.

HOW TO INSERT A CROSS-REFERENCE—STANDARD METHOD

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor place your cursor where you want to insert the cross-reference.

3. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In the Links section, selectCross-Reference.

Menu Select Insert>Cross-Reference.

Keyboard Shortcut PressCTRL+SHIFT+R.

Local Toolbar In the local toolbar of the XMLEditor, click .

The Insert Cross-Reference dialog opens.

4. From the Link to drop-down field, select a way to identify the topic or bookmark to which you want to link. Based
on the option you choose, the section below gives you a list of selectionsor additional fields to complete.

TOPIC IN PROJECT

This option lets you search for a topicwithin your project. After you select this option, use the area below to nav-
igate to the file that you want to link to and select it. Byusing the buttons in the local toolbar, you can view all files in
a list, view files in their folder structure, and use other options.

Showsall of the files in the project in a list in the area below. If you click the button again, it switches to a
folder tree view. In the list, you can click the File, Type, or Path column headers to sort the list alpha-
betically by that column data.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the area
splits into two halves. The folder is shown on the left side, and the files and subfolderswithin it are shown
on the right.

16



If the Show Files button is the only one selected, you can click this button tomove up one folder level.

You can also click to display and select anybookmarkswithin the destination topic.

PLACE IN THIS DOCUMENT

This option displaysanyheadingsand bookmarks in the current file. After you click this option, use the section
below to choose the heading or bookmark to which you want to link.

CHAPTER 2│Navigation Links Guide 17



5. In theCross-Reference Properties section, select the <MadCap:xref> style that you want to use for the cross-
reference.

Initially, youmaysee only the parent <MadCap:xref> tag in the list. In the XRef Format area to the right, you can
see the current format associated with that tag. Bydefault, it initially is: See "{paratext}." The command {paratext}
means that the text of the paragraphed bookmark—or the text of the first paragraph found in the topic—will be dis-
played at that spot.

You can: (1) use the parent <MadCap:xref> tag with its current format, (2) use the parent <MadCap:xref> tag
and change the format to something else, (3) create a new classof the <MadCap:xref> tag and provide a custom
format for it, or (4) use a class that you have already created previously.

It is a good idea to create classesbecause youmayeventuallywant to usemultiple kindsof cross-references in
your project. Each class that you create can be used to display cross-references in a different format. For more
information about using styles, including steps, see the online Help or the FlareStylesGuide.

6. If you want to use the parent <MadCap:xref> tag with its current format, or a class that you have created pre-
viously, clickMadCap:xref or the name of the class, respectively. Then continue with Step 13.

7. If you want to use the parent <MadCap:xref> tag but change the format, clickMadCap:xref and thenEdit. The
Edit Cross-Reference Style Classdialog opens. Continue with Step 10.

8. If you want to create a new classof the parent <MadCap:xref> tag, clickNew. The New Cross-Reference Style
Classdialog opens.

9. In theXRef Class field, give your new classa name.

10. In theStylesheet to modify field, select the appropriate stylesheet (if different from the one shown). If you are
using amaster stylesheet (recommended), only that stylesheet is shown in this field. If you are not using amaster
stylesheet, the stylesheet that you select needs to be applied to the topic in which you are inserting the cross-ref-
erence.

11. In theEnter format field, provide the format for the style. This format can be a combination of text that you type
and automated commands that you select. You can select commands from the list by double-clicking them. They
are then added to the "Enter format" field.

Command Description

b Start bold text

/b End bold text

bg Start new background color

/bg End background color

18



Command Description

color Start new text color

/color End text color

default Reset all font changes

ext File extension

family Start new font family

/family End font family

file File name, including extension

filename File name, without extension

h1 Text of first heading 1 paragraph

h2 Text of first heading 2 paragraph

h3 Text of first heading 3 paragraph

h4 Text of first heading 4 paragraph

h5 Text of first heading 5 paragraph

h6 Text of first heading 6 paragraph

i Start italic text

/i End italic text

page Page number

pagecount Page count

pageref Context-sensitive page reference

paranum The autonumber text of bookmarked paragraph.

CHAPTER 2│Navigation Links Guide 19



Command Description

paranumonly The autonumber only of bookmarked paragraph

paratext Text of bookmarked paragraph

paraxml Text andmarkup of bookmarked paragraph

path File path

size Start new font size

/size End font size

sub Start subscript text

/sub End subscript text

sup Start superscript text

/sup End superscript text

title Title of document

u Start underlined text

/u End underlined text

url File path, URL syntax

20



E X A M P L E

If you want the cross-reference to include text (such as "For more information see"), simply type it in this
field. You can also double-click anyof the commands to add them to this field. For example, youmight
want to add the text of the first paragraph in the destination file to the cross-reference format. The com-
mand for this is {paratext}. Descriptions for each command are displayed in the list.

Some commands include a start tag and an end tag. For example, if you want a portion of the cross-ref-
erence to be displayed in bold, you would place your cursor in the "Enter format" field where want to start
the bold font and double-clickb in the list below. Then place your cursor where you want the bold font to
end and double-click /b from the list.

So in the end, your cross-reference format might include a combination of text andmultiple commands,
such as:

For more information see {b}{paratext}{/b}

A format such as this onemight display a link in the output like this:

For more information seeMy Destination Topic

12. ClickOK.

13. (Optional) In the Target Frame field of the Insert Cross-Reference dialog, click the drop-down arrow to select the
way the linked destination will open. This option can be used to open the destination topic or file in a popup.

(default) The destination file will open in the samewindow as the output window.

Parent Frame_parent The destination file will open in the parent frame of the current topicwhile hiding
that topic.

New Window_blank The destination file will open in a new browser window.

Same Frame_self The destination file will open in the samewindow frame as the current topic.

Top Frame_top The destination file will open in the same output window, removing all other framesets.
Youmight use this option, for example, if the destination topic has its own frameset.

Popup Window The destination file will open in a popup boxon top of the current topic.

CHAPTER 2│Navigation Links Guide 21



14. (Optional) In theScreen Tip field, you can type a phrase that will appear when the end user hovers over the
cross-reference in the output.

When you enter a screen tip, it is added asa <title> tag in themarkup. In addition, an <alt> (alternate text) tag is
added with the same text. This is usefulwhen it comes to accessibility.

For more information see the online Help.

15. ClickOK. The cross-reference is added to the topic. You can change the appearance of the link (e.g., color, under-
line) bymodifying the style (e.g., MadCap|xref or MadCap|xref.MyStyle) in the Stylesheet Editor.

16. Click to save your work.

22



HOW TO INSERT A CROSS-REFERENCE—QUICK CROSS-REFERENCE METHOD

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor right-click at the location where you want to insert the cross-reference.

3. From the context menu selectQuick Cross-Reference.

4. Select the appropriate submenu, depending on the option that helps you find the destination the fastest.

Bookmarks Lets you select anybookmarks that you have already inserted into the current file.

Same Folder Lets you select any files that are contained in the same folder in the Content Explorer.

Open Documents Lets you select anyother files that are also currently open in the workspace.

5. From the next submenu choose the bookmarkor file. The cross-reference is added to the topic. You can change
the appearance of the link (e.g., color, underline) bymodifying the style (e.g., MadCap|xref or MadCap|xre-
f.MyStyle) in the Stylesheet Editor.

6. Click to save your work.
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Creating Context-Sensitive Cross-References

This feature is supported in EPUBand in all print outputs (Adobe FrameMaker, Adobe PDF,MicrosoftWord,
Microsoft XPS, XHTML).

For print-based and EPUBoutput you can create context-sensitive cross-references, which automatically change the text
in the link based on the relationship of the cross-reference and the target location.

E X A M P L E

Let's say that you have a cross-reference that is designed to display the text "See Figure 2.1." If the link and the
target fall on the same page, the cross-reference is updated to display the text, "See Figure 2.1 above" or "See
Figure 2.1 below." If the link and the target are on adjacent pages, the cross-reference is updated to display the
text, "See Figure 2.1 on the previouspage" or "See Figure 2.1 on the next page." If the document is double-sided
with the link on the left page and the target on the right page, the cross-reference is updated to display the text,
"See Figure 2.1 on the facing page."

Using context-sensitive cross-references is simply amatter of using the correct command. In other words, instead of using
the simple {page} command, you can use the {pageref} command.

E X A M P L E

Let's say you use the plain {page} command. Perhaps the complete format that you create for a cross-reference
style is this:

See "{paratext}" on page {page}.

When you generate the output, this cross-reference will be converted to something like the following, regardless
of where the link falls in relation to its destination:

See "My Information" on page 42.

However, let's say that you use a slightly different format, something like this:

See "{paratext}" {pageref}.

24



When you generate the output, what you see in place of {pageref} dependson the relative closenessof the link
and the destination. It might be translated asanyof the following:

See "My Information" below.

See "My Information" above.

See "My Information" on previouspage.

See "My Information" on page 42.
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HOW TO CREATE CONTEXT-SENSITIVE CROSS-REFERENCES

1. Go through the processof inserting or editing a cross-reference. See "Inserting Cross-References" on page 16
and .

2. In the Insert Cross-Reference dialog, select either Newor Edit, depending on whether you want to create a new
cross-reference style or edit an existing one.

3. Provide a format in theEnter format field. This format can be a combination of text and automated commands.

When creating this format, make sure you include the {pageref} command in it. You can find the command by
selecting either Show All or Show Page Commands. When you find the {pageref} command in the list, double-
click it to add it to the format. Here is an example of a format that contains a context-sensitive cross-reference com-
mand: See "{paratext}" {pageref}.

4. ClickOK.
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Note: You also have control over the text used in context-sensitive cross-references (e.g., instead of the text
displaying "on next page," it can be customized to display "on following page"). You can customize this text
through the use of a language skin. See "Editing Text for Context-Sensitive Cross-References" on page 34.
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Editing Cross-References
After you insert cross-references into topics, you can edit them in the following ways.

Destination You can change the file to which the cross-reference is pointing. See "Editing Cross-Reference
Destinations" on the following page.

Style Format You can change the style format used for cross-references. For example, instead of "SeeMy
Topic," youmight want cross-references to display "For more information seeMy Topic." See "Editing Cross-
Reference Style Formats" on page 32.

Context-sensitive Text You can use language skins to localize the text used in your cross-references. In addi-
tion, even if you plan to create output in only one language, you can use a language skin to change the autotext
that is displayed for context-sensitive cross-references. For example, instead of the text displaying "on next
page," it can be customized to display "on the following page." See "Editing Text for Context-Sensitive Cross-
References" on page 34.

28



Editing Cross-Reference Destinations
After you insert cross-references into topics, you can change the file to which the cross-reference is pointing.

HOW TO EDIT A CROSS-REFERENCE DESTINATION

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, right-click on the cross-reference and selectEdit Cross-Reference. The Insert Cross-Refer-
ence dialog opens.

3. From the Link to drop-down field, select a way to identify the topic or bookmark to which you want to link. Based
on the option you choose, the section below gives you a list of selectionsor additional fields to complete.

TOPIC IN PROJECT

This option lets you search for a topicwithin your project. After you select this option, use the area below to nav-
igate to the file that you want to link to and select it. Byusing the buttons in the local toolbar, you can view all files in
a list, view files in their folder structure, and use other options.

Showsall of the files in the project in a list in the area below. If you click the button again, it switches to a
folder tree view. In the list, you can click the File, Type, or Path column headers to sort the list alpha-
betically by that column data.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the area
splits into two halves. The folder is shown on the left side, and the files and subfolderswithin it are shown
on the right.

If the Show Files button is the only one selected, you can click this button tomove up one folder level.

You can also click to display and select anybookmarkswithin the destination topic.
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PLACE IN THIS DOCUMENT

This option displaysanyheadingsand bookmarks in the current file. After you click this option, use the section
below to choose the heading or bookmark to which you want to link.
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4. (Optional) In the Target Frame field of the Insert Cross-Reference dialog, click the drop-down arrow to select the
way the linked destination will open. This option can be used to open the destination topic or file in a popup.

(default) The destination file will open in the samewindow as the output window.

Parent Frame_parent The destination file will open in the parent frame of the current topicwhile hiding
that topic.

New Window_blank The destination file will open in a new browser window.

Same Frame_self The destination file will open in the samewindow frame as the current topic.

Top Frame_top The destination file will open in the same output window, removing all other framesets.
Youmight use this option, for example, if the destination topic has its own frameset.

Popup Window The destination file will open in a popup boxon top of the current topic.

5. (Optional) In theScreen Tip field, you can type a phrase that will appear when the end user hovers over the
cross-reference in the output.

When you enter a screen tip, it is added asa <title> tag in themarkup. In addition, an <alt> (alternate text) tag is
added with the same text. This is usefulwhen it comes to accessibility.

For more information see the online Help.

6. ClickOK.

7. Click to save your work.
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Editing Cross-Reference Style Formats
You can change the style format used for cross-references. For example, instead of "SeeMyTopic," youmight want
cross-references to display "For more information seeMy Topic."

You can edit cross-reference style formats at the point where a cross-reference is inserted, or from a stylesheet.

HOW TO EDIT A CROSS-REFERENCE STYLE FORMAT AT THE POINT OF INSERTION

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, click inside the link.

3. At the top of the XMLEditor, right-click the span bar representing the link. For example, hyperlink span bars have
an "a" label, and cross-reference span bars have a "MadCap:xref" label. When you click on the link in the topic,
the appropriate span bar at the top of the XMLEditor will change color to indicate that it goeswith the link. If your
span bars are not turned on, click in the local toolbar of the XMLEditor.

4. SelectEdit Cross-Reference. The Insert Cross-Reference dialog opens.

5. In theCross-Reference Properties section, select theMadCap:xref style that you want to edit.

<MadCap:xref> is the parent tag and default selection, but in the Stylesheet Editor you can create style classes
under that tag if you want a variety of looks for cross-references.

6. ClickEdit. The Edit Cross-Reference Style Classdialog opens.

7. (Optional) In theStylesheet to modify field, you can select the appropriate stylesheet (if different from the one
shown). If you are using amaster stylesheet (recommended), only that stylesheet is shown in this field. If you are
not using amaster stylesheet, the stylesheet that you select needs to be applied to the topic in which you are insert-
ing the cross-reference. For more information see the online Help or the FlareStylesGuide.

8. In theEnter format field, provide the format for the class. This format can be a combination of text that you type
and automated commands that you select. You can select commands from the list by double-clicking them. They
are then added to the "Enter format" field.

9. ClickOK.

10. Click to save your work.

11. (Optional) Tomake sure other cross-references in your project display the new format, you can update the cross-
references in a topic (Tools>Update Cross-References). However, all of the cross-references in your project
will be updated automaticallywhen you generate the output, so this is not amandatory task.
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HOW TO EDIT A CROSS-REFERENCE STYLE FORMAT FROM A STYLESHEET

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Advanced view is cur-

rently shown in the editor). If the button displays instead, then click it.

Note: For stepsusing the Simplified View, see the online Help.

3. In the upper-left corner of the editor, click in theShow Styles field and select .

4. On the left side of the Stylesheet Editor, select theMadCap|xref tag (or a classof it) that you want to edit.

5. From theShowdrop-down list on the upper-right side of the editor, select . The
most relevant properties for that style are shown on the right side of the editor.

6. Click in the value column on the right side of themc-format property.

7. In theEnter format field, provide the format for the class. This can be a combination of text that you type and auto-
mated commands that you select. You can select commands from the list by double-clicking them, adding them to
the "Enter format" field.

8. ClickOK.

9. Click to save your work.

10. (Optional) Tomake sure cross-references in your project display the new format, you can update the cross-ref-
erences in a topic (select Tools>Update Cross-References in either the ribbon or menu interface). However,
all of the cross-references in your project will be updated automaticallywhen you generate the output, so this is
not amandatory task.
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Editing Text for Context-Sensitive Cross-References
You can use language skins to localize the text used in your cross-references. In addition, even if you plan to create output
in only one language, you can use a language skin to change the autotext that is displayed for context-sensitive cross-ref-
erences. For example, instead of the text displaying "on next page," it can be customized to display "on the following page."
See "Creating Context-Sensitive Cross-References" on page 24.

Flare provides skins for manydifferent languages. If Flare doesnot provide a skin for a language that you would like to use,
you can create a user-defined language skin.

HOW TO EDIT TEXT FOR CONTEXT-SENSITIVE CROSS-REFERENCES

1. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Tools ribbon. In the Templates section selectManage Language Skins.

Menu Select Tools>Manage Language Skins.

The Language Skinsdialog opens.

2. From the list, select a language in bold or italic font.

3. ClickOpen File For Editing. If you selected a language in bold, clickOK in themessage that displays. The Lan-
guage Skin Editor opens.

4. On the left side of the editor, select Formats

5. On the right side of the editor, expand theCross-Reference group.

6. Click in anyof the cells on the right and change the text asnecessary.

Note: The "Format" and "Format for Print" fields not only contain text, but theyalso contain format
commands in brackets—for example, {paratext} and {page}. For a list of commands that you can use,
see "Editing Cross-Reference Style Formats" on page 32.

7. Click to save your work.
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Updating Cross-References
If you insert cross-references into topics and then later edit the formats for those cross-references (or make other
changes in the project that might affect them), you can update the cross-references in a topic. Byupdating cross-ref-
erences, you are essentially refreshing them so that they reflect anypertinent changes in the project since you inserted
them.

Updating cross-references is not amandatory step when it comes to the output.When you generate output for a target, all
of your cross-references in the output will be updated automatically. However, the cross-references in the source files in
your project will remain as theywere. But you can use the following steps tomanually update cross-references in a single
content file, such asa topic or snippet. This is a wayof performing a spot checkahead of time, verifying that cross-ref-
erenceswill be updated accurately before you generate the output.

HOW TO UPDATE CROSS-REFERENCES

1. Open a content file (e.g., topic).

2. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Tools ribbon. In theUpdate section selectUpdate Cross-References.

Menu Select Tools>Update Cross-References.

The Update Cross-Reference dialog opens, displaying the destination topics of your cross-references.

3. ClickUpdate.
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Text Hyperlinks

This feature is supported in all outputs.

A text hyperlink is one of themost basic formsof a navigation link. It is simply a hyperlink
applied to text. When an end user clicks the hyperlink in the output, the location specified in the
hyperlink opens. The location can be another topic in the project (including a bookmarkwithin
that topic), a topic in an imported HTMLHelp file, or a file outside of the project (such asa web-
site on the Internet).

This chapter discusses the following:

Inserting Text Hyperlinks 38

Editing Text Hyperlinks 45



Inserting Text Hyperlinks
You can insert text hyperlinks in a few ways.

Standard You can use the "Standard" method, which allowsyou to select more optionswhen you insert the link,
such as choosing a style class. Thismethod lets you quickly select from a list of files in your project or use a tree
view with folders.

Drag-and-Drop You can quickly create hyperlinksbydragging topics from the Content Explorer or a TOC. This
method is very quick, but doesnot let you specify anyoptionswhen creating the link.

Quick Link You can use the "Quick Link" method, which is faster but doesnot have asmanyoptions. This
method lets you quickly select a bookmark in the current file, a file in the same folder, or another file currently
open.

HOW TO INSERT A TEXT HYPERLINK—STANDARD METHOD

1. Open the content file (e.g., topic, snippet).

2. Highlight the text that you want to use as the link (or "hotspot").

3. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In the Links section, selectHyperlink.

You can use theOptionsdialog to switch between ribbonsand the classic tool strip layout. For more inform-
ation see the online Help.

Keep inmind that the smaller the application window becomes, themore the options in a ribbon shrink.
Therefore, youmight only see a small icon instead of text, or youmight see only a section name displayed
with a down arrow to access the options in it. You can hover over small icons to see tooltips that describe
them. You can also enlarge the application window or click one of the section drop-downs in the ribbon to
locate a hidden feature.

Menu Select Insert>Hyperlink.

Keyboard Shortcut PressCTRL+K.

Local Toolbar In the local toolbar of the XMLEditor, click .

The Insert Hyperlink dialog opens.
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4. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which you want to link.
Based the option you choose, the section below gives you a list of selectionsor additional fields to complete.

FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the area below to navigate
to the file that you want to link to and select it. Byusing the buttons in the local toolbar, you can view all files in a list,
view files in their folder structure, and use other options.

Showsall of the files in the project in a list in the area below. If you click the button again, it switches to a
folder tree view. In the list, you can click the File, Type, or Path column headers to sort the list alpha-
betically by that column data.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the area
splits into two halves. The folder is shown on the left side, and the files and subfolderswithin it are shown
on the right.

If the Show Files button is the only one selected, you can click this button tomove up one folder level.

You can also click to display and select anybookmarkswithin the destination file, or if you have selected a
PDF file. See "Bookmarks" on page 71 and "NamedDestinations" on page 77.

PLACE IN THIS DOCUMENT

This option displaysanyheadingsand bookmarks in the current file. After you click this option, use the section
below to choose the heading or bookmark to which you want to link.
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EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF,Microsoft Office files) outside your project.
This is especially useful if you want to link from one topic to another in separate project outputs, such asCHM files.
After you select this option, enter the path to the file in the field next to the External File button.

You can also click to display and select anybookmarkswithin the destination file, or if you have selected a
PDF file. See "Bookmarks" on page 71 and "NamedDestinations" on page 77.

For more information see "External Links—HTML, PDF,Microsoft Office" on page 97.

Note: Because the link usually needs to be relative, based on the final locationsof your output files, it is
preferable to enter the text directly into the field, rather than clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you click this option,
simply type the path in the field next to the Website field (e.g., http://www.acme.com).

You can create links to specific topics in HTML5,WebHelp,WebHelp Plus, or WebHelpMobile output. This
includes the ability to incorporate search stringsand skin references (for some outputs).

EMAIL

This option lets you add an email addressand subject line so that the user can quickly send an email.

E X A M P L E

Youmight use this feature to help the end user send an email to your company's technical support
department.When users click the link, it opens their email program and beginsa new emailmessage for
them, inserting the email addressand subject line for them. After you click this option, complete theE-
mail address andSubject fields to the right (or select a recent email address from the list below).
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HTML HELP FILE

This option lets you search for a topicwithin an HTMLHelp (CHM) file that you have added to your project. After
you select this option, click theExternal File button. In the Link to HTMLHelp dialog, you can do one of the fol-
lowing.

SelectProject Files and then use the area below to navigate to the file that you want to link to and select it.
Byusing the buttons in the local toolbar, you can view all files in a list, view files in their folder structure, and
use other options.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the
area splits into two halves. The folder is shown on the left side, and the files and subfolderswithin
it are shown on the right.

Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then from the drop-
down—which displays "(root folder)" by default, you can select a specific content folder in your project to
place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and double-click the topic
that you want to link to.

When you are finished, clickOK in the Link to HTMLHelp dialog.

5. (Optional) The Link text field displays the text that you highlighted in the topic, which will be used as the hyperlink.
Leave the text as it is, unless you decide you would like to change it. If you want to change the link text, type the
new text in the field. It will replace the previously selected text in the topic.

6. (Optional) In theScreen Tip field you can type a phrase that will appear when the end user hovers over the hyper-
link in the output.

When you enter a screen tip, it is added asa <title> tag in themarkup. In addition, an <alt> (alternate text) tag is
added with the same text. This is usefulwhen it comes to accessibility.

For more information see the online Help.

7. (Optional) Next to the Style Class field click theSelect button. This opens the Select Classdialog, which lets you
apply one of the defined hyperlink styles from your stylesheet to the link. You can change the appearance of the
link in the Stylesheet Editor. After you select a style class in the dialog, clickOK. The Style Class field displays the
selected style. (If you do not specify a style class, Flare uses the parent <a> tag.)
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8. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked destination will open
(e.g., in another window, in a popup).

(default) The destination file will open in the samewindow as the output window.

Parent Frame_parent The destination file will open in the parent frame of the current topicwhile hiding
that topic.

New Window_blank The destination file will open in a new browser window.

Same Frame_self The destination file will open in the samewindow frame as the current topic.

Top Frame_top The destination file will open in the same output window, removing all other framesets.
Youmight use this option, for example, if the destination topic has its own frameset.

Popup Window The destination file will open in a popup boxon top of the current topic.

9. (Optional) In the Tab Index field you can enter a value to specify the order in which users can tab through hyper-
links in a topic. So when a user presses the Tab key the first time in a topic, the hyperlinkwith an index value of 1
will be selected first, the hyperlinkwith a value of 2 will be selected next, and so on. If you want to skip a hyperlink,
enter -1 in that field.

Note: This feature is supported only inWebHelp outputs—WebHelp, HTML5,WebHelp AIR,
WebHelpMobile,WebHelp Plus.

10. ClickOK. The hyperlink is added to the topic.

11. Click to save your work.
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HOW TO INSERT A TEXT HYPERLINK—DRAG-AND-DROP METHOD

1. Open the content file (e.g., topic, snippet).

2. Do one of the following:

Make sure the Content Explorer is open.

Note: You can also use the Content Explorer's split view to drag topics from the Content
Explorer into the appropriate location in the topic. Thiswill form a special kind of hyperlink called
a related topics link. See "Related Topics Links" on page 187.

Make sure one of your TOCs is placed so that it can be seen next to the topic. You can do this bymoving,
docking, or floating window panes.

3. Click and drag the topic to which you want to link from the Content Explorer or TOC to the appropriate location in
the topic. The hyperlink is added to the topic.

4. Click to save your work.
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HOW TO INSERT A TEXT HYPERLINK—QUICK LINK METHOD

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor right-click at the location where you want to insert the hyperlink.

3. From the context menu selectQuick Link.

4. Select the appropriate submenu, depending on the option that helps you find the destination the fastest.

Bookmarks Lets you select anybookmarks that you have already inserted into the current file.

Same Folder Lets you select any files that are contained in the same folder in the Content Explorer.

Open Documents Lets you select anyother files that are also currently open in the workspace.

5. From the next submenu choose the bookmarkor file. The hyperlink is added to the topic.

6. Click to save your work.
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Editing Text Hyperlinks
You can edit text hyperlinks that you have inserted into a topic in at least three different ways: (1) edit the destination and
properties of the hyperlink, (2) edit the style of the hyperlink, and (3) unbind (or remove) the hyperlink from the text.

HOW TO EDIT THE DESTINATION AND PROPERTIES OF A TEXT HYPERLINK

The first way to edit text hyperlinks is to change the destination and other properties (link text, target frame, screen tip).

E X A M P L E

Let's say that you test the topic containing the text hyperlink and you notice that the wrong destination topic is
opening when you click the hyperlink. So you use the stepsbelow to associate the correct destination topicwith
the hyperlink.

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, click inside the link.

3. At the top of the XMLEditor, right-click the span bar representing the link. For example, hyperlink span bars have
an "a" label, and cross-reference span bars have a "MadCap:xref" label. When you click on the link in the topic,
the appropriate span bar at the top of the XMLEditor will change color to indicate that it goeswith the link. If your
span bars are not turned on, click in the local toolbar of the XMLEditor.

4. SelectEdit Hyperlink. The Insert Hyperlink dialog opens.

5. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which you want to link.
Based the option you choose, the section below gives you a list of selectionsor additional fields to complete.
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FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the area below to navigate
to the file that you want to link to and select it. Byusing the buttons in the local toolbar, you can view all files in a list,
view files in their folder structure, and use other options.

Showsall of the files in the project in a list in the area below. If you click the button again, it switches to a
folder tree view. In the list, you can click the File, Type, or Path column headers to sort the list alpha-
betically by that column data.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the area
splits into two halves. The folder is shown on the left side, and the files and subfolderswithin it are shown
on the right.

If the Show Files button is the only one selected, you can click this button tomove up one folder level.

You can also click to display and select anybookmarkswithin the destination file, or if you have selected a
PDF file. See "Bookmarks" on page 71 and "NamedDestinations" on page 77.

PLACE IN THIS DOCUMENT

This option displaysanyheadingsand bookmarks in the current file. After you click this option, use the section
below to choose the heading or bookmark to which you want to link.
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EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF,Microsoft Office files) outside your project.
This is especially useful if you want to link from one topic to another in separate project outputs, such asCHM files.
After you select this option, enter the path to the file in the field next to the External File button.

You can also click to display and select anybookmarkswithin the destination file, or if you have selected a
PDF file. See "Bookmarks" on page 71 and "NamedDestinations" on page 77.

For more information see "External Links—HTML, PDF,Microsoft Office" on page 97.

Note: Because the link usually needs to be relative, based on the final locationsof your output files, it is
preferable to enter the text directly into the field, rather than clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you click this option,
simply type the path in the field next to the Website field (e.g., http://www.acme.com).

You can create links to specific topics in HTML5,WebHelp,WebHelp Plus, or WebHelpMobile output. This
includes the ability to incorporate search stringsand skin references (for some outputs).

EMAIL

This option lets you add an email addressand subject line so that the user can quickly send an email.

E X A M P L E

Youmight use this feature to help the end user send an email to your company's technical support
department.When users click the link, it opens their email program and beginsa new emailmessage for
them, inserting the email addressand subject line for them. After you click this option, complete theE-
mail address andSubject fields to the right (or select a recent email address from the list below).
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HTML HELP FILE

This option lets you search for a topicwithin an HTMLHelp (CHM) file that you have added to your project. After
you select this option, click theExternal File button. In the Link to HTMLHelp dialog, you can do one of the fol-
lowing.

SelectProject Files and then use the area below to navigate to the file that you want to link to and select it.
Byusing the buttons in the local toolbar, you can view all files in a list, view files in their folder structure, and
use other options.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the
area splits into two halves. The folder is shown on the left side, and the files and subfolderswithin
it are shown on the right.

Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then from the drop-
down—which displays "(root folder)" by default, you can select a specific content folder in your project to
place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and double-click the topic
that you want to link to.

When you are finished, clickOK in the Link to HTMLHelp dialog.

6. (Optional) The Link text field displays the text that you highlighted in the topic, which will be used as the hyperlink.
Leave the text as it is, unless you decide you would like to change it. If you want to change the link text, type the
new text in the field. It will replace the previous text in the topic.

7. (Optional) In theScreen Tip field, you can type a phrase that will appear when the end user hovers over the
hyperlink in the output.

When you enter a screen tip, it is added asa <title> tag in themarkup. In addition, an <alt> (alternate text) tag is
added with the same text. This is usefulwhen it comes to accessibility.

For more information see the online Help.

8. (Optional) Next to the Style Class field, click theSelect button. This opens the Select Classdialog, which lets you
apply one of the defined hyperlink styles (a.NameOfStyleClass) from your stylesheet to the link. After you select a
style class in the dialog, clickOK. The Style Class field displays the selected style. (If you do not specify a style
class, Flare uses the parent <a> style tag.)

9. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked destination will open.
This option can be used to open the destination topic or file in a popup.
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(default) The destination file will open in the samewindow as the output window.

Parent Frame_parent The destination file will open in the parent frame of the current topicwhile hiding
that topic.

New Window_blank The destination file will open in a new browser window.

Same Frame_self The destination file will open in the samewindow frame as the current topic.

Top Frame_top The destination file will open in the same output window, removing all other framesets.
Youmight use this option, for example, if the destination topic has its own frameset.

Popup Window The destination file will open in a popup boxon top of the current topic.

10. (Optional) In the Tab Index field you can enter a value to specify the order in which users can tab through hyper-
links in a topic. So when a user presses the Tab key the first time in a topic, the hyperlinkwith an index value of 1
will be selected first, the hyperlinkwith a value of 2 will be selected next, and so on. If you want to skip a hyperlink,
enter -1 in that field.

Note: This feature is supported only inWebHelp outputs—WebHelp, HTML5,WebHelp AIR,
WebHelpMobile,WebHelp Plus.

11. ClickOK. The hyperlink is changed in the topic. Bydefault the hyperlink is displayed in blue, underlined font. You
can change the appearance of the link bymodifying the style in the Stylesheet Editor.

12. Click to save your work.
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HOW TO EDIT THE STYLE OF A TEXT HYPERLINK

The second way to edit a text hyperlink is to edit the style (e.g., font, color) of the hyperlink.When you edit the style for a text
hyperlink, the style changes for all text hyperlinks.

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Advanced view is cur-

rently shown in the editor). If the button displays instead, then click it.

Note: For stepsusing the Simplified View, see the online Help.

3. In the upper-left corner of the editor, click in theShow Styles field and select .

4. In theStyles section on the left side of the editor, find and select the a tag.

If you want to modify the way links lookwhen theyare in a certain state, you can select a pseudo classunder the
<a> tag. Link pseudo classes include the following:

Active This class is used when the person activates the element (mouse is clicked).

Focus This class is used if the element has the focus.

Hover This class is used when the person hovers themouse over the element.

Link This class is used for links that have not yet been clicked.

Visited This class is used for links that have alreadybeen clicked.

E X A M P L E

Let's say you want the text to display in green for links that have not yet been clicked. But after a link is
clicked, you want it to display asgray text. Therefore, under the <a> style tag, youmodify the "link"
pseudo classand change the font color to green. Then youmodify the "visited" pseudo classunder the
<a> tag so that the font color is gray.

5. From theShowdrop-down list on the upper-right side of the editor, select . The
most relevant properties for that style are shown on the right side of the editor.

6. From theProperties section, change values for anyof the style's properties.

7. Click to save your work.
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HOW TO UNBIND OR REMOVE THE TEXT HYPERLINK

The third way to edit a text hyperlink is to unbind (or remove) the hyperlink effect. If you decide that you no longer want the
content to serve asa hyperlink, you can use the stepsbelow to remove the hyperlink, converting the content to regular text.

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, click inside the link.

3. At the top of the XMLEditor, right-click the span bar representing the link. For example, hyperlink span bars have
an "a" label, and cross-reference span bars have a "MadCap:xref" label. When you click on the link in the topic,
the appropriate span bar at the top of the XMLEditor will change color to indicate that it goeswith the link. If your
span bars are not turned on, click in the local toolbar of the XMLEditor.

4. From the context menu, selectUnbind. The hyperlink effect is removed.

5. Click to save your work.
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4
Text Popups

This feature is supported in all online outputs (DotNet Help, Eclipse Help, Microsoft
HTMLHelp, HTML5,WebHelp,WebHelp AIR,WebHelpMobile, andWebHelp Plus).

A text popup is a link that opensa popup box containing basic text that you provide.

This chapter discusses the following:

Inserting Text Popups 54

Editing Text Popups 56



Inserting Text Popups
Following are steps for inserting a text popup:

HOW TO INSERT A TEXT POPUP

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, highlight the text that you want to use as the link (or "hotspot") to open the popup.

3. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In the Text section, select Text Popup.

You can use theOptionsdialog to switch between ribbonsand the classic tool strip layout. For more inform-
ation see the online Help.

Keep inmind that the smaller the application window becomes, themore the options in a ribbon shrink.
Therefore, youmight only see a small icon instead of text, or youmight see only a section name displayed
with a down arrow to access the options in it. You can hover over small icons to see tooltips that describe
them. You can also enlarge the application window or click one of the section drop-downs in the ribbon to
locate a hidden feature.

Menu Select Insert>Text Popup.

The Insert Text Popup dialog opens, with the text that you highlighted already shown in "The Hotspot Text" field.

4. In The Popup Text field, type the content for the popup.
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5. ClickOK. The link for the text popup is added to the topic. You can change the appearance of the link bymodifying
the <MadCap|popupHead>and <MadCap|popupBody> styles in the Stylesheet Editor.

6. Click to save your work.
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Editing Text Popups
You can edit text popups that you have inserted into a topic in at least two different ways: (1) edit the popup hotspot and
text, and (2) edit the style of the text popup.

HOW TO EDIT THE POPUP HOTSPOT AND TEXT

The first way to edit text popups is to change the popup hotspot and/or the text that users see when the popup opens.

E X A M P L E

Let's say that you test the topic containing the text popup and you notice that a word ismisspelled in the popup
text. You can use the following steps to correct the spelling in the popup.

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, right-click the text popup icon next to the popup hotspot.

3. In themenu, selectEdit Popup. The Insert Text Popup dialog opens.

4. Change the text for the hotspot or the popup itself.

5. ClickOK. The changesaremade to the text popup.

6. Click to save your work.
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HOW TO EDIT THE STYLE OF A TEXT POPUP

You can edit the style (e.g., font, color) of a text popup hotspot or the popup body.When you do this, the style changes for
all text popups in any topics in your project.

E X A M P L E

Let's say that you want to change the font for your text popup hotspots to dark green with no underline. The fol-
lowing steps show you how to accomplish this.

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Advanced view is cur-

rently shown in the editor). If the button displays instead, then click it.

Note: For stepsusing the Simplified View, see the online Help.

3. In the upper-left corner of the editor, click in theShow Styles field and select .

4. In theStyles section on the left side of the editor, find and select the style calledMadCap|popupHead (for the
hotspot) orMadCap|popupBody (for the bodyof the popup).

5. From theShowdrop-down list on the upper-right side of the editor, select . The
most relevant properties for that style are shown on the right side of the editor.

6. From theProperties section, change values for anyof the style's properties.

7. Click to save your work.
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5
Topic Popups

This feature is supported in all online outputs (DotNet Help, Eclipse Help, Microsoft
HTMLHelp, HTML5,WebHelp,WebHelp AIR,WebHelpMobile, andWebHelp Plus).

A topic popup is a text hyperlink that opensa topic or external file (such asa website) in a
popup box.

This chapter discusses the following:

Inserting Topic Popups 60

Editing Topic Popups 63

Customizing the Size of Topic Popups 69



Inserting Topic Popups
Following are steps for inserting a topic popup.

HOW TO INSERT A TOPIC POPUP

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, highlight the text that you want to use as the link (or "hotspot") for the topic popup.

3. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In the Links section, selectHyperlink>Topic Popup.

You can use theOptionsdialog to switch between ribbonsand the classic tool strip layout. For more inform-
ation see the online Help.

Keep inmind that the smaller the application window becomes, themore the options in a ribbon shrink.
Therefore, youmight only see a small icon instead of text, or youmight see only a section name displayed
with a down arrow to access the options in it. You can hover over small icons to see tooltips that describe
them. You can also enlarge the application window or click one of the section drop-downs in the ribbon to
locate a hidden feature.

Menu Select Insert>Topic Popup.

The Insert TopicPopup dialog opens. The Target Frame field at the bottom of the dialog alreadyhasPopupWin-
dow selected.

4. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which you want to link.
Based on the option you choose, the section below gives you a list of selectionsor additional fields to complete.

FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the area below to navigate
to the file that you want to link to and select it. Byusing the buttons in the local toolbar, you can view all files in a list,
view files in their folder structure, and use other options.

Showsall of the files in the project in a list in the area below. If you click the button again, it switches to a
folder tree view. In the list, you can click the File, Type, or Path column headers to sort the list alpha-
betically by that column data.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the area
splits into two halves. The folder is shown on the left side, and the files and subfolderswithin it are shown
on the right.
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If the Show Files button is the only one selected, you can click this button tomove up one folder level.

You can also click to display and select anybookmarkswithin the destination file, or if you have selected a
PDF file. See "Bookmarks" on page 71 and "NamedDestinations" on page 77.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF,Microsoft Office files) outside your project.
This is especially useful if you want to link from one topic to another in separate project outputs, such asCHM files.
After you select this option, enter the path to the file in the field next to the External File button.

You can also click to display and select anybookmarkswithin the destination file, or if you have selected a
PDF file. See "Bookmarks" on page 71 and "NamedDestinations" on page 77.

For more information see "External Links—HTML, PDF,Microsoft Office" on page 97.

Note: Because the link usually needs to be relative, based on the final locationsof your output files, it is
preferable to enter the text directly into the field, rather than clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you click this option,
simply type the path in the field next to the Website field (e.g., http://www.acme.com).

You can create links to specific topics in HTML5,WebHelp,WebHelp Plus, or WebHelpMobile output. This
includes the ability to incorporate search stringsand skin references (for some outputs).
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HTML HELP FILE

This option lets you search for a topicwithin an HTMLHelp (CHM) file that you have added to your project. After
you select this option, click theExternal File button. In the Link to HTMLHelp dialog, you can do one of the fol-
lowing.

SelectProject Files and then use the area below to navigate to the file that you want to link to and select it.
Byusing the buttons in the local toolbar, you can view all files in a list, view files in their folder structure, and
use other options.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the
area splits into two halves. The folder is shown on the left side, and the files and subfolderswithin
it are shown on the right.

Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then from the drop-
down—which displays "(root folder)" by default, you can select a specific content folder in your project to
place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and double-click the topic
that you want to link to.

When you are finished, clickOK in the Link to HTMLHelp dialog.

5. (Optional) The Link Text field displays the text that you highlighted in the topic, which will be used as the hyper-
link. Leave the text as it is, unless you decide you would like to change it. If you want to change the link text, type the
new text in the field. It will replace the previous text in the topic.

6. (Optional) In theScreen Tip field, you can type a phrase that will appear when the end user hovers over the
hyperlink in the output.

7. (Optional) Next to the Style Class field, click theSelect button. This opens the Select Classdialog, which lets you
apply one of the defined hyperlink styles from your stylesheet to the link. After you select a style class in the dialog,
clickOK. The Style Class field displays the selected style. (If you do not specify a style class, Flare uses the
"a.Popup" style class.)

8. In the Target Frame field, leavePopup Windowas the selection.

9. ClickOK. The hyperlink for the topic popup is added to the topic. You can change the appearance of the link by
modifying the a.Popup style in the Stylesheet Editor. This includes the ability to change the size of the popup. See
"Editing TopicPopups" on the following page and "Customizing the Size of TopicPopups" on page 69.

10. Click to save your work.
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Editing Topic Popups
You can edit topic popups that you have inserted into a topic in at least three different ways: (1) edit the destination and
properties of the topic popup, (2) edit the style of the topic popup, and (3) unbind (or remove) the hyperlink from the topic
popup.

HOW TO EDIT THE DESTINATION AND PROPERTIES OF A TOPIC POPUP

The first way to edit topic popups is to change the destination and other properties (link text, target frame, screen tip).

E X A M P L E

Let's say that you test the topic containing the popup and you notice that the wrong destination topic is opening
when you click the hyperlink. So you use the stepsbelow to associate the correct destination topicwith the hyper-
link.

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, click inside the link.

3. At the top of the XMLEditor, right-click the span bar representing the link. For example, hyperlink span bars have
an "a" label, and cross-reference span bars have a "MadCap:xref" label. When you click on the link in the topic,
the appropriate span bar at the top of the XMLEditor will change color to indicate that it goeswith the link. If your
span bars are not turned on, click in the local toolbar of the XMLEditor.

4. SelectEdit Hyperlink. The Insert TopicPopup dialog opens.

5. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which you want to link.
Based the option you choose, the section below gives you a list of selectionsor additional fields to complete.

FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the area below to navigate
to the file that you want to link to and select it. Byusing the buttons in the local toolbar, you can view all files in a list,
view files in their folder structure, and use other options.

Showsall of the files in the project in a list in the area below. If you click the button again, it switches to a
folder tree view. In the list, you can click the File, Type, or Path column headers to sort the list alpha-
betically by that column data.

Showsor hides the folders that the files are stored in.
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Showsor hides the files. If you click this button when the Show Folders button is selected, the area
splits into two halves. The folder is shown on the left side, and the files and subfolderswithin it are shown
on the right.

If the Show Files button is the only one selected, you can click this button tomove up one folder level.

You can also click to display and select anybookmarkswithin the destination file, or if you have selected a
PDF file. See "Bookmarks" on page 71 and "NamedDestinations" on page 77.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF,Microsoft Office files) outside your project.
This is especially useful if you want to link from one topic to another in separate project outputs, such asCHM files.
After you select this option, enter the path to the file in the field next to the External File button.

You can also click to display and select anybookmarkswithin the destination file, or if you have selected a
PDF file. See "Bookmarks" on page 71 and "NamedDestinations" on page 77.

For more information see "External Links—HTML, PDF,Microsoft Office" on page 97.

Note: Because the link usually needs to be relative, based on the final locationsof your output files, it is
preferable to enter the text directly into the field, rather than clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you click this option,
simply type the path in the field next to the Website field (e.g., http://www.acme.com).

You can create links to specific topics in HTML5,WebHelp,WebHelp Plus, or WebHelpMobile output. This
includes the ability to incorporate search stringsand skin references (for some outputs).
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HTML HELP FILE

This option lets you search for a topicwithin an HTMLHelp (CHM) file that you have added to your project. After
you select this option, click theExternal File button. In the Link to HTMLHelp dialog, you can do one of the fol-
lowing.

SelectProject Files and then use the area below to navigate to the file that you want to link to and select it.
Byusing the buttons in the local toolbar, you can view all files in a list, view files in their folder structure, and
use other options.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the
area splits into two halves. The folder is shown on the left side, and the files and subfolderswithin
it are shown on the right.

Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then from the drop-
down—which displays "(root folder)" by default, you can select a specific content folder in your project to
place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and double-click the topic
that you want to link to.

When you are finished, clickOK in the Link to HTMLHelp dialog.

6. (Optional) The Link text field displays the text that you highlighted in the topic, which will be used as the hyperlink.
Leave the text as it is, unless you decide you would like to change it. If you want to change the link text, type the
new text in the field. It will replace the previous text in the topic.

7. (Optional) In theScreen Tip field, you can type a phrase that will appear when the end user hovers over the
hyperlink in the output.

8. (Optional) Next to the Style Class field, click theSelect button. This opens the Select Classdialog, which lets you
apply one of the defined hyperlink styles from your stylesheet to the link. After you select a style class in the dialog,
clickOK. The Style Class field displays the selected style. (If you do not specify a style class, Flare uses the
"a.Popup" style class.)

9. In the Target Frame field, leavePopup Windowas the selection.

10. ClickOK. The hyperlink for the topic popup is added to the topic. Bydefault the hyperlink is displayed in blue,
underlined font. You can change the appearance of the link bymodifying the style in the Stylesheet Editor.

11. Click to save your work.
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HOW TO EDIT THE STYLE OF A TOPIC POPUP HYPERLINK

You can edit the style (e.g., font, color) of the hyperlink for a topic popup.When you do this, the style changes for all topic
popups in any topics in your project.

E X A M P L E

Let's say that you want to change the font for your topic popups to dark green with no underline. The following
steps show you how to accomplish this.

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Advanced view is cur-

rently shown in the editor). If the button displays instead, then click it.

Note: For stepsusing the Simplified View, see the online Help.

3. In the upper-left corner of the editor, click in theShow Styles field and select .

4. In theStyles section on the left side of the editor, find and select the a.Popup tag.

5. From theShowdrop-down list on the upper-right side of the editor, select . The
most relevant properties for that style are shown on the right side of the editor.
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6. From theProperties section, change values for anyof the style's properties.

7. Click to save your work.
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HOW TO UNBIND OR REMOVE THE TOPIC POPUP HYPERLINK

The third way to edit a topic popup is to unbind (or remove) the hyperlink effect. If you decide that you no longer want the
content to serve asa hyperlink, you can use the stepsbelow to remove the hyperlink, converting the content to regular text.

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, click inside the link.

3. At the top of the XMLEditor, right-click the span bar representing the link. For example, hyperlink span bars have
an "a" label, and cross-reference span bars have a "MadCap:xref" label. When you click on the link in the topic,
the appropriate span bar at the top of the XMLEditor will change color to indicate that it goeswith the link. If your
span bars are not turned on, click in the local toolbar of the XMLEditor.

4. SelectUnbind. The hyperlink effect is removed.

5. Click to save your work.
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Customizing the Size of Topic Popups
If you insert a topic popup link, the popup displays in a default window size in the output (after the link is clicked). However,
you can adjust the style to specify a custom size for the popup box. You can do this by selecting the a.Popup style classand
changing the values for themc-popup-width andmc-popup-height properties (located in the Unclassified property group).

HOW TO CUSTOMIZE THE SIZE OF TOPIC POPUPS

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Advanced view is cur-

rently shown in the editor). If the button displays instead, then click it.

3. In the upper-left corner of the editor, click in theShow Styles field and select .

4. In theStyles section on the left side of the editor, find and select the a.Popup style class.

5. From theShowdrop-down list on the upper-right side of the editor, select . The
most relevant properties for that style are shown on the right side of the editor.
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6. From theProperties section, click in the column to the right ofmc-popup-width ormc-popup-height (where
it displays "auto"). A small boxpopup displays, where you can enter values.

7. In the top-right corner of the small popup box (next to "Automatic"), click the down arrow and select Length.

8. In the lower-left field, enter a number.

9. In the lower-right field, click the down arrow and select a unit of measurement.

10. In the popup box, clickOK.

11. Click to save your work.
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6
Bookmarks

This feature is supported in all outputs.

A bookmark is amarker, or flag, that lets you create hyperlinks to specific locationswithin top-
ics (rather than to another topic file in general). You can insert a bookmarkat a specific loc-
ation in your topic (e.g., at a subheading) and then insert a hyperlink that "connects" to that
bookmark. This is a useful feature, for example, if you have a somewhat lengthy topic and
want the user to be able to locate a specific place in the topic quickly.

This chapter discusses the following:

Inserting Bookmarks 72

Renaming Bookmarks 74

Deleting Bookmarks 75

Hiding and Showing Bookmark Names 76



Inserting Bookmarks
Following are steps for inserting a bookmark:

HOW TO INSERT A BOOKMARK

1. Open the content file (e.g., topic, snippet).

2. Click in the topicwhere you want to insert a bookmark (e.g., in front of a subheading or a specific paragraph).

3. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In the Links section, selectBookmark.

You can use theOptionsdialog to switch between ribbonsand the classic tool strip layout. For more inform-
ation see the online Help.

Keep inmind that the smaller the application window becomes, themore the options in a ribbon shrink.
Therefore, youmight only see a small icon instead of text, or youmight see only a section name displayed
with a down arrow to access the options in it. You can hover over small icons to see tooltips that describe
them. You can also enlarge the application window or click one of the section drop-downs in the ribbon to
locate a hidden feature.

Menu Select Insert>Bookmark.

Keyboard Shortcut PressSHIFT+CTRL+K on your keyboard.

TheManage Bookmarksdialog opens.

4. In theNew bookmark field, type a name for your bookmark (do not use spaces).

E X A M P L E

If the bookmark is being placed at the beginning of a bulleted list of product features, youmight type Pro-
ductFeaturesas the bookmarkname.

5. ClickAdd. A bookmark icon and the name of the bookmarkare displayed at the appropriate location in the
topic (as long as your markers are turned on). You can hide the bookmarkname if you want.

6. Click to save your work.

7. Now you can insert a cross-reference or another kind of hyperlink elsewhere in this topic or in another topic that
links to this bookmark.
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Note: You can alsomove an existing bookmark to a new location in the topic. To do this, place your cursor in
the topicwhere you want the bookmark to bemoved. Select Insert>Bookmark. In theManage Bookmarksdia-
log, select the existing bookmark that you want to move (instead of typing the name of a new bookmark). Then
clickMove.
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Renaming Bookmarks
If you want to rename one of the bookmarks that you have inserted in a content file (e.g., topic, snippet) , you can easily
change the name.

HOW TO RENAME A BOOKMARK

1. Open the content file (e.g., topic, snippet).

2. Right-click the bookmark, and from the context menu selectRename Bookmark. TheManage Bookmarksdia-
log opens, with the bookmarks in that topic listed.

3. Select the bookmark that you want to rename.

4. In theNew bookmark field, type a new name for the bookmark.

5. ClickRename. This changes the bookmarkname in the topic.

6. Click to save your work.
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Deleting Bookmarks
If you inserted a bookmarkand no longer need it, you can permanently remove it.

HOW TO DELETE A BOOKMARK FROM A TOPIC

1. Open the content file (e.g., topic, snippet).

2. Right-click the bookmark to remove and selectDelete from the context menu.

3. Click to save your work.

CHAPTER 6│Navigation Links Guide 75



Hiding and Showing Bookmark Names
When you insert a bookmark into a content file (e.g., topic, snippet) , both the bookmark icon and the bookmarkname
displayon screen. You can show or hide the bookmarkname from your screen display.When hidden, the screen displays
showsonly the bookmark icon at the insertion point.

HOW TO HIDE BOOKMARK NAMES

1. Open the content file (e.g., topic, snippet).

2. On the local toolbar of the XMLEditor, click the down arrow of theShow tags button . Then selectShow
Bookmark Names to remove the checkmarknext to it. This hides the bookmarkname.

HOW TO SHOW BOOKMARK NAMES

1. Open the content file (e.g., topic, snippet).

2. On the local toolbar of the XMLEditor, click the down arrow of theShow tags button . Then selectShow
Bookmark Names to place a checkmarknext to it. This shows the bookmarkname.
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7
NamedDestinations

This feature is supported in Adobe PDF output.

You can create named destinations for use in Adobe PDF outputs. A named destination lets
you point to a specific place in a PDF. In the Insert Hyperlink dialog, you can create links to
named destinationswhen using the "File in Project" option (if the PDF hasbeen added to your
project) or "External File" option (if the PDF file exists outside of your project).

This process involves the following sets of steps:

Generate/Insert Named Destinations You can generate named destinationsauto-
matically in a PDF everywhere a bookmarkexists. Alternatively, you can insert named
destinations into content filesmanually.

Create Links to Named Destinations You can insert hyperlinks to named des-
tinations in a PDF.



E X A M P L E

Let's say you plan to generate a PDF file from Flare Project A. Once that is done, you plan to add the PDF to Flare
Project B. And in one of the topics of Flare Project B, you create a hyperlink that points to a specific paragraph in
the PDF.

First, you open the topic or snippet in Flare Project Awhere the destination paragraph will eventually exist in the
PDF, and you insert a named destination at that location:
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Next, you generate the output for the PDF.

Now you open Flare Project B. You could use the a feature such asExternalResources to add the PDF to that
project, or you could just copyand paste it inWindows.
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Now you open a topic in Flare Project B, and you create a hyperlink that points to the named destination in the
PDF. You follow the steps for inserting the a link to a file in the project, and you select the PDF file. Then you click

and select the named destination that you created:
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Now when you generate the output from Project B, you can click on the hyperlink in that output, and the PDF will
open to the specified paragraph.
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HOW TO GENERATE NAMED DESTINATIONS AUTOMATICALLY

1. Open the PDF target that will contain the named destinations (i.e., hyperlinks in another file will point to these des-
tinations).

2. Select thePDF Options tab.

3. In theDocument Properties area, clickCreate named destinations for bookmarks.

Note: This doesnot remove bookmarks. It simply createsnamed destinationsnext to other book-
marks in the generated PDF if theyexist.

4. Click to save your work.

5. Generate and publish the PDF.

CHAPTER 7│Navigation Links Guide 85



HOW TO INSERT A NAMED DESTINATION MANUALLY

1. Open the topicwhere you want insert a named destination (i.e., hyperlinks in another file will point to the PDF hold-
ing this destination).

2. Click in the topicwhere you want to insert a named destination (e.g., in front of a subheading or a specific para-
graph).

3. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In the Links section, selectNamed Destination.

You can use theOptionsdialog to switch between ribbonsand the classic tool strip layout. For more inform-
ation see the online Help.

Keep inmind that the smaller the application window becomes, themore the options in a ribbon shrink.
Therefore, youmight only see a small icon instead of text, or youmight see only a section name displayed
with a down arrow to access the options in it. You can hover over small icons to see tooltips that describe
them. You can also enlarge the application window or click one of the section drop-downs in the ribbon to
locate a hidden feature.

Menu Select Insert>Named Destination.

The NamedDestination dialog opens.

4. In theName field, type a name for destination (do not use spaces).

5. ClickOK. An icon is displayed at the appropriate location in the document (as long as your markers are turned
on).

6. Click to save your work.

7. Generate and publish the PDF containing that topic.
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HOW TO CREATE A LINK TO A NAMED DESTINATION

1. Open the topicwhere you want the link to exist.

2. Highlight the text that you want to use as the link (or "hotspot").

3. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In the Links section, selectHyperlink.

Menu Select Insert>Hyperlink.

Local Toolbar In the local toolbar of the XMLEditor click .

Keyboard Shortcut PressCTRL+K on your keyboard.

Right-Click In the XMLEditor, right-click and selectHyperlink.

The Insert Hyperlink dialog opens.

4. From the Link to drop-down field select one of the following. Based on the option you choose, the section below
the field gives you a list of selectionsor additional fields to complete.

FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the area below to navigate
to the PDF file that you want to link to and select it. Byusing the buttons in the local toolbar, you can view all files in
a list, view files in their folder structure, and use other options.

Showsall of the files in the project in a list in the area below. If you click the button again, it switches to a
folder tree view. In the list, you can click the File, Type, or Path column headers to sort the list alpha-
betically by that column data.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the area
splits into two halves. The folder is shown on the left side, and the files and subfolderswithin it are shown
on the right.

If the Show Files button is the only one selected, you can click this button tomove up one folder level.
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EXTERNAL FILE

This option lets you search for a file outside your project. After you select this option, enter the path to the PDF file
in the field next to the External File button.

For more information see "External Links—HTML, PDF,Microsoft Office" on page 97.

Note: Because the link usually needs to be relative, based on the final locationsof your output files, it is
preferable to enter the text directly into the field, rather than clicking the External File button.

5. After selecting the PDF, click .

6. In the dialog that opens, select the named destination and clickOK.

7. (Optional) The Link text field displays the text that you highlighted in the topic, which will be used as the hyperlink.
Leave the text as it is, unless you decide you would like to change it. If you want to change the link text, type the
new text in the field. It will replace the previously selected text in the topic.

8. (Optional) In theScreen Tip field you can type a phrase that will appear when the end user hovers over the hyper-
link in the output.

When you enter a screen tip, it is added asa <title> tag in themarkup. In addition, an <alt> (alternate text) tag is
added with the same text. This is usefulwhen it comes to accessibility.

For more information see the online Help.

9. (Optional) Next to the Style Class field click theSelect button. This opens the Select Classdialog, which lets you
apply one of the defined hyperlink styles from your stylesheet to the link. You can change the appearance of the
link in the Stylesheet Editor. After you select a style class in the dialog, clickOK. The Style Class field displays the
selected style. (If you do not specify a style class, Flare uses the parent <a> tag.)
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10. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked destination will open
(e.g., in another window, in a popup).

(default) The destination file will open in the samewindow as the output window.

Parent Frame_parent The destination file will open in the parent frame of the current topicwhile hiding
that topic.

New Window_blank The destination file will open in a new browser window.

Same Frame_self The destination file will open in the samewindow frame as the current topic.

Top Frame_top The destination file will open in the same output window, removing all other framesets.
Youmight use this option, for example, if the destination topic has its own frameset.

Popup Window The destination file will open in a popup boxon top of the current topic.

11. ClickOK. The hyperlink is added to the topic.

12. Click to save your work.
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Links toWebHelp Topics

This feature is supported in HTML5,WebHelp,WebHelpMobile, andWebHelp Plusout-
put.

If you generateWebHelp, HTML5,WebHelp Plus, or WebHelpMobile targets, you can create
links to specific topics in the output.

This chapter discusses the following:

Creating Links to HTML5 Topics 92

Creating Links to WebHelp and WebHelp Plus Topics 94

Creating Links to WebHelp Mobile Topics 96



Creating Links to HTML5 Topics
You can create links to specific topics in HTML5 output. You can also create links that incorporate search stringsand skin
references.

HOW TO CREATE LINKS TO HTML5 TOPICS

1. Perform the steps for creating one of the following kindsof links:

Image Maps See "Creating ImageMaps" on page 110.

Image Hyperlinks See "Image HyperlinksandMaps" on page 101.

Text Hyperlinks See "Text Hyperlinks" on page 37.

Topic Popups See "TopicPopups" on page 59.

2. In the dialog that opens for creating the link, click the Link to field and selectWebsite.

3. Enter the path to the website. You can also include a specific topic, a search string, and/or skin.When inserting the
link, you can use the following structure.

http://[website]/[main entry file].htm#[path/name of topic]&searchQuery=[search
string]&firstPick=true&skinName=[skin name]

After the hashmark (#), you can specify any combination of the parameters (cshid, searchQuery, firstPick,
skinName), separated byampersands (&). The order of the parameters doesnot matter:

Main entry fileProvide the path to themain entry file for your output. The file name is determined by
whatever you enter into theOutput File field in theGeneral tab of the Target Editor. If you do not provide
a name in this field, the name "Default" will be used.

searchQuery This is an optional element that automatically performsa search for a specific string.

firstPick This element can be used in conjunction with the search string. If you include the first pick option,
the first topic found with the specified search stringwillbe opened automatically. If you do not include this
element, the search resultswill simply be displayed; the first topicwill not be opened automatically.

skinNameYou can specify a skin directly in the link, which will override the skin associated with that topic in
the CSH alias file.
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<a href="http://my.mycompany.com/Default.htm#Sports/Soccer.htm">Click here to
open</a>

<a href="http://my.mycompany.com/Default.htm#searchQuery=World Cup Stand-
ings&firstPick=true">Click here to open</a>

<a href="http://my.mycompany.com/Default.htm#Sports/Soccer.htm&skinName=Green">Click
here to open</a>

In these examples, the following were used:

Default.htm =main entry file name

Soccer.htm = topic in the project, located in subfolder called "Sports"

World Cup Standings= search term

Green = skin name
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Creating Links to WebHelp and WebHelp Plus Topics
You can create links to specific topics inWebHelp andWebHelp Plusoutput. You can also create links that incorporate
search stringsand skin references.

HOW TO CREATE LINKS TO WEBHELP AND WEBHELP PLUS TOPICS

1. Perform the steps for creating one of the following kindsof links:

Image Maps See "Creating ImageMaps" on page 110.

Image Hyperlinks See "Image HyperlinksandMaps" on page 101.

Text Hyperlinks See "Text Hyperlinks" on page 37.

Topic Popups See "TopicPopups" on page 59.

2. In the dialog that opens for creating the link, click the Link to field and selectWebsite.

3. Enter the path to the website. You can also include a specific topic, a search string, and/or skin.When inserting the
link, you can use the following structure.

http://[website]/[main entry file]_CSH.htm?[search string]|FirstPick#[path/name
of topic]|[skin name]

Main entry file_CSH.htm This is themain entry file for your output. The file name is determined by
whatever you enter into theOutput File field in theGeneral tab of the Target Editor. If you do not provide
a name in this field, the name "Default" will be used. After the file name, it is important that you add an under-
score followed by "CSH."

Note: You do not need to include the "_CSH" portion in the file name of the topic in Flare. You
only need to add " _CSH" to the web page hyperlink connecting to that topic.

Search string This is an optional element that automatically performsa search for a specific string.

First pick This element can be used in conjunction with the search string. If you include the first pick option,
the first topic found with the specified search string will be opened automatically. If you do not include this
element, the search resultswill simply be displayed; the first topicwill not be opened automatically.

Skin name You can specify a skin directly in the link, which will override the skin associated with that topic in
the CSH alias file.
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<a href="http://my.mycompany.com/Default_CSH.htm#Sports/Soccer.htm|Green">Click here
to open</a>

<a href="http://my.mycompany.com/Default_CSH.htm?World Cup Standings|FirstPick">Click
here to open</a>

In these examples, the following were used:

Default.htm =main entry file name

Soccer.htm = topic in the project, located in subfolder called "Sports"

World Cup Standings= search term

Green = skin name
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Creating Links to WebHelp Mobile Topics
You can create links to specific topics inWebHelpMobile output. You can also create links that incorporate search strings.

HOW TO CREATE LINKS TO WEBHELP MOBILE TOPICS

1. Perform the steps for creating one of the following kindsof links:

Image Maps See "Creating ImageMaps" on page 110.

Image Hyperlinks See "Image HyperlinksandMaps" on page 101.

Text Hyperlinks See "Text Hyperlinks" on page 37.

Topic Popups See "TopicPopups" on page 59.

2. In the dialog that opens for creating the link, click the Link to field and selectWebsite.

3. Enter the path to the website. You can also include a specific topic and/or a search string.When inserting the link,
you can use the following structure.

http://[website]/[path/name of topic]&searchQuery=[search string]&firstPick-
k=true

Parameters can be separated byampersands (&).

searchQuery This is an optional element that automatically performsa search for a specific string.

firstPick This element can be used in conjunction with the search string. If you include the first pick option,
the first topic found with the specified search stringwillbe opened automatically. If you do not include this
element, the search resultswill simply be displayed; the first topicwill not be opened automatically.

E X A M P L E S

<a href="http://mycompany.com/Sports/Soccer.htm">Click here to open</a>

<a href="http://mycompany.com/searchQuery=World Cup Standings&firstPick=true">Click
here to open</a>

In these examples, the following were used:

Soccer.htm = topic in the project, located in subfolder called "Sports"

World Cup Standings= search term
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External Links—HTML, PDF,
Microsoft Office

This feature is supported in all outputs.

An external link lets you search for a file (e.g., HTM, HTML, XML, PDF,Microsoft Office files)
outside your project. These steps involve a little planning ahead. You need to know the loc-
ation where your fileswill be published, aswell as the namesof your main output files.



HOW TO INSERT A LINK TO AN EXTERNAL FILE

1. Open the content file (e.g., topic, snippet) where you want to insert the link.

2. Use the normal steps for inserting the type of navigation link that you want to create:

Text Hyperlink See "Text Hyperlinks" on page 37.

Topic Popup See "TopicPopups" on page 59.

Image Hyperlink See "Image HyperlinksandMaps" on page 101.

3. From the Link to drop-down field, selectExternal File.

4. In the field to the right, next to theExternal File button, enter the path for the link, depending on the output type
you are using.

Note: Because the link usually needs to be relative, based on the final locationsof your output files, it is
preferable to enter the text directly into the field, rather than clicking the External File button.
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IF YOU ARE BUILDING MICROSOFT HTML HELP (CHM FILES)

Use one of the following:

NameOfOutput.chm::/NameOfTopic.htm

OR

mk:@MSITStore:PathToOutput\NameOfOutput.chm::/NameOfTopic.htm

Use the first method if you plan to publish your CHM files to the same folder (recommended). Use the second
method if you plan to publish your CHM files in different folders.

E X A M P L E S

Let's say you have a project called "FirstHelp" and another called "SecondHelp." Also, let's assume that
the first project will generate a CHM file named "First.chm," and the second will generate a CHM file
named "Second.chm." (The namesof the CHM files can be specified on theGeneral tab of the Target
Editor. Enter the desired name in the Output File field. If you plan to publish the files to the same folder,
theyneed to have different names.)

Suppose you want to create a text hyperlink in a topic called "Welcome," which is located within the
FirstHelp project. When a user clicks on this link, you want it to open a topic called "About the Company,"
which is located within the SecondHelp project. Therefore, you open theWelcome topic in the FirstHelp
project. Then you highlight the text to be used in the hyperlink, and you select Insert>Hyperlink. The
Insert Hyperlink dialog opens. Next, from the drop-down field you selectExternal File. What do you
enter in theExternal File field?

Wewill take a lookat two different situations. First, let's say that you plan to publish both CHM files to the
same folder (perhapson your company's intranet). In that case, you would enter the following:

SecondHelp.chm::/About the Company.htm

On the other hand, let's say that you plan to publish First.chm to one folder, and you plan to publish
Second.chm to a separate folder, such as the following: C:\Documentation\More Help. In that case, you
would enter the following:

mk:@MSITStore:C:\Documentation\More Help\SecondHelp.chm::/About the Company.htm
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Note: If you want to link content to an externalCHM file, an alternative is to use the "HTMLHelp File"
option from the "Link to" field, instead of the "External File" option.

IF YOU ARE BUILDING OTHER OUTPUT TYPES

Enter the relative path from the source output topic to the destination topic, using a pair of periods to represent
each folder level.

E X A M P L E

Let's say that you have a project called "First Help" and another called "Second Help." Suppose that you
will generateWebHelp output for the First Help project and publish it to a folder called "MyFirstHelp."
You will also generateWebHelp output for the Second Help project and publish it to a folder called
"MySecondHelp," which is located next to the "MyFirstHelp" folder. Now, let's say you have a topic called
"Welcome" in the First Help project and it is stored at the root level of the Content folder. You want to cre-
ate an external link in this topic so that it opensa topic called "About the Company," which is stored in the
root Content folder of the Second Help project. In that case, you would enter the following when creating
the external link:

../../MySecondHelp/Content/About the Company.htm

5. (Optional) You can click to display and select anybookmarkswithin the destination file, or if you have selec-
ted a PDF file. See "Bookmarks" on page 71 and "NamedDestinations" on page 77.

6. In the link dialog, clickOK.

7. Click to save your work.

8. Generate the output for the projects and publish the files to the appropriate location(s).

Note: WithMarkof the web enabled in your target, some links to external filesmaynot work properly in some
versionsof Internet Explorer when pagesare viewed locally (file://). This is not an issue if pagesare viewed
online (http://). For more information about MOTW, seeMicrosoft'sMSDN website.

Note: The Eclipse Viewer cannot displayPDFsopened from links.
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Image Hyperlinks andMaps

This feature is supported in EPUBand in all online outputs (DotNet Help, Eclipse Help,
Microsoft HTMLHelp, HTML5,WebHelp,WebHelp AIR,WebHelpMobile, and
WebHelp Plus.

You canmake images interactive through the use of hyperlinksandmaps.

This chapter discusses the following:

Inserting Image Hyperlinks 102

Editing Image Hyperlinks 106

Creating Image Maps 110



Inserting Image Hyperlinks
After you insert an image, you can turn that picture into a hyperlink, connecting it to another topic, a topic in an imported
HTMLHelp file, an external file (such asa website), or an email.

HOW TO INSERT AN IMAGE HYPERLINK

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, right-click the image that you want to use asa hyperlink.

3. In the context menu, selectHyperlink Image. The Insert Hyperlink dialog opens.

4. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which you want to link.
Based on the option you choose, the section below gives you a list of selectionsor additional fields to complete.

FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the area below to navigate
to the file that you want to link to and select it. Byusing the buttons in the local toolbar, you can view all files in a list,
view files in their folder structure, and use other options.

Showsall of the files in the project in a list in the area below. If you click the button again, it switches to a
folder tree view. In the list, you can click the File, Type, or Path column headers to sort the list alpha-
betically by that column data.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the area
splits into two halves. The folder is shown on the left side, and the files and subfolderswithin it are shown
on the right.

If the Show Files button is the only one selected, you can click this button tomove up one folder level.

You can also click to display and select anybookmarkswithin the destination file, or if you have selected a
PDF file. See "Bookmarks" on page 71 and "NamedDestinations" on page 77.
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PLACE IN THIS DOCUMENT

This option displaysanyheadingsand bookmarks in the current file. After you click this option, use the section
below to choose the heading or bookmark to which you want to link.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF,Microsoft Office files) outside your project.
This is especially useful if you want to link from one topic to another in separate project outputs, such asCHM files.
After you select this option, enter the path to the file in the field next to the External File button.

You can also click to display and select anybookmarkswithin the destination file, or if you have selected a
PDF file. See "Bookmarks" on page 71 and "NamedDestinations" on page 77.

For more information see "External Links—HTML, PDF,Microsoft Office" on page 97.

Note: Because the link usually needs to be relative, based on the final locationsof your output files, it is
preferable to enter the text directly into the field, rather than clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you click this option,
simply type the path in the field next to the Website field (e.g., http://www.acme.com).

You can create links to specific topics in HTML5,WebHelp,WebHelp Plus, or WebHelpMobile output. This
includes the ability to incorporate search stringsand skin references (for some outputs).

EMAIL

This option lets you add an email addressand subject line so that the user can quickly send an email.

E X A M P L E

Youmight use this feature to help the end user send an email to your company's technical support
department.When users click the link, it opens their email program and beginsa new emailmessage for
them, inserting the email addressand subject line for them. After you click this option, complete theE-
mail address andSubject fields to the right (or select a recent email address from the list below).
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HTML HELP FILE

This option lets you search for a topicwithin an HTMLHelp (CHM) file that you have added to your project. After
you select this option, click theExternal File button. In the Link to HTMLHelp dialog, you can do one of the fol-
lowing.

SelectProject Files and then use the area below to navigate to the file that you want to link to and select it.
Byusing the buttons in the local toolbar, you can view all files in a list, view files in their folder structure, and
use other options.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the
area splits into two halves. The folder is shown on the left side, and the files and subfolderswithin
it are shown on the right.

Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then from the drop-
down—which displays "(root folder)" by default, you can select a specific content folder in your project to
place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and double-click the topic
that you want to link to.

When you are finished, clickOK in the Link to HTMLHelp dialog.

5. (Optional) In theScreen Tip field, you can type a phrase that will appear when the end user hovers over the
hyperlink in the output. This is added not only a "title" attribute, but asan "alt" (alternate text) attribute aswell.

6. (Optional) Next to the Style Class field, click theSelect button. This opens the Select Classdialog, which lets you
apply one of the defined hyperlink styles (a.NameOfStyleClass) from your stylesheet to the link. After you select a
style class in the dialog, clickOK. The Style Class field displays the selected style. (If you do not specify a style
class, Flare uses the parent <a> style tag.)

7. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked destination will open.
This option can be used to open the destination topic or file in a popup.

(default) The destination file will open in the samewindow as the output window.

Parent Frame_parent The destination file will open in the parent frame of the current topicwhile hiding
that topic.

New Window_blank The destination file will open in a new browser window.

Same Frame_self The destination file will open in the samewindow frame as the current topic.

Top Frame_top The destination file will open in the same output window, removing all other framesets.
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Youmight use this option, for example, if the destination topic has its own frameset.

Popup Window The destination file will open in a popup boxon top of the current topic.

8. (Optional) In the Tab Index field you can enter a value to specify the order in which users can tab through links.
So when a user presses the Tab key the first time, the hyperlinkwith an index value of 1 will be selected first, the
linkwith a value of 2 will be selected next, and so on. If you want to skip a link, enter -1 in that field.

Note: This feature is supported only inWebHelp outputs—WebHelp, HTML5,WebHelp AIR,
WebHelpMobile,WebHelp Plus.

9. ClickOK. The hyperlink is added to the image in the topic.When a user hovers the cursor over the image in the
output, the cursor changes to a hand.

10. Click to save your work.

Warning: It is recommended that you avoid creating links to snippets.This is primarily due to the nature of
snippets, which are designed to be inserted intomultiple files. Let's say you have a heading style in a snippet
and that snippet is then inserted into 12 different topics. In another topic, youmight decide to create a cross-
reference that points to the heading in that snippet. But which of those 12 topics is it supposed to point to in
the output? There is no way for Flare to know this, so you could end up with some very undesirable results.
For this reason, it's a good idea not to link to any content in a snippet.
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Editing Image Hyperlinks
You can edit image hyperlinks that you have inserted into a topic in the following ways: (1) edit the destination and prop-
erties of the hyperlink, and (2) remove the hyperlink from the image.

The first way to edit image hyperlinks is to change the destination and other properties (target frame, screen tip).

E X A M P L E

Let's say that you test the topic containing the image hyperlink and you notice that the wrong destination topic is
opening when you click the hyperlink. So you use the stepsbelow to associate the correct destination topicwith
the hyperlink.

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, right-click the image.

3. In the context menu, selectHyperlink Image. The Insert Hyperlink dialog opens.

4. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which you want to link.
Based the option you choose, the section below gives you a list of selectionsor additional fields to complete.

FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the area below to navigate
to the file that you want to link to and select it. Byusing the buttons in the local toolbar, you can view all files in a list,
view files in their folder structure, and use other options.

Showsall of the files in the project in a list in the area below. If you click the button again, it switches to a
folder tree view. In the list, you can click the File, Type, or Path column headers to sort the list alpha-
betically by that column data.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the area
splits into two halves. The folder is shown on the left side, and the files and subfolderswithin it are shown
on the right.

If the Show Files button is the only one selected, you can click this button tomove up one folder level.
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You can also click to display and select anybookmarkswithin the destination file, or if you have selected a
PDF file. See "Bookmarks" on page 71 and "NamedDestinations" on page 77.

PLACE IN THIS DOCUMENT

This option displaysanyheadingsand bookmarks in the current file. After you click this option, use the section
below to choose the heading or bookmark to which you want to link.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF,Microsoft Office files) outside your project.
This is especially useful if you want to link from one topic to another in separate project outputs, such asCHM files.
After you select this option, enter the path to the file in the field next to the External File button.

You can also click to display and select anybookmarkswithin the destination file, or if you have selected a
PDF file. See "Bookmarks" on page 71 and "NamedDestinations" on page 77.

For more information see "External Links—HTML, PDF,Microsoft Office" on page 97.

Note: Because the link usually needs to be relative, based on the final locationsof your output files, it is
preferable to enter the text directly into the field, rather than clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you click this option,
simply type the path in the field next to the Website field (e.g., http://www.acme.com).

You can create links to specific topics in HTML5,WebHelp,WebHelp Plus, or WebHelpMobile output. This
includes the ability to incorporate search stringsand skin references (for some outputs).

EMAIL

This option lets you add an email addressand subject line so that the user can quickly send an email.

E X A M P L E

Youmight use this feature to help the end user send an email to your company's technical support
department.When users click the link, it opens their email program and beginsa new emailmessage for
them, inserting the email addressand subject line for them. After you click this option, complete theE-
mail address andSubject fields to the right (or select a recent email address from the list below).
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HTML HELP FILE

This option lets you search for a topicwithin an HTMLHelp (CHM) file that you have added to your project. After
you select this option, click theExternal File button. In the Link to HTMLHelp dialog, you can do one of the fol-
lowing.

SelectProject Files and then use the area below to navigate to the file that you want to link to and select it.
Byusing the buttons in the local toolbar, you can view all files in a list, view files in their folder structure, and
use other options.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the
area splits into two halves. The folder is shown on the left side, and the files and subfolderswithin
it are shown on the right.

Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then from the drop-
down—which displays "(root folder)" by default, you can select a specific content folder in your project to
place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and double-click the topic
that you want to link to.

When you are finished, clickOK in the Link to HTMLHelp dialog.

5. (Optional) In theScreen Tip field, you can type a phrase that will appear when the end user hovers over the
hyperlink in the output.

6. (Optional) Next to the Style Class field, click theSelect button. This opens the Select Classdialog, which lets you
apply one of the defined hyperlink styles (a.NameOfStyleClass) from your stylesheet to the link. After you select a
style class in the dialog, clickOK. The Style Class field displays the selected style. (If you do not specify a style
class, Flare uses the parent <a> style tag.)

7. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked destination will open.
This option can be used to open the destination topic or file in a popup. The other optionsare typically used by
advanced users.

(default) The destination file will open in the samewindow as the output window.

Parent Frame_parent The destination file will open in the parent frame of the current topicwhile hiding
that topic.

New Window_blank The destination file will open in a new browser window.

Same Frame_self The destination file will open in the samewindow frame as the current topic.
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Top Frame_top The destination file will open in the same output window, removing all other framesets.
Youmight use this option, for example, if the destination topic has its own frameset.

Popup Window The destination file will open in a popup boxon top of the current topic.

8. (Optional) In the Tab Index field you can enter a value to specify the order in which users can tab through links.
So when a user presses the Tab key the first time, the hyperlinkwith an index value of 1 will be selected first, the
linkwith a value of 2 will be selected next, and so on. If you want to skip a link, enter -1 in that field.

Note: This feature is supported only inWebHelp outputs—WebHelp, HTML5,WebHelp AIR,
WebHelpMobile,WebHelp Plus.

9. ClickOK. The hyperlink is changed in the topic.

10. Click to save your work.

HOW TO REMOVE THE HYPERLINK FROM THE IMAGE

Another way to edit an image hyperlink is to remove the hyperlink effect. If you decide that you no longer want the image to
serve asa hyperlink, you can use the stepsbelow to remove the hyperlink.When you are finished, the image will remain in
the topic, but the hyperlink effect will be removed.

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, right-click the image.

3. In the context menu, selectHyperlink Image. The Insert Hyperlink dialog opens.

4. In the bottom-left section of the dialog, click theRemove Link button. The hyperlink effect is removed.

5. Click to save your work.

CHAPTER 10│Navigation Links Guide 109



Creating Image Maps

This feature is supported in all online outputs (DotNet Help, Eclipse Help, Microsoft HTMLHelp, HTML5,WebHelp,
WebHelp AIR,WebHelpMobile, andWebHelp Plus).

After you insert an image, you can createmultiple hyperlinks for specific sectionsof the image. This is called an "image
map."

HOW TO CREATE AN IMAGE MAP

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, right-click the image on which you want to create an imagemap.

3. In the context menu, select Image Map. The ImageMap Editor opens, with the image displayed lightly.

4. In the Standard toolbar of the ImageMap Editor, click one of the shape drawing buttons, depending on the area
of the image that you want to use asa hyperlink.

Click this button if you want to draw an odd shape over a section of the image.

Click this button if you want to draw a rectangle over a section of the image.

Click this button if you want to draw a circle over a section of the image.

Note: There are additional features in the ImageMap Editor that you can use to refine your image
map.

5. In the image, click and drag your mouse over the area to be used asa hyperlink. Release themouse button when
you are satisfied with the size and location of the shape. You should now see the shape on top of the image, con-
nected bya series of points.

6. In the toolbar, click .
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7. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which you want to link.
Based the option you choose, the section below gives you a list of selectionsor additional fields to complete.

FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the area below to navigate
to the file that you want to link to and select it. Byusing the buttons in the local toolbar, you can view all files in a list,
view files in their folder structure, and use other options.

Showsall of the files in the project in a list in the area below. If you click the button again, it switches to a
folder tree view. In the list, you can click the File, Type, or Path column headers to sort the list alpha-
betically by that column data.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the area
splits into two halves. The folder is shown on the left side, and the files and subfolderswithin it are shown
on the right.

If the Show Files button is the only one selected, you can click this button tomove up one folder level.

You can also click to display and select anybookmarkswithin the destination file, or if you have selected a
PDF file. See "Bookmarks" on page 71 and "NamedDestinations" on page 77.

PLACE IN THIS DOCUMENT

This option displaysanyheadingsand bookmarks in the current file. After you click this option, use the section
below to choose the heading or bookmark to which you want to link.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF,Microsoft Office files) outside your project.
This is especially useful if you want to link from one topic to another in separate project outputs, such asCHM files.
After you select this option, enter the path to the file in the field next to the External File button.

You can also click to display and select anybookmarkswithin the destination file, or if you have selected a
PDF file. See "Bookmarks" on page 71 and "NamedDestinations" on page 77.

For more information see "External Links—HTML, PDF,Microsoft Office" on page 97.
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Note: Because the link usually needs to be relative, based on the final locationsof your output files, it is
preferable to enter the text directly into the field, rather than clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you click this option,
simply type the path in the field next to the Website field (e.g., http://www.acme.com).

You can create links to specific topics in HTML5,WebHelp,WebHelp Plus, or WebHelpMobile output. This
includes the ability to incorporate search stringsand skin references (for some outputs).

EMAIL

This option lets you add an email addressand subject line so that the user can quickly send an email.

E X A M P L E

Youmight use this feature to help the end user send an email to your company's technical support
department.When users click the link, it opens their email program and beginsa new emailmessage for
them, inserting the email addressand subject line for them. After you click this option, complete theE-
mail address andSubject fields to the right (or select a recent email address from the list below).

HTML HELP FILE

This option lets you search for a topicwithin an HTMLHelp (CHM) file that you have added to your project. After
you select this option, click theExternal File button. In the Link to HTMLHelp dialog, you can do one of the fol-
lowing.

SelectProject Files and then use the area below to navigate to the file that you want to link to and select it.
Byusing the buttons in the local toolbar, you can view all files in a list, view files in their folder structure, and
use other options.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the
area splits into two halves. The folder is shown on the left side, and the files and subfolderswithin
it are shown on the right.

Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then from the drop-

112



down—which displays "(root folder)" by default, you can select a specific content folder in your project to
place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and double-click the topic
that you want to link to.

When you are finished, clickOK in the Link to HTMLHelp dialog.

8. (Optional) In theScreen Tip field, you can type a phrase that will appear when the end user hovers over the
hyperlink in the output. This is added not only a "title" attribute, but asan "alt" (alternate text) attribute aswell.

9. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked destination will open.
This option can be used to open the destination topic or file in a popup.

(default) The destination file will open in the samewindow as the output window.

Parent Frame_parent The destination file will open in the parent frame of the current topicwhile hiding
that topic.

New Window_blank The destination file will open in a new browser window.

Same Frame_self The destination file will open in the samewindow frame as the current topic.

Top Frame_top The destination file will open in the same output window, removing all other framesets.
Youmight use this option, for example, if the destination topic has its own frameset.

Popup Window The destination file will open in a popup boxon top of the current topic.

10. (Optional) In the Tab Index field you can enter a value to specify the order in which users can tab through hyper-
links in the image. So when a user presses the Tab key the first time in a topic, the hyperlinkwith an index value of
1 will be selected first, the hyperlinkwith a value of 2 will be selected next, and so on. If you want to skip a hyperlink,
enter -1 in that field.

Note: This feature is supported only inWebHelp outputs—WebHelp, HTML5,WebHelp AIR,
WebHelpMobile,WebHelp Plus.

11. ClickOK. The hyperlink is added to the imagemap.

12. If you want to addmore hyperlinks to the image, select a shape button again and repeat the stepsabove.

13. When you are finished creating hyperlinkson the image, clickOK in the ImageMap Editor.

14. Click to save your work.

CHAPTER 10│Navigation Links Guide 113



Buttons and Sections
Following are descriptionsof buttonsand sections found in the ImageMap Editor.

Description

File Use thismenu to selectOK (to accept changes in the editor) or Cancel (to close the editor without saving
changes).

Edit Use thismenu to select basic editing options (such asundo, redo, cut, copy, and paste).

View Use thismenu to open and close certain elements in the editor (such as toolbars, messages, and the status
bar).

OK Click this button to accept your changes in the editor.

Cancel Click this button to close the editor without saving changes in the editor.

Click this button to toggle between seeing a clear image of the picture and a faded image.

Click this button to hide the shapes that you draw over areasof the image.

Click this button to fill the shapes that you draw over areasof the image.

Click this button to open the Area Properties dialog, which lets you find and select a destination file to link to a
shape that you've drawn. Youmust select a shape before this button is enabled.

Click this button to delete a selected point in the editor.

Click this button to enable "Select" mode so that you can click on shapes that you have drawn in the editor.

Click this button to draw a polygon shape over an area of the image. You can then select the shape and link it
to a destination file.

Click this button to draw a rectangle shape over an area of the image. You can then select the shape and link
it to a destination file.

Click this button to draw a circle shape over an area of the image. You can then select the shape and link it to
a destination file.

Click this button to bring a shape up one layer (if it is overlapped byone or more other shapes).
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Description

Click this button to bring a shape up to the top layer (if it is overlapped byone or more other shapes).

Click this button tomove a shape down one layer (if it is overlapped byone or more other shapes).

Click this button tomove a shape down to the bottom layer (if it is overlapped byone or more other shapes).

Click this button tomove the selected shape slightly to the left.

Click this button tomove the selected shape slightly to the right.

Click this button tomove the selected shape slightly up.

Click this button tomove the selected shape slightly down.

Opens the Condition tagsdialog, which lets you apply condition tags to content.

Href You can enter a path to the destination file so that it can be linked to the selected shape. Alternatively, you can
click to find and select a destination file. The path to that file will then be displayed in this field.

Alt You can enter an Alt tag in this field. An Alt tag providesa textual equivalent for the image. This code allows
the page to be usable bypersonswith graphics turned off or who are blind and using a screen reader.

Tab
Index

You can enter a value to specify the order in which users can tab through linkson an image. So when a user
presses the Tab key the first time, the linkwith an index value of 1 will be selected first, the linkwith a value of 2
will be selected next, and so on. If you want to skip a link, enter -1 in that field. This feature is supported only in
WebHelp outputs—WebHelp, HTML5,WebHelp AIR,WebHelpMobile,WebHelp Plus.
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FrameMaker Links
If you are importing Adobe FrameMaker documents and you have created hyperlinksby
using "SpecifyNamedDestination" and "Jump to NamedDestination" markers, Flare will auto-
matically convert them to links in your project. Following are steps for creating these hyperlinks
in Adobe FrameMaker. For more information, please refer to the documentation provided
with Adobe FrameMaker.



HOW TO CREATE A HYPERLINK IN A FRAMEMAKER SOURCE DOCUMENT

The following stepsmayvary in different versionsof FrameMaker.

1. Open the Adobe FrameMaker document.

2. In Adobe FrameMaker, place your cursor at the spot to be used as the destination for a link. Thismight be a head-
ing that will become a new topicwhen you import the document.When a user clicks on the hyperlink (created
below), this is the content that will be displayed to end users.

3. SelectSpecial>Hypertext. The Hypertext dialog opens.

4. From theCommand field, selectSpecify Named Destination.The text "newlink" is added to the area below.

5. After the text "newlink," type a name to identify the destination (perhaps the name of the heading).

6. ClickNew Hypertext Marker.

7. Locate the area that you want to serve as the hyperlink. Prepare the area to become a hyperlink, according to the
documentation provided with Adobe FrameMaker.

8. Place your cursor in the prepared hypertext area.

9. From theCommand field of the Hypertext dialog, select Jump to Named Destination. The text "gotolink" is
added to the text area below.

10. After the text "gotolink," type the name that you gave to the destinationmarker.

11. ClickNew Hypertext Marker.

12. Close the Hypertext dialog.

13. Save the Adobe FrameMaker document.

Note: Flare supportsFrameMaker 7.0 and newer versions.
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Togglers

This feature is supported in all online outputs (DotNet Help, Eclipse Help, Microsoft
HTMLHelp, HTML5,WebHelp,WebHelp AIR,WebHelpMobile, andWebHelp Plus).

A toggler is a feature that lets users click a hotspot to reveal one or more named elements in a
topic. A named element (also called the "toggler target") is a chunkof content that can reside
anywhere in the topic.When users click the toggler hotspot, the output reveals hidden content
elements.When users click the hotspot again, the content is hidden again.

This chapter discusses the following:

Inserting Togglers 120

Editing Togglers 122

Deleting Togglers 125



Inserting Togglers
Following are steps for inserting a toggler:

HOW TO INSERT A TOGGLER

1. Open the content file (e.g., topic, snippet).

2. Click anywhere in the paragraph that you want to toggle (the content that will open when users click the hotspot).

3. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select theHome ribbon. In theAttributes section, selectName.

You can use theOptionsdialog to switch between ribbonsand the classic tool strip layout. For more inform-
ation see the online Help.

Keep inmind that the smaller the application window becomes, themore the options in a ribbon shrink.
Therefore, youmight only see a small icon instead of text, or youmight see only a section name displayed
with a down arrow to access the options in it. You can hover over small icons to see tooltips that describe
them. You can also enlarge the application window or click one of the section drop-downs in the ribbon to
locate a hidden feature.

Menu Select Format>Name.

TheManage Named Elements dialog opens.

4. Type a name for the toggled element (anything that will help you identify it).

5. ClickOK. The named element is added, with a yellow flag next to it. The flag will not display in the output. It is
simply used to show you where a named element hasbeen inserted. You can hide or show this flag by selecting

the option from theShow tags button in the XMLEditor local toolbar.

6. In the topic, highlight the text that you want to use as the toggler hotspot.

7. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In the Text section, select Toggler.

Menu Select Insert>Toggler.

The Insert Toggler dialog opens.

8. In the Toggler targets section, click the checkboxnext to the toggler element that you created.

9. (Optional) In the Toggler class section, select a style class to be associated with the toggler.
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10. ClickOK. The toggler hotspot now has the toggler icon next to it in the XMLEditor. (The icon will not display in
the output. It is simply used to show you where a named element hasbeen inserted.)

11. Click to save your work.
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Editing Togglers
You can edit togglers that you have inserted into a topic in at least three different ways: (1) edit the content in the section
that is "toggled," (2) edit the style of a toggler hotspot, and (3) associate the hotspot with another toggler element and/or
style class.

HOW TO EDIT THE TOGGLER CONTENT

The first way to edit drop-down text is to change the actual content in the section that gets "toggled" when users click the
hotspot.

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, click in the area containing the toggler content. Then add, remove, or replace content asneces-
sary.

3. Click to save your work.
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HOW TO EDIT THE STYLE OF A TOGGLER HOTSPOT

You can edit the style (e.g., font, color) of a toggler hotspot.When you do this, the style changes for all toggler hotspots in
any topics in your project.

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Advanced view is cur-

rently shown in the editor). If the button displays instead, then click it.

Note: For stepsusing the Simplified View, see the online Help.

3. In the upper-left corner of the editor, click in theShow Styles field and select .

4. In theStyles section on the left side of the editor, find and select the style calledMadCap|toggler (or a toggler
style class you have created within it).

5. From theShowdrop-down list on the upper-right side of the editor, select . The
most relevant properties for that style are shown on the right side of the editor.

6. From theProperties section, change values for anyof the style's properties. Following are some of themore
common properties that youmight change.

mc-closed-image This style, located in theUnclassified property group, lets you select an image to be
shown next to the toggler effect when it is in a closed state.

mc-closed-image-alt-text This style, located in theUnclassified property group, lets you set alternate
text for the toggler effect when it is in a closed state.

mc-open-image This style, located in theUnclassified property group, lets you select an image to be
shown next to the toggler effect when it is in an open state.

mc-open-image-alt-text This style, located in theUnclassified property group, lets you set alternate
text for the toggler effect when it is in an open state.

7. Click to save your work.
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HOW TO ASSOCIATE A HOTSPOT WITH ANOTHER TOGGLER ELEMENT

The third way to edit a toggler is to associate the hotspot with another toggler element and/or style class.

E X A M P L E

Youmight havemultiple sectionsof content in a topic that are open and closed via toggler hotspots. If you are
using one hotspot to "toggle" one section of content, you can easily associate that hotspot with an additional sec-
tion of content, so that it "toggles" both areaswhen a user clicks it.

1. Open the content file (e.g., topic, snippet).

2. If you have not yet given a toggler element name to the content that you want to show and hide, follow the steps
for inserting a toggler.

3. In the XMLEditor, right-click the icon at the beginning of the toggler hotspot.

4. In themenu, selectEdit Toggler. The Insert Toggler dialog opens.

5. In the Toggler targets section, click the checkboxnext to any toggler elements that you want to associate with
the hotspot. You can select asmany toggler elements asneeded.

6. In the Toggler class section, select a style class to be associated with the toggler.

7. ClickOK.

8. Click to save your work.
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Deleting Togglers
If you have inserted a toggler into a topic and want to remove the toggler hotspot, use the following steps.

HOW TO DELETE A TOGGLER FROM A TOPIC

1. Open the content file (e.g., topic, snippet).

2. Right-click the icon at the beginning of the toggler.

3. From themenu, selectDelete. The toggler hotspot and its content are removed from the topic.

4. Click to save your work.
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Drop-Downs

This feature is supported in all online outputs (DotNet Help, Eclipse Help, Microsoft
HTMLHelp, HTML5,WebHelp,WebHelp AIR,WebHelpMobile, andWebHelp Plus).

Drop-down text is a feature that lets you collapse content in your topic. Let's say you have a
topic that seems to be getting quite lengthy. So you decide to condense the portion of the topic
that contains step-by-step procedures.When users open the topic in the output, theywill see
a link (also called a "drop-down hotspot"). This hotspot is the first paragraph (or a section of
the first paragraph) that you condensed. It might be something like "How to create a thingama-
jig." When users click that hotspot, the hidden content (e.g., the actual steps to create the
thingamajig) is displayed below the hotspot.When users click the hotspot again, the content
becomeshidden oncemore.

This chapter discusses the following:

Tasks Associated with Drop-Down Text 128

Inserting Drop-Down Text 129

Creating Drop-Down Effects in FrameMaker Source Documents 132

Editing Drop-Down Text 133

Removing/Unbinding Drop-Down Text 136

Deleting Drop-Down Text 137



Tasks Associated with Drop-Down Text
You can do the following with drop-down text:

Insert You can create a new drop-down effect in the XMLEditor in Flare. See "Inserting Drop-Down Text " on
the following page.

Create in FrameMaker These steps show you how to create a new drop-down effect in a FrameMaker source
document (if you plan to import that document into Flare). After you import the document, the drop-down effect
will automatically be created in the XMLEditor. See "Creating Drop-Down Effects in FrameMaker Source Docu-
ments" on page 132.

Edit You can change the style and content for a drop-down effect. See "Editing Drop-Down Text" on page 133.

Remove/Unbind You can remove (or "unbind") a drop-down effect so that it is displayed asnormal text. See
"Removing/Unbinding Drop-Down Text" on page 136.

Delete You can delete a drop-down effect, therefore removing all of its text from the topic. See "Deleting Drop-
Down Text" on page 137.
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Inserting Drop-Down Text
The following steps show you how to create a new drop-down effect.

HOW TO INSERT DROP-DOWN TEXT

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor type and format the content that will become the drop-down hotspot and the drop-down body.

3. Highlight all of the paragraphs that you want to become the drop-down text, including the first paragraph, which
will contain the hotspot.

4. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In the Text section, selectDrop-Down Text.

You can use theOptionsdialog to switch between ribbonsand the classic tool strip layout. For more inform-
ation see the online Help.

Keep inmind that the smaller the application window becomes, themore the options in a ribbon shrink.
Therefore, youmight only see a small icon instead of text, or youmight see only a section name displayed
with a down arrow to access the options in it. You can hover over small icons to see tooltips that describe
them. You can also enlarge the application window or click one of the section drop-downs in the ribbon to
locate a hidden feature.

Menu Select Insert>Drop-Down Text.

The Insert Drop-Down dialog opens. The entire first paragraph is displayed in the Drop-DownHead field. The
rest of the paragraphsare displayed in the Drop-Down Bodysection.
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5. If you want only a portion of the first paragraph to be used as the hotspot link, highlight only that specific text in the
field (otherwise, leave the text in that field as it is).
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6. ClickOK. The entire drop-down text section now hasbrackets around it in the XMLEditor (if markers are turned
on). The hotspot hasa blue down arrow to the left of it. If you designated just a portion of the first paragraph to
serve as the hotspot, smaller brackets surround it.

7. Click to save your work.

Note: There is also an option called "Drop-DownHotspot." This option lets you specify the exact text to use in a
drop-down effect as the drop-down hotspot. In order for this option to be enabled, you first need to insert drop-
down text into a topic. Then select a portion of the drop-down head (the first paragraph of the drop-down
effect) and choose this option.

CHAPTER 13│Navigation Links Guide 131



Creating Drop-Down Effects in FrameMaker Source Documents
The following steps show you how to create a new drop-down effect in a FrameMaker source document (if you plan to
import that document into Flare). After you import the document, the drop-down effect will automatically be created in the
XMLEditor.

HOW TO CREATE A DROP-DOWN EFFECT IN A FRAMEMAKER SOURCE DOCUMENT

The following stepsmayvary in different versionsof FrameMaker.

1. Open the FrameMaker document.

2. In FrameMaker, create the two drop-down paragraph styles that are required for producing this effect. This is a
one-time step in the document. Afterwards, you can simply select the newly created styleswhen specifying drop-
down text. To create the two styles, do the following.

a. In FrameMaker, select Format>Paragraphs>Designer. The Paragraph Designer opens.

b. From theCommands field, click the down arrow and selectNew Format. The New Format dialog opens.

c. In the Tag field, type PullDownButton.

d. Make sure that theStore in Catalog checkboxhasa checkmark.

e. Make sure that theApply to Selection checkboxdoesNOT have a checkmark in it (unless you want the
new style to immediately be applied to the paragraph where your cursor is placed).

f. ClickCreate.

g. Follow these same steps to create a paragraph style called PullDownBody.

h. Close the Paragraph Designer.

3. In the FrameMaker document, place your cursor in the paragraph that you want to serve as the drop-down hot-
spot in the online output (i.e., when the user clicks that hotspot, the text below that is identified as the drop-down
bodywill be shown or hidden).

4. From the styles drop-downmenu or from the paragraph catalog, selectPullDownButton.

5. Highlight the paragraph(s) that you want to serve as the drop-down body in the online output.

6. From the styles drop-downmenu or from the paragraph catalog, selectPullDownBody.

7. Save the FrameMaker document.

Note: Flare supportsFrameMaker 7.0 and newer versions.

After you apply the drop-down styles to the FrameMaker document(s), you can import those documents into a Flare pro-
ject.
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Editing Drop-Down Text
You can edit drop-down text that you have inserted into a topic in at least three different ways: (1) edit the content in the
drop-down text, (2) edit the style of drop-down text, and (3) unbind (or remove) the drop-down effect.

HOW TO EDIT THE CONTENT IN DROP-DOWN TEXT

The first way to edit drop-down text is to change the actual content in the drop-down heading (or hotspot) or in the drop-
down body.

E X A M P L E

Let's say you have drop-down text in a topic that contains the words "click here" as the hotspot and one para-
graph as the drop-down body. If you want to change the text of the hotspot to "see this," you would simply replace
the hotspot text between the small brackets in the topic. And if you want to add another paragraph in the drop-
down body, you would simply click at the end of the current paragraph in the drop-down body, pressEnter, and
type the additional paragraph.

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, click in the area containing the drop-down hotspot or drop-down body. Then add, remove, or
replace the content asnecessary.

3. Click to save your work.
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HOW TO EDIT THE STYLE OF DROP-DOWN TEXT

You can edit the style (e.g., font, color) of a drop-down hotspot or body.When you do this, the style changes for all drop-
down text in any topics in your project.

E X A M P L E

Let's say that you want to change the font for your drop-down hotspots to red and italic. The following steps show
you how to accomplish this.

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Advanced view is cur-

rently shown in the editor). If the button displays instead, then click it.

Note: For stepsusing the Simplified View, see the online Help.

3. In the upper-left corner of the editor, click in theShow Styles field and select .

4. In theStyles section on the left side of the editor, find and select the appropriate style, depending on what you
want to change.

MadCap|dropDown This style affects the entire container holding a drop-down effect, including the
image that is shownwhen a drop-down effect is open or closed.

MadCap|dropDownBody This style affects the content that is shownwhen users open the drop-down
effect.

MadCap|dropDownHead This style affects the text in the first paragraph of a drop-down effect (i.e., the
paragraph where the drop-down link is located).

MadCap|dropDownHotSpot This style affects the specific text that you select in the first paragraph of a
drop-down effect to serve as the link for opening the drop-down body. If you do not select specific text in the
first paragraph to serve as the hotspot, the entire first paragraph is used as the hotspot.

5. From theShowdrop-down list on the upper-right side of the editor, select . The
most relevant properties for that style are shown on the right side of the editor.
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6. From theProperties section, change values for anyof the style's properties. Following are some of themore
common properties that youmight change.

mc-closed-image This style, located in theUnclassified property group, lets you select an image to be
shown next to the drop-down effect when it is in a closed state. To use this property, first select the
MadCap|dropDown style mentioned above.

mc-closed-image-alt-text This style, located in theUnclassified property group, lets you set alternate
text for the drop-down effect when it is in a closed state.

mc-open-image This style, located in theUnclassified property group, lets you select an image to be
shown next to the drop-down effect when it is in an open state. To use this property, first select the
MadCap|dropDown style mentioned above.

mc-open-image-alt-text This style, located in theUnclassified property group, lets you set alternate
text for the drop-down effect when it is in an open state.

7. Click to save your work.
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Removing/Unbinding Drop-Down Text
If you have inserted drop-down text into a topic and want to keep the text but remove (or "unbind") the drop-down effect so
that it is displayed asnormal text, use the following steps. If you want to delete the drop-down text, therefore removing all
of its text from the topic, see "Deleting Drop-Down Text" on the following page.

HOW TO REMOVE/UNBIND DROP-DOWN TEXT

1. Open the content file (e.g., topic, snippet).

2. Right-click the down arrow at the beginning of the drop-down text.

3. From theClick to save your work. drop-downmenu, selectUnbind Drop-Down Text. The drop-down effect
is removed, converting the section to normal text.
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Deleting Drop-Down Text
If you have inserted drop-down text into a content file (e.g., topic, snippet) and want to delete it, therefore removing all of
its text from the topic, use the following steps. If you want to keep the text but remove the drop-down effect so that it is dis-
played asnormal text, see "Removing/Unbinding Drop-Down Text" on the previouspage.

HOW TO DELETE DROP-DOWN TEXT

1. Open the content file (e.g., topic, snippet).

2. Right-click the down arrow at the beginning of the drop-down text.

3. From the drop-downmenu, selectDelete. The drop-down text is removed from the topic.

4. Click to save your work.
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Expanding Text

This feature is supported in all online outputs (DotNet Help, Eclipse Help, Microsoft
HTMLHelp, HTML5,WebHelp,WebHelp AIR,WebHelpMobile, andWebHelp Plus).

Expanding text is a feature that lets you collapse content in a paragraph in your topic. Let's say
you have a bulleted list in a topic. After each bullet is a feature of the software program that
you are explaining. You have given a detailed description of each feature, and now the topic
seems to be getting quite lengthy. So you decide to condense each bulleted item so that users
initially see only the name of the feature, which appears asa link (also called an "expanding
text hotspot"). When users click that hotspot, the hidden content (i.e., the rest of the para-
graph) "expands" and is displayed after the hotspot.When users click the hotspot again, the
content becomeshidden oncemore.

This chapter discusses the following:

Inserting Expanding Text 140

Editing Expanding Text 142

Removing/Unbinding Expanding Text 145

Deleting Expanding Text 146



Inserting Expanding Text
Following are steps for inserting expanding text.

HOW TO INSERT EXPANDING TEXT

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor type and format the content that will become the expanding text.

3. Highlight the paragraph (or the portion of it) that you want to become the expanding text, including the word or
words that will be used as the hotspot.

4. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In the Text section, selectExpanding Text.

Menu Select Insert>Expanding Text.

The Insert Expanding Text dialog opens. The paragraph (or the portion of it that you selected) is displayed, with
the first word highlighted. This first word will be used as the hotspot, unless youmodify it by highlightingmore of
the paragraph.

5. If you want additionalwords in the paragraph to be used as the hotspot link, highlight them. Otherwise, leave the
text in that field as it is.

6. ClickOK. The selection is now surrounded bybrackets in the XMLEditor (if markers are turned on). The hotspot

appearswith an icon next to it. The font used in the expanding text dependson the settings specified for the
<MadCap|expandingHead>and <MadCap|expandingBody> styles in your stylesheet.
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7. Click to save your work.

Note: Although this feature is called "expanding text," the content doesnot have to be strictly text only. For
example, you can use an image for the hotspot. To do this, go through the normal process for creating expand-
ing text. When you do this, just type some dummy text at the beginning where you want the image to be. The
reason for this is that the Insert Expanding Text dialog lets you workonlywith text. After you create the expand-
ing text effect, you'll see the two parts of the effect within brackets in the XMLEditor. The hotspot is in the first
set of brackets. Just click inside those brackets and replace the dummy text with the image you want to use.
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Editing Expanding Text
You can edit expanding text that you have inserted into a topic in at least three different ways: (1) edit the content in the
expanding text, (2) edit the style of expanding text, and (3) unbind (or remove) the expanding text effect.

HOW TO EDIT THE CONTENT IN EXPANDING TEXT

The first way to edit expanding text is to change the actual content in the expanding text heading (or hotspot) or in the
expanding text body.

E X A M P L E

Let's say you have expanding text in a topic that contains the words "click here" as the hotspot, and the rest of the
sentence after the hotspot is the expanding text body. If you want to change the text of the hotspot to "see this,"
you would simply replace the hotspot text (which is the text between the first set of brackets). And if you want to
add another sentence to the expanding text body, you would simply click at the end of the current expanding text
body (within the second set of brackets) and type the additional sentence.

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, click in the area containing the expanding text hotspot or body. Then add, remove, or replace
the content asnecessary.

3. Click to save your work.
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HOW TO EDIT THE STYLE IN EXPANDING TEXT

You can edit the style (e.g., font, color) of an expanding text hotspot or body.When you do this, the style changes for all
expanding text in any topics in your project.

E X A M P L E

Let's say that you want to change the font for your expanding text hotspots to red and italic. The following steps
show you how to accomplish this.

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Advanced view is cur-

rently shown in the editor). If the button displays instead, then click it.

Note: For stepsusing the Simplified View, see the online Help.

3. In the upper-left corner of the editor, click in theShow Styles field and select .

4. In theStyles section on the left side of the editor, find and select one of the expanding text styles:

MadCap|expanding This style affects the entire container holding an expanding text effect, including the
image that is shownwhen an expanding text effect is open or closed.

MadCap|expandingBody This style affects the expanded text portion of an expanding text effect (i.e.,
the area that is displayed or hidden when users click the hotspot link).

MadCap|expandingHead This style affects the hotspot portion of an expanding text effect.

5. From theShowdrop-down list on the upper-right side of the editor, select . The
most relevant properties for that style are shown on the right side of the editor.

6. From theProperties section, change values for anyof the style's properties. Following are some of themore
common properties that youmight change.

mc-closed-image This style, located in theUnclassified property group, lets you select an image to be
shown next to the expanding text effect when it is in a closed state. To use this property, first select the
MadCap|expanding style mentioned above.

mc-closed-image-alt-text This style, located in theUnclassified property group, lets you set alternate
text for the expanding text effect when it is in a closed state.
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mc-open-image This style, located in theUnclassified property group, lets you select an image to be
shown next to the expanding text effect when it is in an open state. To use this property, first select the
MadCap|expanding style mentioned above.

mc-open-image-alt-text This style, located in theUnclassified property group, lets you set alternate
text for the expanding text effect when it is in an open state.

7. Click to save your work.
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Removing/Unbinding Expanding Text
If you have inserted expanding text into a topic and want to keep the text but remove (or "unbind") the expanding text effect
so that it is displayed asnormal text, use the following steps. If you want to delete the expanding text, therefore removing all
of its text from the topic, see "Deleting Expanding Text" on the next page.

HOW TO REMOVE/UNBIND EXPANDING TEXT

1. Open the content file (e.g., topic, snippet).

2. Hover over the expanding text icon until the cursor becomesan arrow, then right-click it.

3. From the drop-downmenu, selectUnbind Expanding Text. The expanding text effect is removed, converting
the section to normal text.

4. Click to save your work.
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Deleting Expanding Text
If you have inserted expanding text into a topic and want to delete it, therefore removing all of its text from the topic, use the
following steps. If you want to keep the text but remove the expanding text effect so that it is displayed asnormal text, see
"Removing/Unbinding Expanding Text" on the previouspage.

HOW TO DELETE EXPANDING TEXT FROM A TOPIC

1. Open the content file (e.g., topic, snippet).

2. Hover over the expanding text icon until the cursor becomesan arrow, then right-click it.

3. From the drop-downmenu, selectDelete. The expanding text is removed from the topic.

4. Click to save your work.

146



C
HA

PT
ER

15
Concepts

This feature is supported in all outputs.

A concept is amarker that you can insert into related topic files in order to "tie" them together.

This chapter discusses the following:

Reasons for Using Concepts 149

Steps for Creating Concept Links 152

Steps for Creating Lists of Concepts 153

Concept Link Example 154

Adding Concepts 159

Assigning Topics to Concepts 160

Inserting Concepts 163

Inserting Concept Links 169

Editing Concepts 170

Editing Concept Links 172

Creating a List of Concepts 179

Using Styles to Determine the Look of a List of Concepts 180

Deleting Concepts 184



Deleting Concept Links 186
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Reasons for Using Concepts
In Flare concept markers can be used for various reasons, depending on whether you are creating online or print-based
output.

CONCEPT LINKS—ONLINE OUTPUT

Concepts can be used to create concept (or "see also") links at the bottom of topics. This is a navigation link that lets users
open topics that you've determined are related to the current topic. It is similar to the related topics link. However, whereas
you associate a related topics linkwith specific individual topics (usually for a one-time use), you associate a concept link
with a group of topics (to be reused in different topics). One great benefit of this type of link is that, if you later want to add or
delete topics from the group, you only need to do so in one place and the changesare applied to every topic containing that
concept link.

E X A M P L E

Let's say you are developing a Help system for an employee time-reporting software application. Youmight have
a group of related topics (e.g., Creating a Time Sheet, Changing a Time Sheet, Deleting a Time Sheet), and you
want each of those topics to have the sameHelp control button that links to the same topics. So youmight create
a concept called "TimeSheets." You would then insert the keyword into each of those topics. After that, you insert
a concept link into each of those topics, selecting the "Timesheets" keyword for that link.

Also see "Concept LinkExample" on page 154.
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SEARCH FILTERS —ONLINE OUTPUT

Concepts can be used to create search filters so that end users can quickly narrow searches.
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LISTS OF CONCEPTS—PRINT-BASED OUTPUT

Concepts can be used along with a proxy to generate a list of concepts in output. Although lists of concepts can be created
in either online or print-based output, theyare typically usedmore often in print-based output.
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Steps for Creating Concept Links
Following are themain steps for using concepts to create concept links.

1. Create Concepts In Flare there are a couple of different ways to create concept keywords.

Method 1—Add Concepts to Concept Window Pane and Assign Topics You can use the bottom
area of the Concept window pane (View>Concept Window) to add concepts (see "Adding Concepts" on
page 159) and assign topics to them (see "Assigning Topics to Concepts" on page 160). Themajor benefit
of thismethod is that it is an easyand quickway to place the same concept marker at the beginning of mul-
tiple topics andmaintain better consistency.

Method 2—Insert Concepts in Individual Topics You can open a topic and use the top area of the
Concept window pane to insert concepts into that file (see "Inserting Concepts" on page 163).

2. Insert Concept Link After you create concepts keywords, you can insert concept links in topics. See "Inserting
Concept Links" on page 169.

3. Modify Look of Concept Link If you want to change the way the link looks, you canmodify the style of the
concept link. For more information see "Editing Concept Links" on page 172.
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Steps for Creating Lists of Concepts
Following are themain steps for using concepts to create a list of concepts.

1. Create Concepts In Flare there are a couple of different ways to create concept keywords.

Method 1—Add Concepts to Concept Window Pane and Assign Topics You can use the bottom
area of the Concept window pane (View>Concept Window) to add concepts (see "Adding Concepts" on
page 159) and assign topics to them (see "Assigning Topics to Concepts" on page 160). Themajor benefit
of thismethod is that it is an easyand quickway to place the same concept marker at the beginning of mul-
tiple topics andmaintain better consistency.

Method 2—Insert Concepts in Individual Topics You can open a topic and use the top area of the
Concept window pane to insert concepts into that file (see "Inserting Concepts" on page 163).

2. Add Topic with Concepts Proxy You can use the concepts proxy to generate a list of all of the concepts in
your project, with links to the corresponding content.When you generate the output, the proxy is replaced with a
list of the paragraph text found wherever a concept hasbeen inserted. See "Creating a List of Concepts" on
page 179.

3. Modify Look of List After you use the concepts proxy to create a list of concepts, you can change the lookof
that list by using styles. You canmodify the lookof individual entries in the list, aswell as the entire container. For
more information see "Using Styles to Determine the Lookof a List of Concepts" on page 180.

4. Add Topic to Outline TOC Add the topicwith the concepts proxy to the outline TOC. For more information see
the online Help.
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Concept Link Example
The following example is designed to helpmake the idea of concept links clearer and guide you through the steps for cre-
ating your own concept links.

Scenario

Let's saywe have a Flare project called "Pets." In this project, we have dozensof topics about all kindsof animals (cats,
dogs, parrots, hamsters, and so on).We have written five topics about dogs.

Choosing a Dog

Feeding a Dog

Training a Dog

Grooming a Dog

Walking a Dog

Because these five topics all have something in common (i.e., they're all about dogs), we want to include a link at the bot-
tom of each of those five topics that lets users quickly jump to anyof the other "dog" topics.

Step 1—Create and Insert a Concept

First, we need to create a concept to tie these five topics together.We can create a concept with anyname that we want,
but it helps to name the keyword something that is obviousand all topics have in common. Therefore, we'll give our
concept the name "dogs."

1. Open anyof the five topics. In this example, we'll open the topic "Choosing a Dog."

2. Click in the location in the topicwhere you want to insert the concept. Typically, you'll insert the concept some-
where near the top of the topic. In our example, we will click right before our topic title "Choosing a Dog."

3. SelectView>Concept Windowor pressSHIFT+F9 on your keyboard. The Concept window pane opens.

4. The cursor should alreadybe placed in the Terms cell. If not, click in that cell. Type Dogsand pressEnter. A
concept marker labeled "Dogs" is added before the topic title. If you cannot see themarker, turn your markers on

by clicking the down arrow next to theShow tags button in the XMLEditor. Then selectShow Markers.
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Step 2—Copy and Paste the Concept Marker into All Relevant Topics

Next, we need to place the same concept in our other four "dog" topics.We could repeat the same stepsabove for each
topic, but we'll copyand paste our first concept marker instead.

1. In the "Choosing a Dog" topic, right-click on the concept marker and chooseCopy.

2. Open another "dog" topic ("Feeding a Dog," "Training a Dog," etc.). Click in front of the topic title (or somewhere
near the top of the topic), and pressCTRL+V on your keyboard.

Repeat this until you've pasted the concept marker into all five of the "dog" topics.

3. Select File>Save>Save All (if using ribbons), select File>Save All (if usingmenus), or pressCTRL+SHIFT+S.

Step 3—Insert a Concept Link

Now that we have the concepts in place, we can insert a concept link into each of the five "dog" topics. This is the link that
userswill see and click in the output. Theywill not see the concepts that we created at the top of each topic (those are
simplymarkers).

1. In one of the "dog" topics, place your cursor at the end of the last piece of content (e.g., after the final paragraph).
Then pressEnter to create a new paragraph.

2. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In theHelp Control section selectConcept Link (A-link).

Menu Select Insert>Help Control>Concept Link (A-link).

The Insert Concept LinkControl dialog opens. The "Dogs" concept that we inserted is listed on the right side of
the dialog.

3. In theAll Concepts section, double-clickDogs. This concept is now listed in the "Selected Concepts" section on
the left.
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4. ClickOK. The concept link is added to the topic.
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Step 4 - Copy and Paste the Concept Link into All Relevant Topics

Finally, we need to place the same concept link in our other four "dog" topics.We could repeat the same stepsabove for
each topic, but we'll copyand paste our first concept link instead.

1. In the topicwhere the first link hasbeen inserted, right-click on the concept link and chooseCopy.

2. Open another "dog" topic ("Feeding a Dog," "Training a Dog," etc.). Place your cursor at the end of the last piece
of content (e.g., after the final paragraph). Then pressEnter to create a new paragraph.

3. PressCTRL+V on your keyboard.

Repeat this until you've pasted the concept link into all five of the "dog" topics.

4. Select File>Save>Save All (if using ribbons), select File>Save All (if usingmenus), or pressCTRL+SHIFT+S.
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Adding Concepts
Use the following steps to add concepts.

HOW TO ADD A CONCEPT

1. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select theView ribbon. In theReference section selectConcept Window.

Menu SelectView>Concept Window.

Keyboard Shortcut PressSHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Termsarea at the top and the
Explorer area at the bottom. If you want to seemore or lessof either section, you can click the splitter
between them and drag it up or down.

2. In the explorer area at the bottom of the window pane, right-click onConcepts and from the context menu select
Add Concept.

3. Type the concept keyword and pressEnter.
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Assigning Topics to Concepts
After you add concepts in the Concept window pane, you can assign topics to them. There are twomethods for doing this.

Context menu in Concept window pane

Drag fromContent Explorer

HOW TO ASSIGN TOPICS TO A CONCEPT—CONTEXT MENU IN CONCEPT WINDOW PANE

1. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select theView ribbon. In theReference section selectConcept Window.

Menu SelectView>Concept Window.

Keyboard Shortcut PressSHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Termsarea at the top and the
Explorer area at the bottom. If you want to seemore or lessof either section, you can click the splitter
between them and drag it up or down.
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2. Right-click on the concept and from the context menu selectAssign Topic.

3. In the dialog that opens, find and select the topic(s). You can hold theSHIFT key to select a range, or you can hold
theCTRL key to select individual items.

4. In the dialog, clickClose.

Paths to the selected topics are displayed in the Concept window pane after the keyword. And a concept marker
is added at the beginning of each topic.
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HOW TO ASSIGN TOPICS TO A CONCEPT—DRAG FROM CONTENT EXPLORER

1. Make sure the Content Explorer is open.

2. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select theView ribbon. In theReference section selectConcept Window.

Menu SelectView>Concept Window.

Keyboard Shortcut PressSHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Termsarea at the top and the
Explorer area at the bottom. If you want to seemore or lessof either section, you can click the splitter
between them and drag it up or down.

3. In the local toolbar of the Content Explorer, click theShow Files button . The window pane splits into left and
right halves.

4. In the left half of the Content Explorer, click the folder holding the topics that you want to assign to a concept.

5. In the right half of the Content Explorer, select the topics. You can hold theSHIFT key to select a range, or you
can hold theCTRL key to select individual items.

6. Drag the selected topics and drop them on the concept keyword that is displayed the bottom (explorer) portion of
the Concept window pane.

Paths to the selected topics are displayed in the Concept window pane after the keyword. And a concept marker
is added at the beginning of each topic.
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Inserting Concepts
There are a few different ways to insert an index keyword into a topic or snippet, and each has its own advantages.

Drag-and-DropMethod

Use thismethod to quickly insert a concept that alreadyexists in your project.

Advantage It is extremely fast.

Disadvantage The concept that you want to insert must alreadyexist in the project. Thismeans youmust first
insert the concept into a topic using one of the other methods.

HOW TO INSERT AN CONCEPT USING THE DRAG-AND-DROP METHOD

1. Open the content file (e.g., topic, snippet).

2. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select theView ribbon. In theReference section selectConcept Window.

Menu SelectView>Concept Window.

Keyboard Shortcut PressSHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Termsarea at the top and the
Explorer area at the bottom. If you want to seemore or lessof either section, you can click the splitter
between them and drag it up or down.
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3. In the bottom (explorer) area of the Concept window pane, click the concept and drag it to the location in the topic
where you want to insert it. As you drag the concept into the topic, a vertical red bar acts asa guide to help you
place the concept in the topic.

The concept is displayed within amarker in front of the word where you added it (as long asmarkers are turned
on). Amarker can holdmultiple concepts, but most times you only need one concept per marker.

4. Click to save your work.
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Concept Window PaneMethod

Use thismethod to insert a concept in the Concept window pane.

Advantage It lets you continue to perform other tasks in the topicwithout having to "switchmodes."

Disadvantage It is not quite as fast as the other methods.

HOW TO INSERT AN CONCEPT USING THE CONCEPT WINDOW PANE METHOD

1. Open the content file (e.g., topic, snippet).

2. Click at the location where you want to insert a concept.

3. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select theView ribbon. In theReference section selectConcept Window.

Menu SelectView>Concept Window.

Keyboard Shortcut PressSHIFT+F9.

The Concept window pane opens.

4. Click in an empty field in the Terms column.

5. Type the concept as you want it to appear.

CHAPTER 15│Navigation Links Guide 165



6. PressEnter. The concept is displayed within amarker in front of the word where you added it (as long asmarkers
are turned on). Amarker can holdmultiple concepts, but most times you only need one keyword per topic.

7. Click to save your work.
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Concept Entry ModeMethod

Use thismethod to accomplish the same thing as the Concept window panemethod. The difference is that, with this
method, you do not need tomove your cursor from the topic to the Concept window pane. You simply click at the spot in
the text where you want to insert the keyword and start typing. The words you type are added directly into the Concept win-
dow pane. This is a goodmethod to use if you plan to create concepts in a lot of topics all at once, without performing any
other tasks in the topic.

Advantage It is extremely fast.

Disadvantage If you are adding a concept as you workon a topic, you need to remember to switch off the Concept
EntryMode so that you can return to editing your topic.

HOW TO INSERT AN CONCEPT USING THE CONCEPT ENTRY MODE METHOD

1. Open the content file (e.g., topic, snippet).

2. Do one of the following, depending on the part of the user interface you are using:

Menu Select Tools>Concepts>Concept Entry Mode.

You can use theOptionsdialog to switch between ribbonsand the classic tool strip layout. For more inform-
ation see the online Help.

Local Toolbar In the local toolbar of the XMLEditor click .

The cursor changes, displaying a small boxed "c" next to it.

3. Click at the place in your topicwhere you want to add a concept.
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4. Type the phrase that you want to add as the concept.

As you start typing, the Concept window pane opens (if it wasnot previously opened), and the phrase is added to
the first empty field under the Termscolumn.

Note: Asyou type in the Concept window pane, notice that the cursor doesnot lose focus in the XML
Editor. It merely turnsgray so that you know for certain where you are adding the concept.When you
return to the XMLEditor, the cursor returns to its previous state.

5. PressEnter. The concept is displayed within amarker in front of the word where you added it (as long asmarkers
are turned on). Amarker can holdmultiple concepts, but most times you only need one keyword per topic.

6. If you want to addmore concepts in the topic, repeat steps3-5.

7. Click to save your work.

Note: To turn off the Concept EntryMode and return to regular editing, you can click again.

Note: If you want to see all of the concepts that you have inserted in your project, theyare displayed in the bot-
tom portion of the Concept window pane.
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Inserting Concept Links
After you create concepts keywords, you can insert concept links.

A concept link lets users open topics that you've determined are related to the current topic. It is similar to the related topics
link. However, whereas you associate a related topics linkwith specific individual topics (usually for a one-time use), you
associate a concept linkwith a group of topics (to be reused in different topics). One great benefit of this type of link is that, if
you later want to add or delete topics from the group, you only need to do so in one place and the changesare applied to
every topic containing that concept link.

Note: Another type of automated link that can be added to topics is a relationship link, which hasa similar result
but worksa bit differently than Help controls. One benefit of a relationship link is that you can create all of your
link information in one place, in a single relationship table. Another benefit is that you can havemultiple typesof
links at the bottom of topics (e.g., one for "Related Information," one for "Related Tasks," and one for "Refer-
enceMaterials"). See "Relationship Table Components" on page 217.

Note: When people click a link like this in the output, the text shown for each of the topics dependson whether
the topic in question hasa title or heading. The title set in the Properties dialog has the highest level of pre-
cedence. If there is no topic title specified in the Properties dialog, Flare uses text associated with <h1> through
<h6>heading styles. If there is no topic title or headings in a topic, Flare uses the topic file name.
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Editing Concepts
After you insert a concept, youmight decide later that the concept keyword needs to be altered. You canmodify a concept
simultaneously for all topicswhere that keyword is located, or you canmodify it in a specific topic.

HOW TO EDIT A CONCEPT IN ALL TOPICS WHERE IT IS LOCATED

1. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select theView ribbon. In theReference section selectConcept Window.

Menu SelectView>Concept Window.

Keyboard Shortcut PressSHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Termsarea at the top and the
Explorer area at the bottom. If you want to seemore or lessof either section, you can click the splitter
between them and drag it up or down.

2. In the explorer area at the bottom of the window pane, right-click on the concept that you want to rename. From
the context menu selectRename Keyword. The concept is renamed in all topicswhere it had been inserted
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HOW TO EDIT A CONCEPT IN A SPECIFIC TOPIC

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, right-click on themarker holding the concept that you want to modify. From the context menu,
selectEdit the Concept Association.

The Concept window pane opens. The window pane is split into two sections—the Termsarea at the top and the
Explorer area at the bottom. If you want to seemore or lessof either section, you can click the splitter
between them and drag it up or down.

3. In the Terms column of the Concept window pane, click in the cell containing the keyword that you want to
change.

4. Type the concept and pressEnter. The concept ismodified.

5. Click to save your work.

Note: If you want to change how concepts lookwhen they're inserted in the XMLEditor, you can change the
MadCap|concept style in the Stylesheet Editor.This doesnot affect the output.
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Editing Concept Links
You can edit a concept link that you have inserted into a topic.

HOW TO CHANGE THE CONCEPTS ASSOCIATED WITH A CONCEPT LINK

The first way to edit a concept link is to change the concepts associated with the link, aswell as specify variousother
optional settings.

E X A M P L E

Let's say you have a concept link that has two concepts ("Projects" and "Systems") associated with it. Youmight
want to remove the "Projects" keyword from the link so that it only contains the "Systems" keyword. The steps
below show you how to do this.

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, right-click the concept link.

3. In the context menu, selectEdit Concept Link. The Insert Concept LinkControl dialog opens.

The concepts currently associated with the link are listed on the right side of the dialog. The concepts that you
have inserted into all other topics are listed on the left side of the dialog.

4. If you want to add a concept to the link, click on that keyword on the left (All Concepts) side of the dialog. Then
click . If you want to remove a concept from the link, click on that keyword on the right (Selected Concepts)
side of the dialog. Then click .

Repeat this for each keyword that you want to add to or remove from the link.When you are finished, the
keywordsassociated with the link should be in the Selected Concepts section, and the keywordsnot associated
with the link should be in the AllConcepts section. However, a concept link usually hasonly one keyword asso-
ciated with it (or just a few at themost). Remember, every topic containing anyof those conceptswill show up in
the concept link in the output.

5. (Optional) If you want to specify other options for the control, click and in the Concept LinkOptionsdialog select
anyof the following. ClickOK to close the dialog when you are finished.

Style Class You can select the style class to be used for the control.

Label You can change the text shown on the control.

Display topics in You can specify that the links should be displayed in a popupmenu (same asdefault) or
asa simple list.
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Note: For projects that aremerged, the list option is supported for standardmerging (e.g., link-
ing to an FLPRJ file in the table of contents). However, it is not supported for automerging in
WebHelp Plusoutput.

Target Frame You can choose the type of frame used when a link is clicked.

(default) The destination file will open in the samewindow as the output window.

Parent Frame_parent The destination file will open in the parent frame of the current topicwhile
hiding that topic.

New Window_blank The destination file will open in a new browser window.

Same Frame_self The destination file will open in the samewindow frame as the current topic.

Top Frame_top The destination file will open in the same output window, removing all other
framesets. Youmight use this option, for example, if the destination topic has its own frameset.

Popup Window The destination file will open in a popup boxon top of the current topic.

6. ClickOK. The Insert Concept LinkControl dialog closes, and the link is now changed.

7. Click to save your work.
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HOW TO EDIT THE STYLE OF A CONCEPT LINK

You can edit the style of a concept link.When you do this, the style changes for all concept links in any topics in your project.
Also, keep inmind the various rules that pertain to concept links.

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Advanced view is cur-

rently shown in the editor). If the button displays instead, then click it.

Note: For stepsusing the Simplified View, see the online Help.

3. In the upper-left corner of the editor, click in theShow Styles field and select .

4. In theStyles section on the left side of the editor, find and select one of the following styles, depending on what
you want to accomplish. You can use a general style (which startswith "helpControl") if you want to modify all
typesof Help control links (concept, keyword, and related topic links). Alternatively, you can use a specific style
(which startswith "conceptLink") if you want to modify only concept links in your project.

MadCap|helpControlList Edit this style to change the lookof the entire list (<ul> element) when linksare
displayed in a list, rather than in a popup.

MadCap|helpControlListItem Edit this style to change the lookof individual items in the list (<li> ele-
ments) when linksare displayed in a list, rather than in a popup.

MadCap|helpControlListItemLink Edit this style to change the lookof links in the list (<a> elements)
when linksare displayed in a list, rather than in a popup.

MadCap|helpControlMenu Edit this style to change the lookof links (i.e., menu items) when linksare dis-
played in a popup, rather than in a list. This particular style controls the entire list.

MadCap|helpControlMenuItem Edit this style to change the lookof links (i.e., menu items) when links
are displayed in a popup, rather than in a list. This particular style controls the individual list items.

MadCap|conceptLink Edit this style to change the lookof the heading for concept links. The following
three concept link styles inherit properties from this style.

MadCap|conceptLinkControlList Edit this style to change the lookof the entire list (<ul> element) when
concept links are displayed in a list, rather than in a popup.

MadCap|conceptLinkControlListItem Edit this style to change the lookof individual items in the list (<li>
elements) when concept links are displayed in a list, rather than in a popup.

MadCap|conceptLinkControlListItemLink Edit this style to change the lookof links in the list (<a> ele-
ments) when concept links are displayed in a list, rather than in a popup.
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Note: You can also change a pseudo classof a link style (e.g.,MadCap|conceptLink.focus or
MadCap|conceptLink.hover) if you want to modify the lookof the concept linkwhen it is in a certain
state (e.g., when it has focusor when the cursor is hovering over it).

5. From theShowdrop-down list on the upper-right side of the editor, select . This displaysonly
the properties that have been set for that particular style. You can also select to display properties alphabetically,
in groups, and according to themost relevant properties

6. From theProperties section, click in the cell on the right to change values for anyof the style's properties.

7. Click to save your work.
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RULES

Keep inmind the following ruleswhen working with these typesof styles.

FONT COLOR ON LINK STYLES ONLY

You can set manydifferent properties on Help controls. However, font color can be set only on styles that deal specifically
with links (e.g., <a>, helpControlListItemLink, conceptLinkControlListItemLink).

E X A M P L E

Let's say you want to use red on concept links. You can set that color on
MadCap|conceptLinkControlListItemLink, because it controls the links specifically. But if you set the color on
MadCap|conceptLinkControlList or MadCap|conceptLinkControlListItem, the color setting will have no effect
because those styles dealwith lists and list items, not links.

INHERITANCE FROM MAIN LIST AND LINK STYLES

Because these Help control styles are based on themain styles for unnumbered lists (<ul>), list items (<li>), and hyperlinks
(<a>), they inherit properties from those standard styles.

E X A M P L E

Let's say you set a purple font on the <a> style. If you do not make any changes to your Help control styles, all of
the linkswill use a purple font. But suppose you want concept links to use a green font instead. In that case, you
can set the MadCap|conceptLinkControlListItemLink style to green. If you do that, regular text hyperlinks,
keyword links, and related topic linkswill all display in purple, but concept linkswill display in green.

Note: If setting a property on the <a> style doesnot seem to have an effect on the Help control links, check the
heading style. For example, if you set purple on the <a> style but MadCap|conceptLinkhasblue, then
MadCap|conceptLinkControlListItemLinkwill use blue. That's because MadCap|conceptLinkoverrules<a>.
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INHERITANCE FROM GENERAL HELP CONTROL STYLES

Because the general "helpControl" styles (helpControlList, helpControlListItem, helpControlListItemLink) are used to
determine the lookof all three typesof Help control links, themore specific styles (e.g., conceptLinkControl, keyword-
linkControl, relatedTopicsConrol) inherit properties from them.

E X A M P L E

Let's say you set a 12-pt font on theMadCap|helpControlListItem style. If you do not make changes to anyof the
more specific styles (MadCap|conceptLinkControlListItem,MadCap|keywordLinkControlListItem,MadCap|re-
latedTopicsControlListItem), all of themwill use a 12-pt font. But suppose you want concept links to use a 14-pt
font instead. In that case, you can set theMadCap|conceptLinkControlListItem style to 14 pt. If you do that,
keyword links and related topic linkswill display in 12 pt, but concept linkswill display in 14 pt.

NO INHERITANCE BETWEEN SPECIFIC STYLES

Asshown, there is inheritance frommain styles (e.g., <a>, <li>) and from the general "helpControl" styles. That's because
themain styles are at a higher level than all of the Help control link styles, and the general "helpControl" styles are at a
higher level than themore specific styles. But all of the specificHelp control styles are at the same level; therefore, none of
them inherit properties from anyof the others.

E X A M P L E

Let's say you set a 10-pt font on theMadCap|keywordLinkControlList style (which controlsentire lists for
keyword links). Neither theMadCap|keywordLinkControlListItem style nor theMadCap|keywordLinkCon-
trolListItemLink style will inherit that font size. Instead, theMadCap|keywordLinkControlListItem style (which con-
trols list items for keyword links) will either inherit from <li> or MadCap|helpControlListItem. And
MadCap|keywordLinkControlListItemLink (which controls the actual links for keywords) will either inherit
from <a>or MadCap|helpControlListItemLink. Or you can set different colors on those styles specifically.
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The following diagram showshow inheritance and precedence workswith Help control styles. In this example, concept link
styles are shown. But the same type of structure applies to keyword and related topic links aswell. The arrowsshow inher-
itance. The numbers show precedence; in other words, if multiple styles have different settings for the same property, the
style with a lower number hasprecedence over those with higher numbers.
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Creating a List of Concepts
You can use the concepts proxy to generate a list of all of the concepts in your project, with links to the corresponding con-
tent.When you generate the output, the proxy is replaced with a list of the paragraph text found wherever a concept has
been inserted.

HOW TO CREATE A LIST OF CONCEPTS

1. Add a new topic as you normallywould.

2. At the top of the topic, enter a title for your list (e.g., "List of Concepts").

3. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In theProxy section selectProxy>Concepts Proxy.

Menu Select Insert>Proxy>Insert Concepts Proxy.

The ConceptsProxydialog opens.

4. (Optional) In theStylesheet class for proxy field, you can select a class to affect the lookof the entire list.

Youmight create and use a proxy style class, for example, if you want to add a border around the generated list. If
you do not select a class from this field, the generated list will use the style settings from the parent <MadCap|-
conceptsProxy> style. You have the option of creating a class for this proxy style in the Stylesheet Editor. To do
this, select theMadCap|conceptsProxy style and clickAdd Class to create a class. The classwill then be avail-
able from this field. For more information see the online Help or the FlareStylesGuide.

5. ClickOK. The proxy is added to the topic.

6. Click to save your work.
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Using Styles to Determine the Look of a List of Concepts
After you use the concepts proxy to create a list of concepts, you can change the lookof that list by using styles. You can
modify the lookof individual entries in the list, aswell as the entire container.

HOW TO DETERMINE THE LOOK OF A LIST OF CONCEPTS (ENTIRE CONTAINER)

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Advanced view is cur-

rently shown in the editor). If the button displays instead, then click it.

3. In the upper-left corner of the editor, make sure theShow Styles field is set to .

4. In the Styles section of the editor, scroll down and select theMadCap|ConceptsProxy style or a class that you
have created under it (e.g., MadCap|ConceptsProxy.myclass).

5. From theShowdrop-down list on the upper-right side of the editor, select .

6. In theProperties section to the right, expand a property group (e.g., Font, Block, Box) to see the actual prop-
ertieswithin it.

7. Locate the specific property that you want to change. The property name is shown in the left column. Use the right
column to select and enter values for the property. Depending on the type of property, you can either type the
value, select it from a drop-down list, or complete the value entries in a popup box.

For example, if you want to change the width of the entire list of concepts, you would first expand theBox prop-
erty group. Then you would click in the cell to the right of thewidth property and set the value.

Another example would involve adding headings to a list of concepts. You would expand theUnclassified prop-
erty group and click the mc-concepts-list-headings property to enable or disable concept list headings.

8. Click to save your work.
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HOW TO DETERMINE THE LOOK OF A LIST OF CONCEPTS (INDIVIDUAL ENTRIES)

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Advanced view is cur-

rently shown in the editor). If the button displays instead, then click it.

3. In the upper-left corner of the editor, make sure theShow Styles field is set to .

4. In the Styles section of the editor, expand the p style.

5. In the list of classesunder the <p> tag, select either of the following:

Concept Select this class to control the lookof the concept termsdisplayed in the generated list.

ConceptContext Select this class to control the lookof the text associated with each concept term in the
generated list.

Note: The page numbers in the generated list inherit their style settings from the list itemsbefore
them. However, if you want the page numbers to lookdifferently, you canmodify theMadCap|xre-
f.ConceptPageNumber style.

6. From theShowdrop-down list on the upper-right side of the editor, select .

7. In theProperties section to the right, expand a property group (e.g., Font, Block, Box) to see the actual prop-
ertieswithin it.
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8. Locate the specific property that you want to change. The property name is shown in the left column. Use the right
column to select and enter values for the property. Depending on the type of property, you can either type the
value, select it from a drop-down list, or complete the value entries in a popup box. Here are some of themore
common properties that youmight change:

Alignment of Page Number (Print Output) To change the alignment (left, right, center) of the page
number, expand theUnclassified property group. Then click in the right column next tomc-leader-align
and select the type of alignment.

Font Family To change the font family (e.g., Arial, Verdana), expand the Font property group. Click in
the right column next to font-family, set the font family in the Font FamilyPicker dialog, and clickOK.

Font Size To change the font size (e.g., 10 pt, 11 pt), expand the Font property group. Then click in the
right column next to font-size, set the font size in the small drop-downwindow, and clickOK.

Leader Format (Print Output) To change the format of the area between the item in the list and the
page number, expand theUnclassified property group. Then click in the right column next tomc-leader-
format and type the character to use. For example, if you want a series of dots, type a period. If you do not
want to use a leader format, leave this field blank.

Note: For Word output, you can enter one character only (period, hyphen, or underscore). For
FrameMaker, you can specify a combination of characters and spaces, which repeat between
the text and page number.

Leader Space Before/After (Print Output) Expand theUnclassified property group. To change the
distance from the end of the list entry to the start of the leader, click in the right column next tomc-leader-
indent, set themargin value in the small drop-downwindow, and clickOK. To change the distance
between the end of the leader and the page number, click in the right column next tomc-leader-offset, set
themargin value in the small drop-downwindow, and clickOK.

Padding Above To change the amount of empty space (padding) above the item in the list, expand the
Box property group. Then click in the right column next to padding-top, set the padding value in the small
drop-downwindow, and clickOK. You can also use the other cells in this property group to add padding
below, to the left, or to the right.

Space in Front (Indentation) To change the distance from the left pagemargin to the beginning of the
item in the list, expand theBox property group. Then click in the right column next tomargin-left, set the
margin value in the small drop-downwindow, and clickOK. You can specify additional indentation for head-
ings that wrap tomore than one line. To do this, expand theUnclassified property group. Then click in the

182



right column next tomc-multiline-indent, set themargin value in the small drop-downwindow, and click
OK.

9. Click to save your work.
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Deleting Concepts
If necessary, you can delete concepts that you have inserted into acontent file (e.g., topic, snippet) . You can do this from
the Concept window pane or from a specific file. The advantage of using the Concept window pane is that you can delete
concept keywords from all topics in one step.

HOW TO DELETE A CONCEPT FROM THE CONCEPT WINDOW PANE

1. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select theView ribbon. In theReference section selectConcept Window.

Menu SelectView>Concept Window.

Keyboard Shortcut PressSHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Termsarea at the top and the
Explorer area at the bottom. If you want to seemore or lessof either section, you can click the splitter
between them and drag it up or down.

2. In the explorer area at the bottom of the window pane, right-click on the concept keyword that you want to delete.
From the context menu selectRemove Keyword.The keyword is removed from all topicswhere it had been
inserted.

Note: If you want to delete a keyword from the Termsarea of the Concept window pane, click on the rect-
angular area to the left of the concept keyword (on the area with the arrow ) and pressDelete on your key-
board.
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HOW TO DELETE A CONCEPT FROM A SPECIFIC FILE

1. Open the content file (e.g., topic, snippet).

2. In the editor right-click the concept marker that you want to delete.

3. From the context menu, selectDelete. The concept marker is removed from the topic.

4. Click to save your work.
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Deleting Concept Links
There are two parts to a concept link—(1) the concept link itself and (2) the concepts inserted into topics that associate the
topicwith a particular concept link. The following steps show you how to delete the concept link.

HOW TO DELETE A CONCEPT LINK FROM A TOPIC

If you no longer need a concept link that you have previously inserted into a topic, you can easily delete it from a topic.

1. Open the content file (e.g., topic, snippet).

2. Right-click the concept link that you want to delete.

3. From the context menu, selectDelete. The concept link is removed from the topic.

4. Click to save your work.
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Related Topics Links

This feature is supported in all online outputs (DotNet Help, Eclipse Help, Microsoft
HTMLHelp, HTML5,WebHelp,WebHelp AIR,WebHelpMobile, andWebHelp Plus).

A related topics link lets users open topics that you've determined are related to the current
topic. This is similar to a concept link. You should use a related topics link if you are applying it
to a topic that you want to associate with specific topics but you do not plan to reuse the same
link in other topics.

This chapter discusses the following:

Inserting Related Topics Links 188

Editing Related Topics Links 197

Deleting Related Topics Links 203



Inserting Related Topics Links
There are a couple of methods to use for inserting related topics links. You can use the "drag-and-drop" method or the
"Insert ribbon" method.

HOW TO INSERT A RELATED TOPICS LINK INTO A TOPIC USING DRAG-AND-DROP

1. Open the content file (e.g., topic, snippet).

2. In the Content Explorer, click theShow Files button . The Content Explorer splits into two halves.

3. On the left half of the Content Explorer, locate and select the folder containing the topics to be included in the
related topics link.

4. On the right half of the Content Explorer, select the topics to be included in the link. You can hold down the CTRL
or Shift keyand click the topic file names to select individual topics or a range of topics.

5. Drag the selected files to the appropriate location in the topic in the XMLEditor. As you drag the files, a colored ver-
tical bar showsyou where the linkwill be inserted when you releasemouse button.

6. Release themouse button. The Insert Related TopicsControl dialog opens. The folders and topic files available in
the project are shown on the left. The files that you selected are automatically added to the section on the right.

7. (Optional) You can customize the related topics link in anyof the following ways.

BOOKMARK

If you want a link to point to a particular bookmarkwithin a topic, do the following.

a. In theSelected Topics area on the right of the dialog, click on the relevant topic.

b. At the bottom of the dialog click .

c. In the Select Bookmarkdialog, click on a heading or bookmarkwithin the topic. If you select a heading, a
bookmarkwill be created at that spot in the topic.

Note: If you want to remove a bookmark from the link, you can select the bookmark in this dia-
log and click . This removes the bookmark from the link only; it doesnot remove the book-
mark from the destination topic.

d. ClickOK.
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STYLE CLASS

If you want to select the style class to be used for the control, do the following.

a. At the bottom of the dialog click .

b. In the dialog, click on the style class you want to use. Themain style is "MadCap:relatedTopics," but if you
create a classunder that style in your stylesheet, it will be available for selection aswell.

c. ClickOK.

LABEL

If you want to change the text shown on the control, do the following.

a. At the bottom of the dialog click .

b. In the dialog, enter text in the Label field.

c. ClickOK.

POPUP MENU OR LIST

If you want to specify that the links should be displayed in a popupmenu (default) or asa simple list, do the fol-
lowing.

a. At the bottom of the dialog click .

b. In the dialog, click the down arrow in theDisplay topics in field and selectPopup Menu or List.

c. ClickOK.

Note: For projects that aremerged, the list option is supported for standardmerging (e.g., linking to
an FLPRJ file in the table of contents). However, it is not supported for automerging inWebHelp Plus
output.
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TARGET FRAME

If you want to choose the type of frame used when the link is clicked, do the following.

a. At the bottom of the dialog click .

b. In the dialog, click the down arrow in the Target Frame field and select anyof the following.

(default) The destination file will open in the samewindow as the output window.

Parent Frame_parent The destination file will open in the parent frame of the current topicwhile
hiding that topic.

New Window_blank The destination file will open in a new browser window.

Same Frame_self The destination file will open in the samewindow frame as the current topic.

Top Frame_top The destination file will open in the same output window, removing all other
framesets. Youmight use this option, for example, if the destination topic has its own frameset.

Popup Window The destination file will open in a popup boxon top of the current topic.

c. ClickOK.

CUSTOM ORDER

If you want to specify that the links should be displayed in a custom order (rather than alphabetically), do the fol-
lowing.

a. In theSelected Topics area on the right of the dialog, click on a topic that you want to move up or down.

b. At the bottom of the dialog click or .

c. Click in theUse Custom Ordering field and selectYes.

Note: Custom ordering is not supported in DotNet Help output.

8. ClickOK. The related topics control is added to the topic.
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9. Click to save your work.
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HOW TO INSERT A RELATED TOPICS LINK INTO A TOPIC USING THE INSERT RIBBON OR MENU

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, click in the topicwhere you want to insert the link (usually at the bottom of the topic).

3. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In theHelp Control section, selectRelated Topics Control.

Menu Select Insert>Help Control>Related Topics Control.

The Insert Related TopicsControl dialog opens. The folders and topic files available in the project are shown on
the left.

4. On the left side of the dialog, either double-click a topic that you want to add to the related topics control, or select
the topic and click . After doing this, the topic is added to the Selected Topics area on the right side of the dialog.

You can use the "multi-view" to locate topics.
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Showsall of the files in the project in a list in the area below. If you click the button again, it switches to a
folder tree view. In the list, you can click the File, Type, or Path column headers to sort the list alpha-
betically by that column data.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the area
splits into two halves. The folder is shown on the left side, and the files and subfolderswithin it are shown
on the right.

If the Show Files button is the only one selected, you can click this button tomove up one folder level.

5. (Optional) You can customize the related topics link in anyof the following ways.

BOOKMARK

If you want a link to point to a particular bookmarkwithin a topic, do the following.

a. In theSelected Topics area on the right of the dialog, click on the relevant topic.

b. At the bottom of the dialog click .

c. In the Select Bookmarkdialog, click on a heading or bookmarkwithin the topic. If you select a heading, a
bookmarkwill be created at that spot in the topic.

Note: If you want to remove a bookmark from the link, you can select the bookmark in this dia-
log and click . This removes the bookmark from the link only; it doesnot remove the book-
mark from the destination topic.

d. ClickOK.

STYLE CLASS

If you want to select the style class to be used for the control, do the following.

a. At the bottom of the dialog click .

b. In the dialog, click on the style class you want to use. Themain style is "MadCap:relatedTopics," but if you
create a classunder that style in your stylesheet, it will be available for selection aswell.

c. ClickOK.
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LABEL

If you want to change the text shown on the control, do the following.

a. At the bottom of the dialog click .

b. In the dialog, enter text in the Label field.

c. ClickOK.

POPUP MENU OR LIST

If you want to specify that the links should be displayed in a popupmenu (default) or asa simple list, do the fol-
lowing.

a. At the bottom of the dialog click .

b. In the dialog, click the down arrow in theDisplay topics in field and selectPopup Menu or List.

c. ClickOK.

Note: For projects that aremerged, the list option is supported for standardmerging (e.g., linking to
an FLPRJ file in the TOC). However, it is not supported for automerging inWebHelp Plusoutput.

TARGET FRAME

If you want to choose the type of frame used when the link is clicked, do the following.

a. At the bottom of the dialog click .

b. In the dialog, click the down arrow in the Target Frame field and select anyof the following.

(default) The destination file will open in the samewindow as the output window.

Parent Frame_parent The destination file will open in the parent frame of the current topicwhile
hiding that topic.

New Window_blank The destination file will open in a new browser window.

Same Frame_self The destination file will open in the samewindow frame as the current topic.

Top Frame_top The destination file will open in the same output window, removing all other
framesets. Youmight use this option, for example, if the destination topic has its own frameset.

Popup Window The destination file will open in a popup boxon top of the current topic.

c. ClickOK.
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CUSTOM ORDER

If you want to specify that the links should be displayed in a custom order (rather than alphabetically), do the fol-
lowing.

a. In theSelected Topics area on the right of the dialog, click on a topic that you want to move up or down.

b. At the bottom of the dialog click or .

c. Click in theUse Custom Ordering field and selectYes.

Note: Custom ordering is not supported in DotNet Help output.

6. ClickOK. The related topics control is added to the topic.

7. Click to save your work.

Note: When people click a link like this in the output, the text shown for each of the topics dependson whether
the topic in question hasa title or heading. The title set in the Properties dialog has the highest level of pre-
cedence. If there is no topic title specified in the Properties dialog, Flare uses text associated with <h1> through
<h6>heading styles. If there is no topic title or headings in a topic, Flare uses the topic file name.
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Editing Related Topics Links
You can edit a related topics link that you have inserted into a topic.

HOW TO CHANGE THE TOPICS ASSOCIATED WITH A RELATED TOPICS CONTROL

The first way to edit a related topics control is to change the topics associated with it.

E X A M P L E

Let's say you have a related topics link that has five topics associated with it. Youmight then create a new topic,
which you decide should be included in the link aswell. The stepsbelow show you how to edit the related topics
link to add that new topic to the link.

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, right-click the related topics link.

3. In the context menu, selectEdit Related Topics Control. The Insert Related TopicsControl dialog opens. The
topics currently associated with the link are listed on the right side of the dialog. All of the content files and folders in
your project can be viewed on the left side of the dialog.

4. On the left side of the dialog, either double-click a topic that you want to add to the related topics control, or select
the topic and click . After doing this, the topic is added to the Selected Topics area on the right side of the dialog.

You can use the "multi-view" to locate topics.

Showsall of the files in the project in a list in the area below. If you click the button again, it switches to a
folder tree view. In the list, you can click the File, Type, or Path column headers to sort the list alpha-
betically by that column data.

Showsor hides the folders that the files are stored in.

Showsor hides the files. If you click this button when the Show Folders button is selected, the area
splits into two halves. The folder is shown on the left side, and the files and subfolderswithin it are shown
on the right.

If the Show Files button is the only one selected, you can click this button tomove up one folder level.

5. If you want to remove a topic from the link, click on that topic on the right side of the dialog. Then click .

6. ClickOK. The Insert Related TopicsControl dialog closes, and the link is now changed.

7. Click to save your work.
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HOW TO CHANGE THE OPTIONS FOR A RELATED TOPICS CONTROL

You can change the options for a related topics control, modifying elements such as the control label or the way the links
are presented (e.g., popupmenu or list).

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, right-click the related topics link.

3. In the context menu, selectEdit Related Topics Control. The Insert Related TopicsControl dialog opens. The
topics currently associated with the link are listed on the right side of the dialog. All of the content files and folders in
your project can be viewed on the left side of the dialog.

4. You can customize the related topics link in anyof the following ways.

BOOKMARK (ADD)

If you want a link to point to a particular bookmarkwithin a topic, do the following.

a. In theSelected Topics area on the right of the dialog, click on the relevant topic.

b. At the bottom of the dialog click .

c. In the Select Bookmarkdialog, click on a heading or bookmarkwithin the topic. If you select a heading, a
bookmarkwill be created at that spot in the topic.

Note: If you want to remove a bookmark from the link, you can select the bookmark in this dia-
log and click . This removes the bookmark from the link only; it doesnot remove the book-
mark from the destination topic.

d. ClickOK.

STYLE CLASS

If you want to select the style class to be used for the control, do the following.

a. At the bottom of the dialog click .

b. In the dialog, click on the style class you want to use. Themain style is "MadCap:relatedTopics," but if you
create a classunder that style in your stylesheet, it will be available for selection aswell.

c. ClickOK.

If you want to edit the actual style in the stylesheet, see the set of stepsbelow.
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LABEL

If you want to change the text shown on the control, do the following.

a. At the bottom of the dialog click .

b. In the dialog, enter text in the Label field.

c. ClickOK.

POPUP MENU OR LIST

If you want to specify that the links should be displayed in a popupmenu (default) or asa simple list, do the fol-
lowing.

a. At the bottom of the dialog click .

b. In the dialog, click the down arrow in theDisplay topics in field and selectPopup Menu or List.

c. ClickOK.

Note: For projects that aremerged, the list option is supported for standardmerging (e.g., linking to
an FLPRJ file in the table of contents). However, it is not supported for automerging inWebHelp Plus
output.

TARGET FRAME

If you want to choose the type of frame used when the link is clicked, do the following.

a. At the bottom of the dialog click .

b. In the Related Topics LinkOptionsdialog, click the down arrow in the Target Frame field and select anyof
the following.

(default) The destination file will open in the samewindow as the output window.

Parent Frame_parent The destination file will open in the parent frame of the current topicwhile
hiding that topic.

New Window_blank The destination file will open in a new browser window.

Same Frame_self The destination file will open in the samewindow frame as the current topic.

Top Frame_top The destination file will open in the same output window, removing all other
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framesets. Youmight use this option, for example, if the destination topic has its own frameset.

Popup Window The destination file will open in a popup boxon top of the current topic.

c. ClickOK.

CUSTOM ORDER

If you want to specify that the links should be displayed in a custom order (rather than alphabetically), do the fol-
lowing.

a. In theSelected Topics area on the right of the dialog, click on a topic that you want to move up or down.

b. At the bottom of the dialog click or .

c. Click in theUse Custom Ordering field and selectYes.

Note: Custom ordering is not supported in DotNet Help output.

5. ClickOK.

6. Click to save your work.
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HOW TO EDIT THE STYLE OF A RELATED TOPICS CONTROL

You can edit the style of a related topics link.When you do this, the style changes for all related topics links in any topics in
your project. Also, keep inmind the various rules that pertain to related topic links.

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Advanced view is cur-

rently shown in the editor). If the button displays instead, then click it.

Note: For stepsusing the Simplified View, see the online Help.

3. In the upper-left corner of the editor, click in theShow Styles field and selectShow Link Styles or Show
Dynamic Effects Styles. Different styles are displayed with each filter.

4. In theStyles section on the left side of the editor, find and select one of the following styles, depending on what
you want to accomplish. You can use a general style (which startswith "helpControl") if you want to modify all
typesof Help control links (concept, keyword, and related topic links). Alternatively, you can use a specific style
(which startswith "relatedTopics") if you want to modify only concept links in your project.

MadCap|helpControlList Edit this style to change the lookof the entire list (<ul> element) when linksare
displayed in a list, rather than in a popup.

MadCap|helpControlListItem Edit this style to change the lookof individual items in the list (<li> ele-
ments) when linksare displayed in a list, rather than in a popup.

MadCap|helpControlListItemLink Edit this style to change the lookof links in the list (<a> elements)
when linksare displayed in a list, rather than in a popup.

MadCap|helpControlMenu Edit this style to change the lookof links (i.e., menu items) when linksare dis-
played in a popup, rather than in a list. This particular style controls the entire list.

MadCap|helpControlMenuItem Edit this style to change the lookof links (i.e., menu items) when links
are displayed in a popup, rather than in a list. This particular style controls the individual list items.

MadCap|relatedTopics Edit this style to change the lookof the heading for related topic links. The fol-
lowing three related topic link styles inherit properties from this style.

MadCap|relatedTopicsControlList Edit this style to change the lookof the entire list (<ul> element)
when related topics are displayed in a list, rather than in a popup.

MadCap|relatedTopicsControlListItem Edit this style to change the lookof individual items in the list
(<li> elements) when related topics are displayed in a list, rather than in a popup.

MadCap|relatedTopicsControlListItemLink Edit this style to change the lookof links in the list (<a> ele-
ments) when related topics are displayed in a list, rather than in a popup.
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Note: You can also change a pseudo classof a link style (e.g.,MadCap|relatedTopics.focus or
MadCap|relatedTopics.hover) if you want to modify the lookof the related topic linkwhen it is in a
certain state (e.g., when it has focusor when the cursor is hovering over it).

5. From theShowdrop-down list on the upper-right side of the editor, select . The
most relevant properties for that style are shown on the right side of the editor.

6. From theProperties section, change values for anyof the style's properties.

7. Click to save your work.
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Deleting Related Topics Links
If you no longer need a related topics link that you have previously inserted into a topic, you can delete it from a topic.

HOW TO DELETE A RELATED TOPICS LINK FROM A TOPIC

1. Open the content file (e.g., topic, snippet).

2. Right-click the related topics link that you want to delete.

3. From the context menu, selectDelete. The related topics link is removed from the topic.

4. Click to save your work.
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17
Keyword Links

This feature is supported in all online outputs (DotNet Help, Eclipse Help, Microsoft
HTMLHelp, HTML5,WebHelp,WebHelp AIR,WebHelpMobile, andWebHelp Plus).

A keyword link lets users open topics that are related to the current topic based on the index
keywords that they share.

This chapter discusses the following:

Inserting Keyword Links 206

Editing Keyword Links 209

Deleting Keyword Links 213



Inserting Keyword Links
Following are steps for inserting a keyword link.

HOW TO INSERT A KEYWORD LINK

1. Insert index keywords into the appropriate files.

2. Open the content file (e.g., topic, snippet).

3. In the XMLEditor, click in the topicwhere you want to insert the link (usually at the bottom of the topic).

4. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In theHelp Control section, selectKeyword Link Control (K-link).

You can use theOptionsdialog to switch between ribbonsand the classic tool strip layout. For more inform-
ation see the online Help.

Keep inmind that the smaller the application window becomes, themore the options in a ribbon shrink.
Therefore, youmight only see a small icon instead of text, or youmight see only a section name displayed
with a down arrow to access the options in it. You can hover over small icons to see tooltips that describe
them. You can also enlarge the application window or click one of the section drop-downs in the ribbon to
locate a hidden feature.

Menu Select Insert>Help Control>Keyword Link Control (K-link).

The Insert Keyword LinkControl dialog opens. The index keywords that you have inserted into topics are listed on
the left side of the dialog.

5. Do one of the following:

In theAll Keywords section, double-click an index keyword that you want to add to the keyword link.

OR

In theAll Keywords section, click on an index keyword that you want to add to the keyword link. Then click
.

The index keyword is added to the "All Keywords" section on the right side of the dialog. Do this for each
index keyword that you want to add to the link.
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6. (Optional) If you want to specify other options for the control, click and in the dialog select anyof the following.
ClickOK to close the dialog when you are finished:

Style Class You can select the style class to be used for the control.

Label You can change the text shown on the control.

Display topics in You can specify that the links should be displayed in a popupmenu (same asdefault) or
asa simple list.

Note: For projects that aremerged, the list option is supported for standardmerging (e.g., link-
ing to an FLPRJ file in the table of contents). However, it is not supported for automerging in
WebHelp Plusoutput.

Target Frame You can choose the type of frame used when a link is clicked.

(default) The destination file will open in the samewindow as the output window.

Parent Frame_parent The destination file will open in the parent frame of the current topicwhile
hiding that topic.

New Window_blank The destination file will open in a new browser window.

Same Frame_self The destination file will open in the samewindow frame as the current topic.

Top Frame_top The destination file will open in the same output window, removing all other
framesets. Youmight use this option, for example, if the destination topic has its own frameset.

Popup Window The destination file will open in a popup boxon top of the current topic.
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7. ClickOK. The keyword link is added to the topic.

8. Click to save your work.
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Editing Keyword Links
You can edit a keyword link that you have inserted into a topic.

HOW TO CHANGE THE KEYWORDS ASSOCIATED WITH A KEYWORD LINK

The first way to edit a keyword link is to change the keyword(s) associated with the link, aswell as specify variousother
optional settings.

E X A M P L E

Let's say you have a keyword link that has two keywords ("Projects" and "Systems") associated with it. Youmight
want to remove the "Projects" keyword from the link so that it only contains the "Systems" keyword. The steps
below show you how to do this.

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, right-click the keyword link.

3. In the context menu, selectEdit Keyword Link. The Insert Keyword LinkControl dialog opens. The keywords
currently associated with the link are listed on the right side of the dialog. The keywords that you have inserted into
all other topics are listed on the left side of the dialog.

4. If you want to add a keyword to the link, click on that keyword on the left (All Keywords) side of the dialog. Then
click . If you want to remove a keyword from the link, click on that keyword on the right (Selected Keywords)
side of the dialog. Then click .

Repeat this for each keyword that you want to add to or remove from the link.When you are finished, the
keywordsassociated with the link should be in the Selected Keywords section, and the keywordsnot associated
with the link should be in the All Keywords section.
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5. (Optional) If you want to specify other options for the control, click and in the dialog select anyof the following.
ClickOK to close the dialog when you are finished:

Style Class You can select the style class to be used for the control.

Label You can change the text shown on the control.

Display topics in You can specify that the links should be displayed in a popupmenu (same asdefault) or
asa simple list.

Note: For projects that aremerged, the list option is supported for standardmerging (e.g., link-
ing to an FLPRJ file in the table of contents). However, it is not supported for automerging in
WebHelp Plusoutput.

Target FrameYou can choose the type of frame used when a link is clicked:

(default) The destination file will open in the samewindow as the output window.

Parent Frame_parent The destination file will open in the parent frame of the current topicwhile
hiding that topic.

New Window_blank The destination file will open in a new browser window.

Same Frame_self The destination file will open in the samewindow frame as the current topic.

Top Frame_top The destination file will open in the same output window, removing all other
framesets. Youmight use this option, for example, if the destination topic has its own frameset.

Popup Window The destination file will open in a popup boxon top of the current topic.

6. ClickOK. The Insert Keyword LinkControl dialog closes, and the link is now changed.

7. Click to save your work.
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HOW TO EDIT THE STYLE OF A KEYWORD LINK

You can edit the style of a keyword link.When you do this, the style changes for all keyword links in any topics in your pro-
ject. Also, keep inmind the various rules that pertain to keyword links.

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Advanced view is cur-

rently shown in the editor). If the button displays instead, then click it.

Note: For stepsusing the Simplified View, see the online Help.

3. In the upper-left corner of the editor, click in theShow Styles field and selectShow Link Styles or Show
Dynamic Effects Styles. Different styles are displayed with each filter.

4. In theStyles section on the left side of the editor, find and select one of the following styles, depending on what
you want to accomplish. You can use a general style (which startswith "helpControl") if you want to modify all
typesof Help control links (concept, keyword, and related topic links). Alternatively, you can use a specific style
(which startswith "keywordLink") if you want to modify only concept links in your project.

MadCap|helpControlList Edit this style to change the lookof the entire list (<ul> element) when linksare
displayed in a list, rather than in a popup.

MadCap|helpControlListItem Edit this style to change the lookof individual items in the list (<li> ele-
ments) when linksare displayed in a list, rather than in a popup.

MadCap|helpControlListItemLink Edit this style to change the lookof links in the list (<a> elements)
when linksare displayed in a list, rather than in a popup.

MadCap|helpControlMenu Edit this style to change the lookof links (i.e., menu items) when linksare dis-
played in a popup, rather than in a list. This particular style controls the entire list.

MadCap|helpControlMenuItem Edit this style to change the lookof links (i.e., menu items) when links
are displayed in a popup, rather than in a list. This particular style controls the individual list items.

MadCap|keywordLink Edit this style to change the lookof the heading for keyword links. The following
three keyword link styles inherit properties from this style.

MadCap|keywordLinkControlList Edit this style to change the lookof the entire list (<ul> element) when
keyword links are displayed in a list, rather than in a popup.

MadCap|keywordLinkControlListItem Edit this style to change the lookof individual items in the list (<li>
elements) when keyword links are displayed in a list, rather than in a popup.

MadCap|keywordLinkControlListItemLink Edit this style to change the lookof links in the list (<a> ele-
ments) when keyword links are displayed in a list, rather than in a popup.
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Note: You can also change a pseudo classof a link style (e.g.,MadCap|keywordLink.focus or
MadCap|keywordLink.hover) if you want to modify the lookof the keyword linkwhen it is in a certain
state (e.g., when it has focusor when the cursor is hovering over it).

5. From theShowdrop-down list on the upper-right side of the editor, select . This displaysonly
the properties that have been set for that particular style.

6. From theProperties section, change values for anyof the style's properties. For example, to change the link
label as described in the example above, you would edit the cell to the right ofmc-label.

7. Click to save your work.
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Deleting Keyword Links
There are two parts to a keyword link—(1) the keyword link itself and (2) the indexmarkers inserted into topics that asso-
ciate the topicwith a particular keyword link. The following steps show you how to delete both.

HOW TO DELETE A KEYWORD LINK FROM A TOPIC

If you no longer need a keyword link that you have previously inserted into a topic, you can delete it from a topic.

1. Open the content file (e.g., topic, snippet).

2. Right-click the keyword link that you want to delete.

3. From the context menu, selectDelete. The keyword link is removed from the topic.

4. Click to save your work.

HOW TO DELETE AN INDEX MARKER FROM A TOPIC

The following steps show you how to delete an indexmarker that you have previously inserted into a topic so that the topic
is no longer associated with a particular keyword link.

1. Open the content file (e.g., topic, snippet).

2. Right-click the indexmarker that you want to delete.

3. From the context menu, selectDelete. The indexmarker and its keywordsare removed from the topic.

4. Click to save your work.
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18
Relationship Links

This feature is supported in all outputs.

A relationship table is an element used to link related topics together. It is similar to concept
links or related topics links. Although a relationship table is a common feature in DITA, you do
not need to be using DITA or know anything about DITA in order to take advantage of rela-
tionship tables.

If you import content fromDITA files that already contain relationship tables, those tablesare
retained in Flare. You can also create new relationship tables in a Flare project and insert rela-
tionship proxies into individual topics. In online output, the end result is one or more hyperlinks
that let users quickly open related topics. In print-based output, the end result is one or more
references to related topicswith the appropriate page number(s).

This chapter discusses the following:

Relationship Table Components 217

Rules for Relationship Tables 226

Relationships Proxy 227

Benefits 230

Steps for Using Relationship Tables 231

Adding Relationship Tables 232

Opening Relationship Tables 233

Creating Relationship Tables 234



Inserting Relationship Links 245

Editing Relationship Link Styles 246

Associating Relationship Tables with Targets 256
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Relationship Table Components
Following are the basic components of a relationship table.

COLUMNS

Bydefault, a relationship table has three columns, each named after three basic topic types—Concept, Task, and Refer-
ence.

Concept Topics that contain basic information and descriptionsabout a subject.

Task Topics that provide step-by-step procedures for accomplishing something.

Reference Topics that provide detailed referencematerial.

If necessary, you can addmore columns to a relationship table, naming the other columnsanything you want.
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ROWS

You can havemany rows in a relationship table, with each cell containing one or more topic names, placed in the appro-
priate column. The relationshipsbetween the different topics are defined acrosseach row.

RELATIONSHIP LINKS

When you insert topic references into a row in a relationship table, those topicswill link to the other topics in the row in some
way.

Following are the typesof links that you can create.

Normal (default) This is a two-way link. In other words, a linkwill be displayed in each topic involved, and that link
will open the other topic.

Source Only This is a linkwhere the topic in question will have a link to other topics, but other topicswill not have
a link back to it.

Target Only This is a linkwhere the topic in question will not have a link to other topics, but other topicswill have a
link back to it.

Use CONREF Target This uses the conref attribute to pull content. The conref attribute referencesan ID on con-
tent that can be reused. For Flare outputs other than DITA, this option is not supported. For more detailed inform-
ation about DITA and the conref attribute, please refer towww.oasis-open.org/committees/dita/.

Unless you leave the default link setting, relationship links are identified bya blue background when you set them. To
identify the exact kind of relationship link applied to an item, you can select the item and then click the appropriate Prop-
erties button in the local toolbar.
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You can specify links on individual topic items, on cells (which can containmultiple items), or on entire columns.

Links on Items Each topic item in a relationship table can use a different kind of link.

Links on Cells If you apply a link type to a cell, all of the topic items in that cell will use that same setting (unless
you later override the setting on individual items).

Links on Columns If you apply a link type to a column, all of the topic items in all cellswill use that same setting
(unless you later override the setting on individual itemsor cells).
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GROUPS

You can group topics in the same cell so that they function asa unit or are related to one another.When you group items
together, you can choose a collection type to specify how the itemswithin the group behave.

Following are the collection types that you can use:

Unordered (default) This displays the grouped links in the output, but the order in which theyare displayed is
not important.

Family This lets you display links not only to adjacent topics in the row, but to other topics grouped within the same
cell aswell.

E X A M P L E

Let's say you have a row that is populated like this:

TopicA is in the "concept" cell.

TopicsB, C, and D are contained in a group in the "task" cell.

TopicE is in the "reference" cell.

Suppose you do not use the Family collection type. In that case, when a user opensTopicA, he will see
links to TopicsB, C, D, and E. However, when the user opensTopicC, he will see links to TopicA and
TopicE, but not to TopicsB and D.

Now suppose you do use the Family collection type. In that case, when a user opensTopicC, he will see
links not only to TopicsA and E, but to TopicsB and D aswell.

Sequence This displays linkswith significance given to how the linksare ordered in the output. For Flare outputs
other than DITA, this option is not supported. For more detailed information about DITA and the sequence
option, please refer towww.oasis-open.org/committees/dita/.

Choice This lets you specifywhich link should be "selected" or "highlighted" from the group of links. For Flare out-
puts other than DITA, this option is not supported. For more detailed information about DITA and the choice
option, please refer towww.oasis-open.org/committees/dita/.

Use CONREF Target This uses the conref attribute to pull content. The conref attribute referencesan ID on con-
tent that can be reused. For Flare outputs other than DITA, this option is not supported. For more detailed inform-
ation about DITA and the conref attribute, please refer towww.oasis-open.org/committees/dita/.

Unless you leave the default link setting, collection typesare identified bya green background when you set them. To
identify the exact kind of group applied, you can select the item and then click the appropriate Properties button in the local
toolbar.
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You can specify collection typeson individual items in a group or on entire columns:

Collection Types on Items in Groups Each group item in a relationship table can use a different kind of col-
lection type.

Collection Types on Columns If you apply a collection type to a column, all of the groups in that columnwill use
that same setting (unless you later override the setting on individual groups).
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CONDITION TAGS

Likemost everything else in Flare, you can apply condition tags to the elementswithin a relationship table. That iswhy you
see squaresnext to the elements. If you apply a condition tag to something (e.g., topic reference, group), the square will
display the color associated with that condition tag. You can show or hide the condition tags if you want.
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Rules for Relationship Tables
Following are some basic ruleswhen it comes to creating relationship tables:

Relationshipsare expressed within individual rowsonly. Relationshipsdo not exist between rows in a table.

Not every cell in a row needs to have a topic link.

Multiple topic links can be added to a single cell.

You can add the same topic link in manydifferent rows.
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Relationships Proxy
After you create at least one relationship table, you can insert a relationshipsproxy into the topicswhere you want the links
to appear in the output.When you build the output, the proxy is replaced by the generated links.
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Benefits
Follow are some of the primary benefits of using relationship links, asopposed to related topic links or concept links:

You can create all of your link information in one place, in a single relationship table.

You can havemultiple typesof links at the bottom of topics (e.g., one for "Related Information," one for "Related
Tasks," and one for "ReferenceMaterials").

In online output, the links are automatically represented ashyperlinks. In print-based output, the links are auto-
matically represented asa list of related topicswith page number references.
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Steps for Using Relationship Tables
Following are the basic steps for using relationship tables.

1. Add The first step in using a relationship table is to add a new file to the Advanced folder in the Project Organizer.
You can add asmany relationship table files as you need. Depending on your project, youmayneed just one rela-
tionship table or many. For example, youmight want to use Relationship Tables1 and 2 when generating Target
A, but youmight want to use Relationship Table 3 when generating Target B. See "Adding Relationship Tables"
on the next page.

2. Create After adding a relationship table file, you can create the actual content for it, adding relationshipsbetween
the topic links in a row. See "Creating Relationship Tables" on page 234.

3. Insert Links You can insert a relationshipsproxy in the topicswhere you want links to appear in the output, using
the information contained in your relationship table(s). See "Inserting Relationship Links" on page 245.

4. Edit Link Styles You can edit the lookof relationship links byadjusting the appropriate styles in your stylesheet.
Thismight involve changing the lookof anyof the following: the container holding the links, the heading(s) above
the links, the link items themselves. See "Editing Relationship LinkStyles" on page 246.

5. Associate With Target If you have created relationship tables in your project, you need to tell Flare which tables
to use for which targets. See "Associating Relationship Tableswith Targets" on page 256.
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Adding Relationship Tables
The first step in using a relationship table is to add a new file to the Advanced folder in the Project Organizer. You can add
asmany relationship table files as you need. Depending on your project, youmayneed just one relationship table or many.
For example, youmight want to use Relationship Tables1 and 2 when generating Target A, but youmight want to use
Relationship Table 3 when generating Target B.

HOW TO ADD A RELATIONSHIP TABLE FILE

1. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select theProject ribbon. In theContent section selectNew>Advanced>Relationship Table.

Menu SelectProject>Advanced>Add Relationship Table.

Right-Click In the Project Organizer, right-click on theAdvanced folder and from the context menu
selectAdd Relationship Table.

The Add File dialog opens.

2. In the File Type field at the top, make sureRelationship Table is selected.

3. In theSource area select one of the following:

New from template This lets you choose either the factory template file or one of your own customized
template files asa starting point. The new file will take on all of the settings contained in the template. If you
want to use the factory template provided byFlare, expand the Factory Templates folder and click on a
template file. If you want to use your own customized template file, expand the appropriate folder and click
on a file. For more information about templates, see the online Help.

Note: In some dialogsand wizards you can click theManage Templates button if you want
to open the TemplateManager. This lets youmanage anyof your template files (e.g., add new
templates, enter descriptions for templates). For more information see the online Help.

New from existing This lets you choose an existing file of the same type asa starting point for your new
file. Aswith template files, your new file will take on all of the settings contained in the file you select. To use
this option, click the browse button , use theOpen File dialog to find a file, and double-click it.

4. (Optional) If you want to place the file into a subfolder that you previously created in the Project Organizer, in the
Folder field click and select the subfolder. Otherwise, keep the default location.

5. In the File Name field, type a new name for the relationship table file.

6. ClickAdd. The relationship table file is added to the Advanced folder in the Project Organizer. The Relationship
Table Editor opens to the right.
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Opening Relationship Tables
After a relationship table file is added, you can open it at any time to work on it.

HOW TO OPEN A RELATIONSHIP TABLE

1. Make sure the Project Organizer is open.

2. Double-click theAdvanced folder.

3. Double-click the relationship table file. The Relationship Table Editor opens to the right.
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Creating Relationship Tables
After adding a relationship table file, you can create the actual content for it, adding relationshipsbetween the topic links in
a row.

HOW TO CREATE A RELATIONSHIP TABLE

1. Open the relationship table that you want to work on. The Relationship Table Editor opens to the right. If you do
not yet have a relationship table, see "Adding Relationship Tables" on page 232.

2. Use the editor to perform anyof the following tasks. Keep the following inmind as you work:

Relationshipsare expressed within individual rowsonly. Relationshipsdo not exist between rows in a table.

Not every cell in a row needs to have a topic link.

Multiple topic links can be added to a single cell.

You can add the same topic link in manydifferent rows.

For examples, see "Relationship Table Components" on page 217.

GIVE A ROW A NAME

This simply helps you distinguish one row from another.

a. Highlight a row.

b. In the local toolbar click .

c. In theRow Type field, enter a name.

d. ClickOK.
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INSERT A NEW ROW

In the local toolbar click .

RENAME A COLUMN

a. Highlight any cell in the column you want to rename.

b. In the local toolbar click to run the Column Properties dialog.

c. In theColumn Type field, enter a name.

d. ClickOK.
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INSERT A NEW COLUMN

In addition to the Row Name, a relationship table has three additional columns, each named after three basic
topic types—Concept, Task, and Reference. You can addmore columns if you want.

In the local toolbar click .

ADD A TOPIC ITEM TO A CELL

a. Click a cellwhere you want to insert a topic reference.

b. In the local toolbar click .

c. In the Open dialog, locate and double-click the topic. The topic file name is added to that cell. The square
next to the file name is used to show any condition tagsapplied to the link.
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SELECT THE LINK TYPE FOR A TOPIC ITEM, CELL, OR COLUMN

When you insert topic items into a row in a relationship table, those topicswill link to the other topics in the row in
someway. If you do not want to use the default type of link, you can select another kind. You can do this for indi-
vidual topic items, entire cells, or entire columns.

Links on Items Each topic item in a relationship table can use a different kind of link.

Links on Cells If you apply a link type to a cell, all of the topic items in that cell will use that same setting
(unless you later override the setting on individual items).

Links on Columns If you apply a link type to a column, all of the topic items in all cellswill use that same set-
ting (unless you later override the setting on individual itemsor cells).

Following are the steps for selecting link types.

a. Do one of the following:

For Columns Click in a column. In the local toolbar click .

OR

For Cells Click in a cell. In the local toolbar click .

OR

For Topic Link Items Click a topic link item in a cell. In the local toolbar click .

b. Click in the Linking field and select one of the following.

Source Only This is a linkwhere the topic in question will have a link to other topics, but other topics
will not have a link back to it.

Target Only This is a linkwhere the topic in question will not have a link to other topics, but other top-
icswill have a link back to it.

Normal (default) This is a two-way link. In other words, a linkwill be displayed in each topic
involved, and that linkwill open the other topic.

None This option indicates that the topic reference doesnot have a link.

Use CONREF Target This uses the conref attribute to pull content. The conref attribute references
an ID on content that can be reused. For Flare outputs other than DITA, this option is not supported.
For more detailed information about DITA and the conref attribute, please refer towww.oasis-
open.org/committees/dita/.

Unless you leave the default link setting, relationship links are identified bya blue background when you set
them. To identify the exact kind of relationship link applied to an item, you can select the item and then click
the appropriate Properties button in the local toolbar.
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c. ClickOK.
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GROUP SELECTED ITEMS

You can group topics in the same cell so that they function asa unit or are related to one another.When you group
items together, you can choose a collection type to specify how the itemswithin the group behave.

a. In a cell containingmultiple items (topic references), hold your CTRL keyand click the items that you want
to group.

b. In the local toolbar click . The word "Group" is added to the cell.
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SELECT THE COLLECTION TYPE FOR A COLUMN OR TOPIC LINK ITEM

When you put items into a group, you can specify how that group will function asa collection (e.g., in the images
above the group is using the "Family" collection type, whichmeans that those topic itemswill reference each other
in the output). You can do this for entire columnsor for individual topic items in a cell that have been grouped. If
you set a particular collection type on a column, all groups in that columnwill use that collection type.

a. Do one of the following:

For Columns Click in a column. In the local toolbar click .

For Topic Link Items Click a topic link item in a cell. In the local toolbar click .

b. Click in theCollection Type field and select one of the following:

Unordered (default) This displays the grouped links in the output, but the order in which theyare
displayed is not important.

Family This lets you display links not only to adjacent topics in the row, but to other topics grouped
within the same cell aswell.

E X A M P L E

Let's say you have a row that is populated like this:

TopicA is in the "concept" cell.

Topics, B, C, and D are contained in a group in the "task" cell.

TopicE is in the "reference" cell.

Suppose you DONOT use the Family collection type. In that case, when a user opens
TopicA, he will see links to TopicsB, C, D, and E. However, when the user opensTopicC,
he will see links to TopicA and TopicE, but not to TopicsB and D.

Now suppose you DOuse the Family collection type. In that case, when a user opensTopic
C, he will see links not only to TopicsA and E, but to TopicsB and D aswell.

Sequence This displays linkswith significance given to how the linksare ordered in the output. For
Flare outputs other than DITA, this option is not supported.

Choice This lets you specifywhich link should be "selected" or "highlighted" from the group of links.
For Flare outputs other than DITA, this option is not supported.
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Use CONREF Target This uses the conref attribute to pull content. The conref attribute references
an ID on content that can be reused. For Flare outputs other than DITA, this option is not supported.

Note: For more detailed information about DITA and these options, please refer to
www.oasis-open.org/committees/dita/.

c. ClickOK.

NEST ITEMS

After you add items to a cell, you can nest them byusing the left and right arrows. If an item is above and to the left
of other items, it becomes the parent; the child itemsare below and to the right of the parent.When this occurs,
the child items inherit the settings from the parent item (e.g., link type).

a. Click on a topic link in a cell that you want to move.

b. In the local toolbar, click to move it to the left, or click tomove it to the right.

MOVE ITEMS UP OR DOWN

If you havemultiple topic items in a cell, theyare displayed in the output in the order theyare shown. You can use
the up and down buttons to change the order.

a. Click the topic item that you want to move.

b. In the local toolbar click tomove the item up or tomove the item down.

DELETE A ROW

a. Click in the row you want to delete.

b. In the local toolbar click .

DELETE A COLUMN

a. Click in the column you want to delete.

b. In the local toolbar click .
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SHOW OR HIDE CONDITIONAL INDICATORS

In a relationship table, condition tagsare shown in the small squaresnext to topic file names. This feature can be
used to show or hide those squares.

In the local toolbar click .

3. Click to save your work.

Note: If there are anybroken links in a relationship table, theywill be identified by this icon: . You can then
open the properties for that item and fix the link.

Note: The three relationship link style classes in your stylesheet are designed to work in syncwith the column
headings in the Relationship Table Editor. Therefore, if you rename a column or create a custom column,
make sure that you create a corresponding style class in the stylesheet to control that column. For example, if
you create a custom columnwith a link type called "other," you should create a style class in the stylesheet
named "MadCap|relationshipsHeading.other." If you do not create a unique style class for the custom column,
it will use the settings from the parent MadCap|relationshipsHeading style. Therefore, the heading labelwill say
"Related Information," instead of what you want it to say.
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Inserting Relationship Links
You can insert a relationshipsproxy in the topicswhere you want links to appear in the output, using the information con-
tained in your relationship table(s).

HOW TO INSERT A RELATIONSHIP LINK

1. Open the content file (e.g., topic, snippet).

2. Place your cursor where you want to insert the link (usually at the bottom of the topic).

3. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In theProxy section selectProxy>Relationships Proxy.

Menu Select Insert>Proxy>Insert Relationships Proxy.

The RelationshipsProxydialog opens.

4. (Optional) In the field labeledStylesheet class for proxy, you can select a class to affect the lookof the rela-
tionship link.

Youmight create and use a proxy style class, for example, if you want to use a border special border above the
relationship links in the output. If you do not select a class from this field, the generated linkwill use the style set-
tings from the parent <MadCap|relationshipsProxy> style. You have the option of creating a class for this proxy
style in the Stylesheet Editor. To do this, select theMadCap|relationshipsProxy style and clickAdd Class to
create a class. The classwill then be available from this field.

5. ClickOK. The proxy is added to the topic.

6. Click to save your work.
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Editing Relationship Link Styles
You can edit the lookof relationship links byadjusting the appropriate styles in your stylesheet. Thismight involve changing
the lookof anyof the following: the container holding the links, the heading(s) above the links, the link items themselves.
The Simplified view of the Stylesheet Editor lets you edit only some of the necessary styles; for the rest of the styles, you
need to use the Advanced view.

E X A M P L E
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HOW TO EDIT THE CONTAINER

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Advanced view is cur-

rently shown in the editor). If the button displays instead, then click it.

Note: Some of the necessary style properties can also be changed in the Simplified view in the
Stylesheet Editor.

3. In the upper-left corner of the editor, click in theShow Styles field and select .

4. In the Styles section of the editor, select theMadCap|relationshipsProxy style.

5. From theShowdrop-down list on the upper-right side of the editor, select . The
most relevant properties for that style are shown on the right side of the editor.

6. Following are some of themore common tasks that youmaywant to perform:
BORDER PROPERTIES

Bydefault, a 1-pixel blackborder is already set, which separates the relationship links from the topic content
above. 

a. In theProperties section, expand theBorder group. The property name is shown in the left column. The
right column is used for selecting and entering values for the property.

b. Locate the border property that you want to change. Each side (bottom, left, right, top) has separate prop-
erties that you can set for the color, style, and width (e.g., border-bottom-style). You can set these prop-
erties individually, or you can set themain property for each side (e.g., border-bottom), which lets you
specify the color, style, and width in one place. Even better, if you plan to have the same settings for all four
sides, you can simply use the border property to set the color, style, and width all the wayaround. When
you click in the cell to the right of one of the broad properties (e.g., border, border-bottom), a small popup
displays.

i. Use the lower-left area of the popup to enter a number for the border thickness.

ii. Use the lower-middle area to select a unit of measurement (e.g., point, pixel, centimeter) for the
number you entered.

iii. Use the upper-right area to select a color for the border.
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iv. Use the lower-right area to select a line type (e.g., solid, double, dashed) for the border.

v. ClickOK.

MARGIN PROPERTIES

Bydefault, a 10-pixel topmargin is already set. Themargin is the space around the outside of the container.

a. In theProperties section, expand theBox group.

The property name is shown in the left column. The right column is used for selecting and entering values
for the property.

b. Locate themargin property that you want to change. Each side (bottom, left, right, top) has separate prop-
erties that you can set (e.g., margin-bottom,margin-left). However, if you plan to have the same settings
for all four sides, you can simply use themainmargin property to set the valuesall the wayaround.When
you click in the cell to the right of one of the properties (e.g., margin, margin-bottom), a small popup dis-
plays.

i. Use the lower-left area of the popup to enter a number for the amount of margin.

ii. Use the lower-right area to select a unit of measurement (e.g., point, pixel, centimeter) for the num-
ber you entered.

iii. ClickOK.

PADDING PROPERTIES

Bydefault, 20 pixels of padding are set on the left side of the container, and 10 pixels of padding are set on the top
side. The padding is the space between the content inside the container and its outer edges.

a. In theProperties section, expand theBox group.

The property name is shown in the left column. The right column is used for selecting and entering values
for the property.

b. Locate the padding property that you want to change. Each side (bottom, left, right, top) has separate prop-
erties that you can set (e.g., padding-top). If you plan to have the same settings for all four sides, you can
simply use the padding property.

c. Locate the padding property that you want to change. Each side (bottom, left, right, top) has separate prop-
erties that you can set (e.g., padding-top, padding-left). However, if you plan to have the same settings for
all four sides, you can simply use themain padding property to set the valuesall the wayaround.When
you click in the cell to the right of one of the properties (e.g., padding, padding-bottom), a small popup dis-
plays.
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i. Use the lower-left area of the popup to enter a number for the amount of padding.

ii. Use the lower-right area to select a unit of measurement.

iii. ClickOK.

7. Click to save your work.
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HOW TO EDIT A HEADING

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Simplified view is cur-

rently shown in the editor). If the button displays instead, then click it.

Note: For stepsusing the Simplified View, see the online Help.

3. In the upper-left corner of the editor, click in theShow Styles field and select .

4. In the Styles section of the editor, expand theMadCap|relationshipsHeading style. Then select the appro-
priate style classunder it:

concept This class lets you change the lookof the heading that is displayed above any concept links (i.e.,
any topics found in the "concept" column of the relationships table).

reference This class lets you change the lookof the heading that is displayed above any reference links
(i.e., any topics found in the "reference" column of the relationships table).

task This class lets you change the lookof the heading that is displayed above any task links (i.e., any topics
found in the "task" column of the relationships table).

Note: If you want to apply a setting that is used for all three of the classes, you can select the parent
MadCap|relationshipsHeading style.Whatever you set for that style will trickle down to the three
classes, unlessa different value is already specified on that class.

Note: The three style classesmentioned above are designed to work in syncwith the column head-
ings in the Relationship Table Editor. You can change the column heading (i.e., link type) for anyof
these in the editor via the column properties dialog. You can also create a custom column. But if you do
this, make sure that you create a corresponding style class in the stylesheet to control that column. For
example, if you create a custom columnwith a link type called "other," you should create a style class in
the stylesheet named "MadCap|relationshipsHeading.other." If you do not create a unique style class
for the custom column, it will use the settings from the parent MadCap|relationshipsHeading style.
Therefore, the heading labelwill say "Related Information," instead of what you want it to say.

CHAPTER 18│Navigation Links Guide 251



5. From theShowdrop-down list on the upper-right side of the editor, select . The
most relevant properties for that style are shown on the right side of the editor.

6. Following are some of themore common tasks that youmaywant to perform.
HEADING TEXT (LABEL)

For the "concept" links, the default text is "Related Information." For the "reference" links, the default text is "Refer-
enceMaterials." For the "task" links, the default text is "Related Tasks."

Click in the cell to the right ofmc-label and replace the default text.

FONT COLOR

The default color is black.

a. In theProperties section, expand the Font group.

The property name is shown in the left column. The right column is used for selecting and entering values
for the property.

b. To the right of color, click the down arrow and select a color from the popup. For advanced color options,
selectMore Colors and use the fields in the Color Picker dialog.

FONT SIZE

The default size is 14 points.

a. In theProperties section, expand the Font group.

The property name is shown in the left column. The right column is used for selecting and entering values
for the property.

b. To the right of font-size, click the down arrow and complete the fields in the popup. Enter a number in the
field and use the down arrow in the lower-right corner to select a unit of measurement.

c. ClickOK.

Note: You can also specify other style settings that can normally be done for fonts or paragraphs.

7. Click to save your work.
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HOW TO EDIT LINK ITEMS

1. From the Content Explorer, open the stylesheet that you want to modify. Bydefault, stylesheets are stored in the
Resources\Stylesheets folder, but you can store them elsewhere if you like.

2. In the local toolbar, make sure the first button displays (whichmeans that the Simplified view is cur-

rently shown in the editor). If the button displays instead, then click it.

Note: For stepsusing the Simplified View, see the online Help.

3. In the upper-left corner of the editor, click in theShow Styles field and select .

4. In the Styles section of the editor, select theMadCap|relationshipsItemstyle.

5. From theShowdrop-down list on the upper-right side of the editor, select . The
most relevant properties for that style are shown on the right side of the editor.

6. Following are some of themore common tasks that youmaywant to perform.
LEADER ALIGNMENT (FOR PRINT-BASED OUTPUT)

This determineshow the page numbersare aligned at the end of the leader. The default setting is right alignment.

Click in the cell to the right ofmc-leader-align and select an alignment setting (center, left, right).

LEADER FORMAT (FOR PRINT-BASED OUTPUT)

This is thematerial that is shown between a topic name and the page number where it can be found. The default
setting is a series of dots.

Click in the cell to the right ofmc-leader-format and type whatever you want to be shown as the leader
(e.g., dash, underline).Whatever you type will be repeated until the end of the leader.

LEADER INDENT (FOR PRINT-BASED OUTPUT)

This is the amount of space from the end of the list entry to the start of the leader.

a. Click in the cell to the right ofmc-leader-indent. A small popup displays.

b. Use the lower-left area of the popup to enter a number.

c. Use the lower-right area to select a unit of measurement.

d. ClickOK.
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LEADER OFFSET (FOR PRINT-BASED OUTPUT)

This is the amount of space from the end of the leader to the page number following it.

a. Click in the cell to the right ofmc-leader-offset. A small popup displays.

b. Use the lower-left area of the popup to enter a number.

c. Use the lower-right area to select a unit of measurement.

d. ClickOK.
MARGIN

This the amount of space around each item. The default setting is a left margin of 24 points.

a. In theProperties section, expand theBox group.

The property name is shown in the left column. The right column is used for selecting and entering values
for the property.

b. Locate themargin property that you want to change. Each side (bottom, left, right, top) has separate prop-
erties that you can set (e.g., margin-bottom,margin-left). However, if you plan to have the same settings
for all four sides, you can simply use themainmargin property to set the valuesall the wayaround.When
you click in the cell to the right of one of the properties (e.g., margin, margin-bottom), a small popup dis-
plays.

i. Use the lower-left area of the popup to enter a number for the amount of margin.

ii. Use the lower-right area to select a unit of measurement (e.g., point, pixel, centimeter) for the num-
ber you entered.

iii. ClickOK.

FONT COLOR

The default color is black. The following instructions show you how to change the font color for print-based output.
For online output, the color is based on the settingson the <a> tag, which controls the lookof all text hyperlinks in
your output. To change this, see "Editing Text Hyperlinks" on page 45.

a. In theProperties section, expand the Font group.

The property name is shown in the left column. The right column is used for selecting and entering values
for the property.

b. To the right of color, click the down arrow and select a color from the popup. For advanced color options,
selectMore Colors and use the fields in the Color Picker dialog.
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FONT SIZE

The default size is 14 points.

a. In theProperties section, expand the Font group.

The property name is shown in the left column. The right column is used for selecting and entering values
for the property.

b. To the right of font-size, click the down arrow and complete the fields in the popup. Enter a number in the
field and use the down arrow in the lower-right corner to select a unit of measurement.

c. ClickOK.

Note: You can also specify other style settings that can normally be done for fonts or paragraphs.

7. Click to save your work.

Note: Different browsersmay treat margin and padding settingsdifferently. For example, Internet Explorer 8
and Firefoxhonor padding settingsmore than theyhonor margin settings. If you were to set a left margin at,
say, 1 inch, Internet Explorer 7 would show it that way. However, in order to get the same results in Internet
Explorer 8 or Firefox, you would also need to set the left padding at 1 inch.
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Associating Relationship Tables with Targets
If you have created relationship tables in your project, you need to tell Flare which tables to use for which targets.

HOW TO ASSOCIATE RELATIONSHIP TABLES WITH TARGETS

1. Open the target from the Project Organizer.

2. In the Target Editor, click theRelationship Table tab.

3. Click next to each relationship table that you want to use for that target so that it hasa checkmark.

4. Click to save your work.

256



C
HA

PT
ER

19
Shortcut Controls

This feature is supported inMicrosoft HTMLHelp output.

A shortcut control launchesa program or window in an application bypassingWindows-
basedmessagesand parameters. For example, if a topic discussesa procedure that involves
a specific dialog window, you can provide a link that a user can click in the topic to open the dia-
log in the program. Shortcut controls canmake taskseasier for new users, and they can
speed up complexprocedures for experienced users.

Following are limitationsof shortcut controls:

A shortcut control can be used onlywith Microsoft HTMLHelp.

The CHM file must be located on a local or network drive. The file cannot be accessed
through HTTP.

The CHM file must be displayed in the Help Viewer. A shortcut control doesnot work in
a file that is displayed in an Internet browser window.

This chapter discusses the following:

Inserting Shortcut Controls 258

Editing Shortcut Controls 259



Inserting Shortcut Controls
Following are steps for inserting a shortcut control.

HOW TO INSERT A SHORTCUT CONTROL INTO A TOPIC

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, click in the topicwhere you want to insert the shortcut control.

3. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select the Insert ribbon. In theHelp Control section, selectShortcut Control

You can use theOptionsdialog to switch between ribbonsand the classic tool strip layout. For more inform-
ation see the online Help.

Keep inmind that the smaller the application window becomes, themore the options in a ribbon shrink.
Therefore, youmight only see a small icon instead of text, or youmight see only a section name displayed
with a down arrow to access the options in it. You can hover over small icons to see tooltips that describe
them. You can also enlarge the application window or click one of the section drop-downs in the ribbon to
locate a hidden feature.

Menu Select Insert>Help Control>Shortcut Control.

The Insert Shortcut Control dialog opens.

4. Enter the appropriate information in each of the fields. Youmayneed to consult with your developer for help on
completing these fields.

File path to the executable file… Enter the path and name of the program that (EXE file) you are call-
ing.

Parameters to be sent… Enter anyparameters you would like to send the program (e.g., the name of a
file to open). Separate the parameterswith commas.

A message ID of a standard Windows messageSelect a standardWindowsmessage from the drop-
downmenu.

WPARAM value Enter theWPARAM value.

LPARAM value Enter the LPARAM value.

5. ClickOK. The shortcut control is added to the topic.

6. Click to save your work.
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Editing Shortcut Controls
You can edit a shortcut control that you have inserted into a topic in a couple of different ways.

HOW TO CHANGE THE SETTINGS ASSOCIATED WITH A SHORTCUT CONTROL

The first way to edit a shortcut control is to change the settings (e.g., executable file path, parameters, message ID) asso-
ciated with the control.

1. Open the content file (e.g., topic, snippet).

2. In the XMLEditor, right-click the shortcut control icon (if "markers" are set to be shown).

3. In the context menu, selectEdit Shortcut Control. The Insert Shortcut Control dialog opens.

4. Adjust the settings in the fields asnecessary. Youmayneed to consult with your developer for help on completing
these fields:

File path to the executable file… Enter the path and name of the program (EXE file) you are calling.

Parameters to be sent… Enter anyparameters you would like to send the program (e.g., the name of a
file to open). Separate the parameterswith commas.

A message ID of a standard Windows message Select a standardWindowsmessage from the drop-
downmenu.

WPARAM valueEnter theWPARAM value.

LPARAM valueEnter the LPARAM value.

5. ClickOK. The Insert Shortcut Control dialog closes, and the link is now changed.

6. Click to save your work.

EDIT THE STYLE OF A SHORTCUT CONTROL

The second way to edit a shortcut control is to edit the style (e.g., font, color) of the link.When you edit the style for a short-
cut control, the style changes for all shortcut controls in any topics in your project. To do this, modify the property settings
for the style called <MadCap|shortcut>. For more information see the online Help.
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Viewing and Fixing Links
There aremultiple ways to view and fix navigation links in Flare.

This chapter discusses the following:

Viewing File Links 262

Viewing Broken Links 267

Viewing Broken Bookmarks 269



Viewing File Links
In Flare there aremanyways that you can link one file with another, thus creating a dependency. Link dependenciesare
created when you perform tasks such as: inserting a text hyperlink, inserting an image, applying a stylesheet to a topic, and
more. The LinkViewer window pane lets you see what other files a particular file is linked to and from.

How the Link ViewerWindow Pane CanHelp You

Thiswindow pane lets you see the following typesof information:

INCOMING LINKS FROM OTHER FILES

You can see which other files contain links to the file that has focus.

E X A M P L E

Let's say you have a topic called "What'sNew" and in several other topics you have inserted a hyperlink to it.
Unfortunately, you cannot remember exactlywhich topics. Furthermore, you'vemade changes to the "What's
New" topic, so you want to see if anyother topics linking to it also requiremodificationsasa result. Therefore, you
open the LinkViewer window pane. You then open the "What'sNew" topic. Because that topic is the file con-
taining focus, the LinkViewer window pane providesa list of all the other topics and files (e.g., tables of contents)
with links to it. Not only can you see a list of fileswith links to the "What'sNew" topic, but you can double-click each
file to open it and workon it.
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OUTGOING LINKS TO OTHER FILES

You can see which other files are linked from the file that has focus.

E X A M P L E

Let's say you have a topic called "What'sNew", which contains a snippet, which you want to edit. One way to edit
the snippet file is to go look for them in the Content Explorer and double-click it. That method can take a lot of time.
Another method is to right-click on the snippet within the topic and selectOpen Link. But another quickmethod is
to use the LinkViewer window pane, which not only lets you open the snippet quickly, but also see the file name of
the snippet and other linked files at a glance. Therefore, you open the LinkViewer window pane. You then open
the "What'sNew" topic. Because that topic is the file containing focus (i.e., it's themost recent file you've opened
or clicked in), the LinkViewer window pane provides you with a list of all the other files linked from it.
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TARGETS LINKED TO A FILE

You can see which targets are associated with the file that has focus. This is useful, for example, because it lets you know
which outputswill be affected when youmake changes to that file. The link to the target might be direct (e.g., the active file
is a topic that is included in the table of contents for a target) or indirect (e.g., the active file is a snippet that hasbeen inser-
ted into a topic that is included in the table of contents for a target).

E X A M P L E

Let's say you have a topic called "Procedure 1" and you need tomakemanychanges to it. After you are finished
making your changes, you need tomake sure your work looks correct in each output. Unfortunately, you cannot
remember which of your outputs (i.e., targets) includes that topic. Therefore, you open the LinkViewer window
pane. You then open the "Procedure 1" topic. Because that topic is the file containing focus (i.e., it's themost
recent file you've opened or clicked in), the LinkViewer window pane provides you with a list of all the targets that
will include the topicwhen output is generated. You can then keep the LinkViewer open asa reference while you
generate and view each of those targets.
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Tasks Associated with the Link ViewerWindow Pane

Following are the basic tasks involved with using the LinkViewer window pane in Flare:

OPEN LINK VIEWER WINDOW PANE

Whenever you want to view links to and from a file, you simply need to open the LinkViewer window pane and give focus to
the file in question. Following are two ways to do this:

SelectView>Link Viewer. The LinkViewer window pane opensbydefault on the right side of the workspace.
Next, open a file (e.g., topic, stylesheet, table of contents). As long as that file has focus (e.g., click in it), the related
links are shown in the LinkViewer window pane.

OR

In one of the window panes containing files (e.g., Content Explorer, Project Organizer, File List window pane),
right-click on a file and from the context menu selectView Links. If it's not alreadyopen, the LinkViewer window
pane opensbydefault on the right side of the workspace, showing the related links.

LOCK WINDOW PANE

Normallywhen you click in a different file, thusgiving it focus, the links for that file are shown in the LinkViewer window
pane. However, theremaybe timeswhen you want a previous set of links to continue to show in the LinkViewer, even

when you click in other files. In that case, you can lock the LinkViewer window pane by clicking the Lock button in the
local toolbar. To unlock the window pane, click the button again.

REFRESH

You can click in the local toolbar to refresh the LinkViewer window pane at any time. This ensures you are seeing the
most up-to-date links for the active file.

E X A M P L E

Let's say you are using the LinkViewer window pane to see the links for a topic.While doing this, suppose you
decide to delete one of the targets in your project, and that target is linked to the topic file. After the file is deleted, it
still is shown in the LinkViewer window pane. But if you click the Refresh button, the window pane no longer
shows that file link.
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GO TO PREVIOUS/NEXT

If you have been viewing links for multiple files, the LinkViewer window pane remembers those files and their links. You
can click thePrevious or Next buttons in the local toolbar to see file links that you have already viewed.

VIEW BROKEN LINKS

If the active file contains broken links, thiswill be indicated bya broken link icon in the LinkViewer window pane.

E X A M P L E

Let's say the active file contains a hyperlink to another file, but the link is broken. In that case, you will see some-
thing like this in the LinkViewer window pane:
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Viewing Broken Links
You can view a list of files in your project where a broken link is located. You can see which file it is trying to find, the link text,
the link tag, and other information. You can also open the file where the broken link is located. The broken link is highlighted
so that you can easily fix it. 

HOW TO VIEW AND FIX BROKEN LINKS

1. Open a content file (e.g., topic).

2. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select theView ribbon. In theAnalysis section, selectProject Analysis>Broken Links.

Menu SelectView>Project Analysis>Broken Links.

The Project Analysiswindow pane opens, with the "Broken Links" option selected from the drop-downmenu at
the top. The area at the bottom of the window pane displaysall files that contain links to the open file that are
broken.

3. To seemore of the information in the window pane, drag the divider bar to make the pane wider:

File Displays the name of the file where the broken link occurs.

Folder Displays the folder where the file is found.

Link Displays the link that is broken (e.g., the path and name of the topic in question).

Type Displays the type of broken link (e.g., missing file).

Link Text Displays the text in the source topic that is being used as the link.

Link Tag Displays the style used for the link. For example, if a regular text hyperlink is used, you will see "a"
in this column.

Extension Displays the file extension that the link is not finding (e.g., .htm, .jpg).
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4. If a certain number of itemshave been found, page navigation buttons in the local toolbar maybe enabled. You
can use these buttons to go to additional pages to displaymore items.

5. Double-click the row that you want to correct. The file opens in the appropriate editor or dialog. For example, if the
link appears in a topic, the XMLEditor openswith the broken link highlighted.

6. Redirect the link asnecessary (e.g., right-click on the link and selectEdit Hyperlink or Select New Snippet).
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Viewing Broken Bookmarks
You can view a list of fileswith broken bookmarks. You can see the bookmarkdestination that the link is trying to find, the
link text, the link tag, and other information. You can also open the file where the broken link is located so that you can fix it. 

HOW TO VIEW AND FIX BROKEN BOOKMARKS

1. Open a content file (e.g., topic).

2. Do one of the following, depending on the part of the user interface you are using:

Ribbon Select theView ribbon. In theAnalysis section selectProject Analysis>Broken Bookmarks.

Menu SelectView>Project Analysis>Broken Bookmarks.

The Project Analysiswindow pane opens, with the "Broken Bookmarks" option selected from the drop-down
menu at the top. The area at the bottom of the window pane displaysall files that contain bookmark links to the
open file that are broken.

3. To seemore of the information in the window pane, drag the divider bar to make the pane wider:

File Displays the name of the file where the broken link occurs.

Folder Displays the folder where the file is found.

Link Displays the link that is broken (e.g., the path and name of the topic in question).

Type Displays the type of broken link (e.g., missing file).

Link Text Displays the text in the source topic that is being used as the link.

Link Tag Displays the style used for the link. For example, if a regular text hyperlink is used, you will see "a"
in this column.

Extension Displays the file extension that the link is not finding (e.g., .htm, .jpg).

4. If a certain number of itemshave been found, page navigation buttons in the local toolbar maybe enabled. You
can use these buttons to go to additional pages to displaymore items.

5. Double-click the row that you want to correct. The file opens in the appropriate editor or dialog. For example, if the
link appears in a topic, the XMLEditor openswith the broken link highlighted.

6. Redirect the link asnecessary (e.g., right-click on the link and selectEdit Hyperlink or Edit Cross-Reference).
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IX PDFGuides

The following PDF guidesare available for download from the online Help.

AccessibilityGuide KeyFeaturesGuide

Analyzer Guide Language Support Guide

AutonumbersGuide MoviesGuide

Condition TagsGuide Navigation LinksGuide

Context-sensitive Help Guide Print-basedOutput Guide

DotNet Help Guide Project Creation Guide

Eclipse Help Guide Pulse Guide

Getting Started Guide QR CodesGuide

GlobalProject Linking Guide ReportsGuide

HTMLHelp Guide Reviews&ContributionsGuide

HTML5Guide SearchGuide

ImagesGuide SharePoint Guide

Importing Guide ShortcutsGuide

IndexGuide SkinsGuide



SnippetsGuide TopicsGuide

Source ControlGuide Touring theWorkspaceGuide

StylesGuide Transition From FrameMaker Guide

TablesGuide VariablesGuide

Tablesof ContentsGuide WebHelp OutputsGuide

TargetsGuide What'sNew Guide

TemplatesGuide
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Accessibility 22, 31, 41, 48, 88
Adobe FrameMaker

hyperlinks 117
importing 117, 128, 132
Jump to NamedDestination 117

Adobe PDF
named destinations 8, 77

Alt See Alternate text
Alternate text 22, 31, 41, 48, 88
Autonumbers

cross-references 12

B
Bookmarks 8, 269

deleting 75
hiding bookmarknames 76
inserting 72
renaming 74
showing bookmarknames 76

Borders
color 248

Broken links 266-267
Bulleted lists See Lists

C
CHM See HTMLHelp
Classes See Styles
Color

border 248
Concepts 9, 147, 159-160, 163, 170,

184
assigning topics 160
concept links 156
concept markers 156
creating 154
deleting 184, 186
editing 170, 172
example 154
inserting 154, 165, 169
links 169
list of 179-180
markers 154
proxy 153

CONREF
Relationship tables 218, 221, 237

Context-sensitive cross-
references 24

Cross-references 8, 11, 15, 24
auto-numbers 12
destinations 29
editing 15, 28-29, 32, 34
inserting 15-16



language support 34
quick 16
styles 18, 26, 32-33
stylesheets 33
updating 15, 35

D
DITA

relationship tables 10, 215, 227, 232-234, 245,
256

Drag and drop 163, 188
Drop-down text 9, 127

deleting 128, 137
editing 128, 133
FrameMaker 128, 132
heading 127
hotspot 127
inserting 128-129, 132
unbinding or removing 128, 133, 136

Dynamiceffects
drop-down text 9
expanding text 9
popups 8
togglers 8

E
EXE file 259
Expanding text 9

deleting 146
editing 142
inserting 140
unbinding or removing 142, 145

External files
hyperlinks 8, 88, 97

ExternalHelp systems
hyperlinks 8, 97
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Firefox 255
FLPRJ file 173, 199
Fonts

font family 182
size 182

FrameMaker See Adobe FrameMaker
Framesets 21, 31, 42, 48, 65, 89, 104, 108, 113

G
Graphics See Images

H
Heading

drop-down text 127
Hiding

bookmarknames 76
Hotspot

drop-down text 127
toggler 119

HTML
links 97

HTMLHelp
external links 8, 97

HTML5
links 8, 92

Hyperlinks 8
editing 45, 106
external 8, 97
HTML 97
HTML5 8, 92
inserting 38, 92, 94, 96
Microsoft Office documents 97
WebHelp 8, 94
WebHelpMobile 8, 96
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FrameMaker documents 117, 128, 132
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keywords 213
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Internet Explorer 255
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K
Keyword links 10
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editing 209
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Keywords
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L
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skins 34

Leaders 182
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HTML 97
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inserting 38, 92, 94, 96
Microsoft Office documents 97
outgoing 263
quick 38
targets 264
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